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Getting Started
Welcome to the MIPAR User Manual!

This manual is meant to complement the various tutorials and 1-on-1 training sessions available on the
MIPAR website. It offers an overview of the each application, and provides a comprehensive description of
the Image Processor’s function library.

Topics

This Section

• Install and Activate
• Introduction
• Supported Formats
• System Requirements
• GPU Computation
• Tutorials
• Recipe Store

Other Sections

• Image Processor
• Batch Processor
• Real-Time Processor
• Session Processor / AI Session Processor
• 3D Toolbox
• Report Generator
• Spotlight
• Live
• Checkpoint: Compliance by TotalLab
• Python API
• REST API
• Release Notes
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Install and Activate

Documents
• Installation + Trial Activation – WINDOWS

Describes procedures for installing, activating, and setting up MIPAR on Windows systems

• Installation + Trial Activation – MAC
Describes procedures for installing, activating, and setting up MIPAR on Mac systems

• Local License Activation
Describes procedures for retrieving and activating your purchased local License Key

• Network License Activation – SERVER
Describes procedures for retrieving and activating your purchased network License Key, and for
configuring your license server

• Network License Activation – VM SERVER
Describes procedures for retrieving and activating your purchased network License Key, and for
configuring your license server on a Windows virtual machine

• Network License Activation – CLIENT
Describes procedure for configuring client systems on your network to use network seats

• Network License Manager Readme – WINDOWS
Detailed documentation on installing and configuring your license server, including supported
operating systems.

• Network License Manager Readme – MAC
Detailed documentation on installing and configuring your license server, including supported
operating systems.

Troubleshooting
• Installation Troubleshooting

• Activation Troubleshooting

• License Key Transfer

MIPAR MIPAR User Manual - v5.0_en

Page 13 of 696

https://mipar-installer.s3.amazonaws.com/MIPAR_Installation-Instructions_Win.pdf
https://mipar-installer.s3.amazonaws.com/MIPAR_Installation-Instructions_Mac.pdf
https://mipar-installer.s3.amazonaws.com/MIPAR_Local-Activation_Instructions.pdf
https://mipar-installer.s3.amazonaws.com/MIPAR_Network-Activation_Instructions_SERVER.pdf
https://mipar-installer.s3.amazonaws.com/MIPAR_Network-Activation_Instructions_VM_SERVER.pdf
https://mipar-installer.s3.amazonaws.com/MIPAR_Network-Activation_Instructions_CLIENT.pdf
https://docs.sentinel.thalesgroup.com/ldk/LDKdocs/rte/win-cmd/Windows/Overview-Win.html
https://docs.sentinel.thalesgroup.com/ldk/LDKdocs/rte/mac-gui/Mac/Overview-Mac.html


Installation Troubleshooting
Error Cause Possible Solution

MIPAR crashes on starup or during
launching of an app

OR

HASP API DLL dynamically unloaded
with active logins

MIPAR crashed on startup and thus
did not properly log out of the
license. This is a symptom rather
than the cause of the crash.

Windows: Try updating your
graphics card driver (see below
links). If the problem persists, try
the solution below.

NVIDIA: https://www.nvidia.com/
download/index.aspx?lang=en-
us
AMD: https://www.amd.com/en/
support
Intel:
https://downloadcenter.intel.com/
product/80939/Graphics

Message on Mac stating that “MIPAR
Installer cannot be opened because it
is from an unidentified developer”.

macOS is not recognizing MIPAR
Software as an identified developer

- Right-click on MIPAR Installer
- Click “Open”
- Click “Open” in the message
that appears

Permissions setting error during
installation stating that “‘Icacls’ is not
recognized as an internal command,
operable program or batch file.”

Incorrect PATH variable

- Open System Properties >
Advanced tab > Environment
Variables > System variables
- Make sure the Path variable
contains the entries
“C:\Windows\system32” and
%SystemRoot%\system32
- Retry running MIPAR Installer

On startup error: Failed to set up java
output streams

Runtime environment was not
installed properly

- Uninstall MRE (MATLAB
Runtime 9.11)
- Download and run installer
from Link
- Restart the system and MIPAR
- Additional Steps
- Check for other Runtime paths
in the ‘Path’ Environment
Variable
- Move v911 path higher by
selecting Move Up
- Save and Restart System

MIPAR MIPAR User Manual - v5.0_en
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On startup error: Could not access the
MATLAB runtime component cache.

Permission issue accessing runtime
environment

- Launch MIPAR as
administrator by right-clicking >
Run as administrator

If problem persists:
- Uninstall MRE (MATLAB
Runtime 9.11)
- Download and run installer
from Link
- Restart the system and MIPAR

Interface buttons and text display
incoherent text

Fonts were not installed properly

- Close MIPAR
- Navigate to C:\ProgramFiles\
MIPAR\fonts
- Select all .ttf and .otf files
- Right click > Install (or “Install
for all users” if available)
- Launch MIPAR

MIPAR takes an extremely long time
to launch on a system with an NVIDIA
Ampere architecture video card
installed

MIPAR must recompile CUDA
drivers on launch

Add Environmental variable:
CUDA_CACHE_MAXSIZE with
a variable value: 536870912

Solution for Crash on Startup or “HASP API DLL dynamically
unloaded” Message (Windows)
This error occurs when the MIPAR Runtime crashes on boot. Please try in order:

Delete the MCR Cache

• Navigate to the MIPAR install folder, default: C:\Program Files\MIPAR\
• Delete the folder: mcrCache9.11
• Restart Computer
• If this does not work, try:

Delete Preferences

• Navigate to C:\Program Files\MIPAR (installation path)
• Delete miparPreferences.pref
• Retry MIPAR launch
• If this does not work, try:

Reinstall the Runtime

MIPAR MIPAR User Manual - v5.0_en
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• Uninstall the runtime from the system: MATLAB Runtime 9.11
• Download and install the runtime: LINK
• Restart the computer
• If this does not work, try:

Adjust Permissions

• Try launching MIPAR as an admin
• Are you running an antivirus program? Does whitelisting MIPAR resolve the problem?

MIPAR MIPAR User Manual - v5.0_en

Page 16 of 696

https://ssd.mathworks.com/supportfiles/downloads/R2021b/Release/3/deployment_files/installer/complete/win64/MATLAB_Runtime_R2021b_Update_3_win64.zip


Activation Troubleshooting
Error During Cause Possible Solution

MIPAR crashes on starup or during
launching of an app
OR
HASP API DLL dynamically
unloaded with active logins

Startup

MIPAR
crashed on
startup and
thus did not
properly log
out of the
license. This
is a symptom
rather than
the cause of
the crash.

Try updating your graphics card driver (see
below links). If the problem persists, try
launching MIPAR as Administrator. If the
problem still remains, try uninstalling and
reinstalling MIPAR

NVIDIA: https://www.nvidia.com/download/
index.aspx?lang=en-us
AMD: https://www.amd.com/en/support
Intel: https://downloadcenter.intel.com/product/
80939/Graphics

License Manager not reachable
OR
Unknown Error

Activation

License
Manager
may not
have been
installed
properly OR
License
Manager
may be out-
of-date

Try accessing
http://localhost:1947/_int_/ACC_help_index.html.

If this page cannot be reached:
- See Solution for License Manager Not
Reachable below.

If this page can be reached:

WINDOWS
- Update to the latest License Manager version
for Windows
- If this still does not resolve the issue, try
activating the license manually: Quit MIPAR >
Go to http://localhost:1947/_int_/checkin.html >
Click “Choose File” > choose .v2c license key
file > Click “Apply File” > Launch MIPAR

MACOS
- Update to the latest License Manager version
for Mac
-If this still does not resolve the issue, try
activating the license manually: Quit MIPAR >
Go to http://localhost:1947/_int_/checkin.html >
Click “Choose File” > choose .v2c license key
file > Click “Apply File” > Launch MIPAR

MIPAR MIPAR User Manual - v5.0_en
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Message on Mac stating that “MIPAR
cannot be checked for malicious
software”.

Activation

macOS is
not
recognizing
MIPAR
Software as
an identified
developer

– Right-click on MIPAR
- Click “Open”
- Click “Open” in the message that appears

Cannot select .v2c file on Mac Activation

.v2c file was
saved with a
.xml
extension
and cannot
be selected
after clicking
“Activate”

First remove the .xml extension and retry
activation. If this does not work, open the file in
Text Edit and resave it with only the .v2c
extension. When saving, make sure to uncheck
the box which says “Add .txt if no extension is
present”

Spinning wheel after selecting a
license type on Mac

Activation

Third-party
software may
be interfering
with MIPAR

Apps such as BetterTouchTool, Magnet, or
Grammarly can affect MIPAR performance on
Mac. If you use these apps, disable them while
using MIPAR.

HASP_UPDATE_ALREADY_ADDED Activation

This MIPAR
License has
already been
activated
previously.

If you have not requested a trial license, you
may do so here. Visit our Purchase Page to
obtain a quote for local or network licenses.

HASP_DEVICE_ERR Activation

An issue
which affects
some Mac
systems
running
macOS
10.13 High
Sierra, or on
Windows
systems
could be
caused by
corrupted
secure
storage.

See Solution for HASP_DEVICE_ERR below

HASP_CLONE_DETECTED
OR

Activation
A change in
your

See Solution for HASP_CLONE_DETECTED
below

MIPAR MIPAR User Manual - v5.0_en

Page 18 of 696

http://www.mipar.us/trial.html
http://www.mipar.us/purchase.html


“Cloned” / “Secure Storage ID
Mismatch” shown next to some keys

system’s
hardware
has caused
the license to
be
temporarily
deactivated
for clone
protection
reasons.

HASP_NO_VLIB Activation

The vendor
library
required to
activate
MIPAR
licenses was
not properly
copied over
during the
installation.

See Solution for HASP_NO_VLIB below

HASP_HASP_NOT_FOUND Activation

A MIPAR
License has
not been
activated, or
cannot be
found on
your network
(for network
licenses).

Please be sure to follow the instructions in the
Activation Window (which appears after MIPAR
is launched) to activate your license.

HASP_FEATURE_NOT_FOUND Activation

A MIPAR
License has
not been
activated, or
cannot be
found on
your network
(for network
licenses).

Please be sure to follow the instructions in the
Activation Window (which appears after MIPAR
is launched) to activate your license.

HASP_FEATURE_EXPIRED Activation
Your MIPAR
License has
expired.

If you have not requested a trial license, you
may do so here. Visit our Purchase Page to
obtain a quote for local or network licenses.
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HASP_INV_UPDATE_DATA Activation

Your .v2c file
may have
been
corrupted
during
download.

Please contact support@mipar.us for
assistance.

HASP_TOO_MANY_USERS Activation

The
concurrent
user limit on
your network
license has
been
reached.

You’ll need to wait for another user to close
MIPAR. Contact support@mipar.us to inquire
about obtaining additional seats for your network
license.

Java Exception Occurred: Sentinel
EMS is not available for the specified
URL

Activation

Sentinel
license
manager is
not able to
communicate
through the
firewall.

Try Local Offline Activation, otherwise add a
firewall rule to allow connection for the Sentinel
license managed (this can be disabled after
activation) Instructions: LINK HASP executable:
C:\Program Files (x86)\Common Files\Aladdin
Shared\HASP\hasplms.exe

Solution for License Manager Not Reachable

Windows

Check License Manager Service

1. In the Windows search bar type Services
2. Open the Services app
3. Scroll down to Sentinel LDK License Manager
4. If it exists and is stopped, select it and click Start in the left panel to start the service
5. If it does not exist, proceed with steps 6-15

Set Environment Variables

6. Open Command Prompt as Administrator and execute the following commands:
7. MKDIR c:\ldktemp
8. SET TEMP=C:\ldktemp
9. SET TMP=C:\ldktemp

Repair License Manager

10. Download the License Manager package for Windows
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11. Extract the downloaded Install_License_Manager_Win.zip (Right-click > Extract All)
12. Inside the extracted folder, double-click Install License Manager.bat
13. Retry activation through MIPAR’s Activation Window

Mac

Repair License Manager

1. Download the License Manager package for Mac
2. Double-click the downloaded Install_License_Manager_Mac.pkg
3. Follow the prompts to complete the License Manager update

Add Vendor Library

4. Download the MIPAR Vendor Library for Mac
5. From menu bar in Finder, select Go > Go to folder > type /var/hasplm and press Enter
6. Place the downloaded haspvlib_111047. dylib file here

Allow Vendor Library

7. Right-click on the haspvlib_111047. dylib file > Open
8. If you see a message which states that “haspvlib_111047 is from an unidentified developer…”, choose
Open
9. Quit Terminal if it opens
10. If there was no “Open” button in the previous message, go to System Preferences > Security & Privacy
> General > click Allow next to the message toward the bottom
Restart License Manager

Restart License Manager

11. In Spotlight search bar type Terminal
12. Open Terminal app
13. Type sudo launchctl unload /Library/LaunchDaemons/com.aladdin.hasplmd.plist and press Enter
14. Type sudo launchctl load /Library/LaunchDaemons/com.aladdin.hasplmd.plist and press Enter

Solution for HASP_DEVICE_ERR

Windows

Repair License Manager

1. Download the License Manager package for Windows
2. Extract the downloaded Install_License_Manager_Win.zip (Right-click > Extract All)
3. Inside the extracted folder, double-click Install License Manager.bat
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Mac

Repair License Manager

1. Download the License Manager package for Mac
2. Double-click the downloaded Install_License_Manager_Mac.pkg
3. Follow the prompts to complete the License Manager update
4. After the installer finishes, and the green check mark is shown, leave the installer window open and
proceed with steps 5-6

Allow in System Preferences

5. Go to System Preferences > Security & Privacy
6. Click the “Allow” button next to “SFNT Germany GmbH” (close the installer window and try clicking
“Allow” again if it does not respond at first)

Solution for HASP_CLONE_DETECTED

Check for Cloned Key

1. On your MIPAR system, go to http://localhost:1947/_int_/devices.html
2. If there is a key marked with a red “Cloned” or “Secure Storage ID Mismatch”, click the “C2V” button in its
“Actions” column, and send the C2V file to support@mipar.us. If there are no visible keys, proceed with
steps 3-5. If there are visible keys, skip to step 6.

Repair License Manager

For Windows

3. Download the License Manager package for Windows
4. Extract the downloaded update_license_manager_win.zip (Right-click > Extract All)
5. Inside the extracted folder, double-click Update License Manager.bat

For Mac

3. Download the License Manager package for Mac
4. Double-click the downloaded Install_License_Manager_Mac.pkg > Follow the prompts to complete the
License Manager update
5. Go to http://localhost:1947/_int_/devices.html and see if any keys show up

Download and Send C2V

6. Locate the key marked with red “Cloned”, click the “C2V” button under its “Actions” column, and send the
C2V file to support@mipar.us. If there are still no visible keys marked “Cloned”, please contact
support@mipar.us for further assistance.
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Solution for HASP_NO_VLIB

Windows

Add Vendor Library

1. Download the MIPAR Vendor Library for Windows
2. In Windows Explorer, navigate to C:\Program Files (x86)\Common Files\Aladdin Shared\HASP
3. Place the downloaded haspvlib_111047.dll file here

Restart License Manager

4. In the Windows search bar type Services
5. Open the Services app
6. Scroll down to Sentinel LDK License Manager
7. Select it and click Restart in the left panel

Mac

Add Vendor Library

1. Download the MIPAR Vendor Library for Mac
2. From the menu bar in Finder, select Go > Go to folder > type /var/hasplm and press Enter
3. Place the downloaded haspvlib_111047. dylib file here

Allow Vendor Library

4. Right-click on the haspvlib_111047. dylib file > Open
5. If you see a message which states that “haspvlib_111047 is from an unidentified developer…”, choose
Open
6. Quit Terminal if it opens
7. If there was no “Open” button in the previous message, go to System Preferences > Security & Privacy >
General > click Allow next to the message toward the bottom
Restart License Manager

Restart License Manager

8. In Spotlight search bar type Terminal
9. Open Terminal app
10. Type sudo launchctl unload /Library/LaunchDaemons/com.aladdin.hasplmd.plist and press Enter
11. Type sudo launchctl load /Library/LaunchDaemons/com.aladdin.hasplmd.plist and press Enter
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License Key Transfer
Please contact support@mipar.us with your request to transfer a license. A representative will be in contact
shortly after to assist you.

License transfers are only available to users with an active Maintenance Plan, and are
limited to 3 per year.*
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Introduction
MIPAR is a revolutionary image analysis software, capable of identifying and measuring features from
nearly any image one can capture. Our users have shown it to be perhaps the most the efficient and flexible
image processing software on the planet.

Through five integrated applications, MIPAR offers powerful and efficient environments for the different
tasks performed during 2D and 3D image analysis. Developed by materials scientists, it is uniquely
designed to offer workflows that are well-suited to solve a variety of scientific image analysis problems.

Launching MIPAR

The Apps

• Image Processor
The most commonly used app. Used for building and editing Recipes, as well as applying Recipes to
single images. Recipes are sequences of image processing steps which work to identify features of
interest from your image.

• Batch Processor
Used for batch applying a Recipe to multiple images. A batch process will save the last Recipe step
(or each Layer) for each image, along with a spreadsheet of global measurements, if there were
measurements in the Recipe.
With 3D Extension: The Batch Processor can output Image Stacks and 3D Reconstructions
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• Real-Time Processor
Similar to the Batch Processor, but used for applying a Recipe to multiple images, every time a new
image is added to a folder being “watched”. This is typically a folder on a network storage drive, such
that images may be processed in real-time as they acquired and saved from an imaging instrument.
With 3D Extension: The Real-Time Processor can output Image Stacks and 3D Reconstructions

• Session Processor/AI Session Processor
Used for reviewing the results of a batch or real-time process. All saved processed images are loaded
and overlaid/outlined, etc. on their respective references. The user can flip through each processed
result to assess accuracy. Manual edits can be made to correct errors. Global and feature
measurements can be made from all processed images at once. With the Deep Learning Extension
on your license, the app is named AI Session Processor, and can train new Deep Learning Models.

• 3D Toolbox (requires 3D Extension)
Used for visualizing and editing Image Stacks, as well as visualizing, editing, and quantifying 3D
Reconstructions. Reconstructions can be exported to other visualization applications such as
commercial Avizo open source ParaView and for high-end rendering and animation.
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Supported Formats
2D Formats

The following 2D image formats are supported for use in the Image Processor, Batch Processor, Real-Time
Processor, and Session Processor:

• TIF
• JPG
• BMP
• PNG
• GIF
• Bio-Formats (over 150 formats )

Requires downloading the Bio-Formats package and placing inside the “plugins” folder in your
installation directory

3D Formats

MIPAR creates 3D Reconstruction files from a series of 2D images through use of the Batch Processor or
Real-Time Processor. 3D Reconstruction files are saved from the Batch Processor or Real-Time Processor
in MIPAR’s REC format and can be opened in the 3D Toolbox.

As of v4.0.0.0, MIPAR now prompts users to download a newer version of the Bio-Formats
library which patches the log4j vulnerability, when opening speciality formats for the first
time. Users currently running the older version will be prompted to update on launch. We
strongly recommend updating. To update manually, download the new library version, place
the .jar file in [Install Directory]/plugins and restart MIPAR.

*

MIPAR scales images to 8-bit on load. MIPAR by default will auto contrast higher bit
images, to turn off auto contrast on load (File>Preferences>Normalize Image Before
Scaling)
*
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System Requirements

Supported Operating Systems

Windows (64-bit only)

• Windows 11
• Windows 10 (version 21H2 or higher)
• Windows Server 2022

Mac (Apple Silicon and Intel)

• macOS Sequoia (15)
• macOS Sonoma (14)
• macOS Ventura (13)
• macOS Monterey (12.6)

Supported Languages
MIPAR’s user-interface is only available in English, but it can be installed on all languages of Windows and
macOS.

Minimum System Requirements
• CPU: Dual-core modern Intel / AMD
• GPU: Integrated graphics
• Storage: SSD (Solid State Drive)
• RAM: 8GB

Recommended System Specs
• CPU: 6+ core modern Intel / AMD
• GPU: NVIDIA GeForce/Quadro 2000 series or better
• Storage: SSD (Solid State Drive)
• RAM: 16+ GB

Note: Apps such as BetterTouchTool, Magnet, or Grammarly can affect MIPAR
performance on Mac. If you use these apps, we recommend disabling them while using
MIPAR.

!
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Deep Learning Requirements

Spotlight Requirements
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GPU Computation
Enable

From any app, launch File > Preferences. In the GPU panel, set to “GPU Computation” to “On” if you have a
supported GPU. Click here to learn more about the technical aspects and benefits of GPU computation.

Supported Functions

The following functions support GPU Computation:

Edit

• Crop Image
• Resize Image
• Rotate Image
• Flip Image
• Translate Image
• *Register Image: Free-Form, Translation, Rigid, Affine
• Sparsely Sample Image
• Draw Random Lines

Color

• Color Cluster
• Color Deconvolution
• Channel Operation

Pre-Processing

• Adjust Contrast
• Flatten Background
• Smart Cluster

GPU computation requires an NVIDIA GPU with compute capability 5.0 to 9.x (Maxwell,
Pascal, Volta, Turing, Ampere, or Ada Lovelace architecture), and your driver must support
CUDA Toolkit 11 or higher. We recommend you update your NVIDIA driver to the latest
version here. Learn more about CUDA here.

*

For GPU requirements for deep learning training, see Deep Learning System Requirements.*
Some functions may produce slightly different results when run on the GPU vs. the CPU.!
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• Wiener Filter
• Gaussian Blur
• Average Blur
• Sum Filter
• Grayscale Dilate
• Grayscale Erode
• StdDev Filter
• Gradient Filter
• Highlight Lines
• Bright Texture
• Dark Texture
• Advanced Texture
• Pattern Mapping
• Orthogonal Correlate
• *Cross-Correlate
• Sharpen
• FFT Filter
• Make FFT
• Apply Stored FFT Filter
• *Grayscale Interpolation

Segmentation

• Invert
• Blank
• Basic Threshold
• Range Threshold
• Adaptive Threshold
• E-M Threshold
• *Local Threshold
• Find Edges
• Find Circles
• Find Lines
• Find Text
• Find Facial Features
• *Region Grow
• Find Global Maximum
• Find Global Minimum
• Find Local Maxima
• Find Local Minima

Deep Learning

• Apply Model
• Call Output
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Morphology

• Uniform Dilation
• Smart Dilation
• Retain Dilation
• Uniform Erosion
• Smart Erosion
• Retain Erosion
• Smooth Features
• Extend Features
• Perimeter Pixels
• Skeletonization
• Thin
• Shrink
• Distance Map

Clean-Up

• Relative Size Filter
• Replace With: Centroid, Ellipse, Equivalent Circle, Fit Circle, Largest Circle, Local Normal, Major Axis,

Minor Axis, Nearest Distance, Triangulation
• Mark Center

Memory

• Set Companion Image
• Load Companion Image
• Call Companion Image
• Set Memory Image #1-6
• Call Memory Image #1-6
• Call Original Image

Math

• *Feature Union
• *Feature Minus
• *Feature Intersection
• *Keep Exclusive Features
• Make Grayscale
• *Add
• *Average
• *Divide
• *Multiply
• *Subtract
• Add Value
• *Merge Darker Pixels
• *Merge Lighter Pixels
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Preferences
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Layout
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1. MIPAR Open Directory
Default folder for opening and image or recipe on MIPAR launch.

2. Calibration and Measurements Units
Calibration units are used to display the scale bar and are used as default during recipe calibration.
Measurement units are used for measurement unit generation.

3. Feature Numbering Order
MIPAR numbers features during Reject Features function and during feature measurement generation. Left
to right numbering will number features from the left edge of the image to the right. Top to Bottom
numbering will number features from the top edge of the image to the bottom.

4. Corner Pixel Connectivity
Distinct features can be identified using two different methods. 4-pixel connectivity and 8-pixel connectivity.

Image Source

5. Memory Allocation for Proprietary File Formats
MIPAR is able to open proprietary file types which are handled using a dedicated library. If MIPAR throws
out of memory errors when the workstation is not out of memory, adjust this setting to allocate more memory
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to MIPAR.

6. Image Scaling
MIPAR scales all opened images to 8-bit, scaling can be done by normalizing the images to the min and
max values. We recommend disabling this setting for projects that requires intensity measurements.

7. TIFF Compression
Set compression preference for binary and non-binary (greyscale, color) images.
Non-binary: lzw(default), packbits, none, lzw, deflate.
Binary: ccitt(default), packbits, none, lzw, deflate, fax3, fax4.

8. GPU and Hardware Acceleration
GPU Computation is recommended for large images to accelerate image processing. Note that GPU
selection for applying Deep Learning models is a separate setting that overrides this preference in the Apply
DL Model function.

Hardware Acceleration is supported on some CPUs to improve MIPAR interface and measurement
performance.

Parallel CPU Grid is used for some functions to accelerate processing. This value defaults to half the
number of physical cores on the system.

Note: Some measurements can be impacted by this setting, to ensure consistent results
across multiple systems make sure this setting is consistent.

!
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Keyboard Shortcuts

All Windows

Zoom CTRL+D or Scroll Wheel

Pan CTRL+F or Scroll Click and Drag

Toggle Zoom/Pan CTRL

Measure (if appl.) CTRL+M

Recipe Step Preview Windows

Toggle Preview SHIFT

Cycle UI Elements TAB / SHIFT+TAB

Navigate Radio Buttons UP / DOWN ARROWS

Accept Text Entry ENTER

Accept Window SHIFT+ENTER

Cancel Window ESC

Windows with Manual Editing Tools

Switch Editing Tools NUMBER KEYS (1, 2, 3…)

Fill Mode CTRL+A

Erase Mode CTRL+S

Undo CTRL+Z

Image Processor

Open Image CTRL+O

Load Recipe CTRL+L

Save Reference Image CTRL+1

Save Current Image CTRL+2

On Mac systems, use CMD instead of CTRL.*
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Save All Layers CTRL+3

Save Recipe CTRL+R

Undo CTRL+Z

Session Processor

Load Session CTRL+L

Save Session CTRL+R

Save Current Image CTRL+2

Save All Images CTRL+3

Manual Editing See above table

Change Current Image LEFT/RIGHT

Change Active Layer UP/DOWN

3D Toolbox

Open Image Stack CTRL+I

Open Reconstruction CTRL+O

Save Stack CTRL+T

Save Recon CTRL+S

Undo Last Stack Change CTRL+X

Undo Last Recon Change CTRL+Z

Rotate 3D CTRL+G
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Tutorials
Watch video tutorials on how to use many of MIPAR’s features:

• Overview
• Image Processor
• Batch Processor
• Session Processor
• AI Session Processor
• 3D Toolbox
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Overview
Tour

Take a tour of MIPAR’s powerful features and intuitive workflow. You’ll see examples of feature detection,
batch processing, and measurements.

Demo

Watch a full demo of MIPAR’s operation including the Image Processor, Batch Processor, and Post
Processor apps.

https://www.youtube.com/embed/ws-AQkPSgOw?rel=0
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https://www.youtube.com/embed/D9vF77EB4hY?rel=0
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Image Processor

Detecting

Creating a Recipe

Describes the process of creating a segmentation recipe to identify features of interest in an image.

Optimizing Steps

Shows the procedures and applications for optimizing, or objectively determining, image processing
parameters.

https://www.youtube.com/embed/D01HYV8yAiw?rel=0
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Frequency Filtering

Demonstrates how to use the Frequency Filter in three different applications.

https://www.youtube.com/embed/HClFGOyt6jI?rel=0
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Memory Steps

Shows examples of setting, calling, and using memory steps in a Recipe.

https://www.youtube.com/embed/X2GzqYL_i88?rel=0
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Smart Cluster™

Demonstrates use of the Smart Cluster function for simple and objective multi-class segmentation.

https://www.youtube.com/embed/ex7UHo7tvro?rel=0
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Color Cluster™

Demonstrates use of the Color Cluster function for simple and objective color segmentation.

https://www.youtube.com/embed/FxebQbpdRuE?rel=0
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Color Deconvolution

Demonstrates use of the Color Deconvolution function to highlight features of certain colors.

https://www.youtube.com/embed/xdrw2Utgb2c?rel=0
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Smart Find™

Demonstrates two example uses of Smart Find in Auto Segmentation for powerful and objective feature
detection.

https://www.youtube.com/embed/KlkunloiWkE?rel=0
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Polishing

Calibrating The Scale

Shows how to calibrate the scale (i.e. calculate the pixel size) of your image, so that measurements can be
made in physical units of microns, instead of pixels.

https://www.youtube.com/embed/GSrwRvSFh4E?rel=0
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Setting Layers

Discusses the power and procedures behind setting recipe steps as Layers.

https://www.youtube.com/embed/iI4U7UuiVbc?rel=0
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Setting Chapters

Discusses the advantages and procedures behind recipe Chapters.

https://www.youtube.com/embed/zbU_-hh6m4M?rel=0
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Adding Notes & Flags

Demonstrates how to add Notes and Flags to Recipe steps.

https://www.youtube.com/embed/_h3zoYKzdTM?rel=0
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Measuring

Generating Measurements

Demonstrates how to generate Global and Feature Measurements from segmented features of interest in an
image.

https://www.youtube.com/embed/xg55EgZbrUg?rel=0
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Coloring By Measurements

Demonstrates how to color segmented features according to any of their available measurements.

https://www.youtube.com/embed/m_Nd_ETglH4?rel=0

MIPAR MIPAR User Manual - v5.0_en

Page 55 of 696

https://www.youtube.com/embed/m_Nd_ETglH4?rel=0


Local Measurements

Demonstrates how to extract and visualize Local Measurements such as area fraction and thickness.

https://www.youtube.com/embed/kvhZrzKOubE?rel=0
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Measuring Feature Intensities

Demonstrates how to measure aspects of grayscale intensities within selected features.

https://www.youtube.com/embed/WhAKluBliXs?rel=0
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https://www.youtube.com/embed/DjX1gcxsKOM?rel=0
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Batch Processor
Running a Batch

Shows how to setup and run a batch process to segment and measure features from a set images.

https://www.youtube.com/embed/KXbY8vPeroM?rel=0
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Session Processor (formerly Post Processor)
Reviewing a 2D Batch

Shows how to review and edit multiple images after they have been batch processed to segment features of
interest.

Generating Measurements

Shows how to generate measurements from multiple images after they have been batch processed to
segment features of interest.

https://www.youtube.com/embed/whP1423oY1k?rel=0
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https://www.youtube.com/embed/KyzyMeVz0bM?rel=0
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AI Session Processor (formerly Deep
Learning Trainer)
Demo Video illustrating the use of the AI Session Processor

Tracing

Shows examples of tracing features of interest to develop training data.

Training

Shows example of training a deep learning model.

Applying

Shows example of applying a deep learning model to a new image.

https://www.youtube.com/embed/ACvg6LAsqRY?rel=0
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3D Toolbox
Overview of 3D Reconstruction

Shows the workflow for creating, processing, visualizing, and measure a 3D Reconstruction.

Downloads

You may download the below assets to use as learning tools and follow this tutorial.

⇩ Raw Dataset

⇩ Calibration Data

⇩ Segmentation Recipe

https://www.youtube.com/embed/sTMwAB9xPgQ?rel=0
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Recipe Store

Enter Recipe Store ››

What Is It?

The Recipe Store is a fantastic resource for getting the most out of MIPAR. Find and download Recipes for
all sorts of segmentation problems. You’ll learn fast and accelerate your work.

How Does It Work?

Browse the Recipes. Download the ones you like. We’ll post examples next to them when possible. Every
Recipe has common info so you know what you’re getting.

Custom Recipes

One of MIPAR’s unique features is the ability for you to receive custom Recipes from our experts anytime.
Just submit an image here, and we’ll return a Recipe for your task as quickly as possible. If needed, a
member of our team will reach out for additional information.
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Image Processor
The Image Processor is the most commonly used app. It is used for building and editing Recipes, as well as
applying Recipes to single images. Recipes are sequences of image processing steps, in the right order and
with the right settings, which work to identify features of interest from your image.

Topics

• Layout
• The Recipe
• Recipe Templates
• Chapters
• Layers
• Notes, Flags, Interruptible, Custom Recipe Names
• Simple Recipe Mode
• Calibrating The Scale
• Scale Bar
• Optimization
• Measurements
• Functions
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Layout
Below is labeled screenshot of the Image Processor which reveals the layout of and purpose behind each
user interface element.

See Keyboard Shortcuts for shortcuts relevant to the Image Processor.*
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The Recipe
MIPAR’s unique technology is the Recipe. Like an engine of a car, you use the one that’s right for the job.
Make them yourself, start with one from the 80+ built-in templates, or get one custom-designed for you.

Recipes are built in the Image Processor, and are a sequence of image processing steps, in the right order
and with the right settings, which work to identify features of interest from your image. Each step you take
gets automatically recorded. Recipes are completely non-destructive, meaning that previous steps can be
edited or removed, new steps inserted, and changes will propagate down the rest of the sequence. Any step
of a Recipe can be double-clicked to show its result.

In addition to processing steps, Recipes can also contain global measurements. If there are no Layers in a
Recipe when it is run on an image or a batch, all global measurements will be performed on the last Recipe
step. If there are layers, all global measurements will be performed on each layer.

Once saved, a Recipe can be applied to another image in the Image Processor, or automatically to a set of
images in the Batch Processor. You’ll be amazed at the range of problems you can solve with this
technology.

Demo
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Custom Recipes

One of MIPAR’s many features that no competitor can match is the ability to receive custom recipes from
our expert anytime. Just submit an image here, and we’ll return a Recipe for your task as quickly as
possible.

Tutorial

https://www.youtube.com/embed/Qh7JxzDWwUU?rel=0
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https://www.youtube.com/embed/D01HYV8yAiw?rel=0

https://www.youtube.com/embed/D01HYV8yAiw?rel=0
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Recipe Templates
MIPAR v4.2.0 brought pre-built recipes right into the Image Processor. Over 80 recipes are available to
browse and try on either the included example images, or your own.

They are called templates as they are intended to be strong starting points for many solutions. Feature type,
size and resolution, sample preparation, image acquisition parameters, and analysis needs are just a few of
the variables which may vary across applications. Templates can offer powerful starts to solving real-world
problems and easily allow the adjustment needed to customize them for your use case. They are there to
accelerate your learning experience and build our applications specialists’ combined decades of recipe
building experience directly into MIPAR.

Recipe Templates may be filtered by category, searched by keywords in their names and descriptions, and
those with available video demos will offer links right in the description box.

Through the “Support” button, our team is always a click away, should you be interested in having a recipe
rapidly custom-built for your application.

Show Templates
Click the “Templates” button in the upper left of the Image Processor to show Recipe Templates.

They will also show by default when opening an image. This feature can be toggled with either the checkbox
under the “Hide” button (only visible after auto-show) or in File > Preferences > Show Recipe Templates.

Updates and new additions to the Recipe Templates will be offered periodically. When an
update is available, you will be prompted to download the new templates after launching
MIPAR, without needing to update your MIPAR version.
*
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Browse and Run
Refer to each element’s description below:
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1. Hide

Hide the Recipe Templates browser.
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2. Filter by Category

Only show templates within certain categories.

3. Filter by Search

Search to filter templates by keywords in their names and descriptions. Search applies to selected category.

4. Template List

List of filtered templates based on category and search string. Click one to select.

5. Description

Brief description of selected template. Links to video demos will appear here when available.

6. Example Image Preview

Preview of included example image for selected template.

7. Example Result Preview

Preview of recipe result on included example image for selected template.

8. Load Image

Open example image for selected template in Image Processor.

9. Run Recipe

Run selected template on open image.

10. Hide (alternate control)

Hide the Recipe Templates browser.

11. Support

Submit your image and information to our applications team for custom recipe development.
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Shortcuts
The below shortcuts are available for browsing and running Recipe Templates:

Move from Search to Template List TAB

Select Templates UP / DOWN ARROWS

Load Example Image (no image open) ENTER or DOUBLE-CLICK

Run Selected Template (with image open) ENTER or DOUBLE-CLICK
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Chapters
Chapters allow a Recipe to be broken up into sections, where the first step in each section (Chapter) is
given a name which generally describes the purpose of that series of steps.

Setting Chapters

During the building of a Recipe, the addition of certain steps will automatically trigger the start of a new
Chapter, since these steps typically indicate the start of new overall goal or purpose in the Recipe. The
steps which automatically trigger the start of a new Chapter are:

• Call Memory Image #1-6
• Call Companion Image
• Load Companion Image
• Call Original Image
• Channel Operation
• Color Select
• Blank
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Any Recipe step can be manually set as the start of a new Chapter at anytime. To do so, right-click on the
step, choose “Set as Chapter…”, type the desired name, and click “OK”.
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Editing Chapters

The name of any Chapter can easily be changed at anytime. To do so, right-click on the step, choose “Edit
Chapter…”, type the desired name, and click “OK”.

Chapter names are set automatically when a step within the Chapter is set as a Layer, but only if the current
name of the Chapter the is the default “New Chapter” (or “Start” in the case of the first step). If this is the
case, the Chapter will automatically be given the same name as the name of the Layer. If the Chapter had
already been named something other than the default, the Chapter name will not be changed.
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Deleting Chapters

Any step (except for the first) can be un-set as a Chapter at anytime. To do so, right-click on the step and
choose “Remove as Chapter”.
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Tutorial
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https://www.youtube.com/embed/_h3zoYKzdTM?rel=0

https://www.youtube.com/embed/_h3zoYKzdTM?rel=0
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Layers
Each Recipe step outputs either an grayscale, or B/W image. B/W images are often the goal, as the black
pixels represent the selection at that point in the Recipe. If you are only targeting one set of features, a
final B/W image is all you need. However, if you need to identify multiple feature types (e.g., large vs. small
particles), Layers come in very handy.

Layers are essentially “favorited” Recipe steps, which can be overlaid together and measured separately.
For example, if you’re looking for large vs. small particles, you may have one step which selects the large,
and one which selects the small. Just set each step as a Layer, and you’re done. You’ve now separately
classified your two feature types and can enjoy coloring them separately, outputting each selection during a
batch process, and taking measurements from each with one click.

To move a Layer from one step to another, select then Layer step, hold CTRL and select the step to move
to. The “Set Layer” button will change to “Move Layer”. Click this button to move the layer.

Tutorial

https://www.youtube.com/embed/zbU_-hh6m4M?rel=0

https://www.youtube.com/embed/zbU_-hh6m4M?rel=0
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Notes, Flags, Interruptible, Custom Recipe
Names
Notes

Notes are comments that users may add to any Recipe step. These can be useful for reminding yourself, or
indicating to others, the intent behind a step. They can also be helpful in indicating which settings should be
adjusted in situations when the Recipe needs tweaking.

Notes may be added to a step by selecting the step and clicking the “Notes” button in the “Help” box.
Erasing the text from the “Notes” box will remove the notes from the step.

Flags

Flagging Recipe steps indicates that they are critical to the accuracy of the feature detection. Flagged steps
are likely the first steps to need adjustment if features are not detected accurately when the Recipe is
applied to a given image.
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A step may be flagged by selecting the step and clicking the “Flag” button in the “Help” box. Un-click the
“Flag” button to un-flag a step.

Interruptible

User editable steps can be set to interrupt recipe execution in the Image Processor, the Batch Processor or
the Real Time Processor to ask for user input. To set the step as interruptible, select the recipe step and
click the ‘Lightning’ button.

Custom Recipe Names

Custom recipe names are used in combination with flags and notes to annotate the recipe and help organize
the workflow for users
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Tutorial

https://www.youtube.com/embed/xg55EgZbrUg?rel=0
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https://www.youtube.com/embed/xg55EgZbrUg?rel=0
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Simple Recipe Mode
Simple Recipe Mode collapses the Recipe display, showing only flagged steps and layers. This enables the
Recipe end-user to easily ignore most steps and make adjustments only to important ones, without having
to search through the entire Recipe. In addition, the Layers panel allows users to view and edit Layers with
a much more streamlined feel.

1a. Switching Recipe Mode

To enable Simple Recipe Mode, the Recipe must have at least one layer. If it does, clicking the Lock icon
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will toggle between Simple and Detail Recipe Mode.

1b. Password Protection

Password protection keeps a Recipe from being switched from Simple to Detail Mode, prevents
measurements from being added or removed, and prevents scale factor modification. Flagged steps
exposed in Simple Mode will still be editable.

To set a password, right-click on the lock icon and select “Lock with Password”.

To open a locked Recipe, either left-click or right-click on the lock icon and enter the password when
prompted. The Recipe Mode can then be switched back and forth without a password until the Recipe is re-
loaded.

To change the password or remove the need for a password completely, right-click on the lock icon of an
unlocked recipe and select “Edit Password …” or “Clear Password”.

2. Detection

The Detection panel shows flagged steps. These steps can be edited or optimized (if applicable) by either
double-clicking, right-clicking and selecting “Edit…” or “Optimize…”, or selecting the step and using the
Optimize or Edit buttons.

3. Layers

The Layers panel shows all layers in the Recipe . Specific layers can be shown or hidden from the Current
Image pane by toggling the check box by each layer. Each layer’s color and name can also be changed in
this panel by clicking on them.

4. Measurements

The Measurements panel displays all the measurements currently present in the Recipe and allows
measurements to be added, modified, and run.
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Calibrating The Scale

Embedded Image Scale Factors
MIPAR can read embedded scale factors from over 150 file formats once the Bio-Formats plugin is in place.
See the Supported Formats page for more information on setting up this plugin.

If an image is opened which contains an embedded scale factor, the factor will be set in light-gray text in the
“Scale” panel, and the corresponding calibration units will be set automatically.

Loading a Recipe with a scale factor, or setting a scale factor, will overwrite the image scale factor. Erasing
the Recipe scale factor will revert back to the image scale factor.

Image scale factors are supported in the Image Processor, Batch Processor, Real-Time Processor, and
Post Processor.

Calibrate Scale Tool
The Calibrate Scale tool allows users to calculate their pixel size, such that distance and areal
measurements can be made in physical units, rather than pixels. The image used for calibration should
contain an object of a known length (typically a scale bar), and should be of the same magnification and
pixel density as the image to measure.

This tool can be used in 1 of 2 modes: Auto or Manual:

Auto Mode

Auto Mode lets MIPAR automatically detect the scale bar in your image, without you having to manually
define it! To use Auto Mode:

• Click “AUTO”
• Drag the blue box roughly around the area of the scale bar
• Click “✓” to confirm

MIPAR will then automatically detect the scale bar and place a line across it. You may then proceed with

Automatic Scale Adjustment: In the Image Processor, when adding or removing a Resize
Step from a recipe, the scale will automatically adjust to compensate. In the Image, Batch,
and Real-Time Processors, when loading an image where its scale is automatically read
from its metadata, this scale will automatically be adjusted by the presence of Resize steps
in the recipe. These adjustments apply to the entire recipe, even steps before the Resize
step.

!
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step 2 and 3 (see below) to enter the physical distance and calculate the scale factor.
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Manual Mode

Manual Mode may be used when MIPAR is unable to automatically detect the scale bar in your image. To
use Manual Mode:

• Click the Distance Line tool
• Drag the line to span across the scale bar

You may then proceed with step 2 and 3 (see below) to enter the physical distance and calculate the scale
factor.
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Dynamic Mode

Dynamic Mode is used to determine the scale factor based on the size of a recognized feature. A recipe
which uses Dynamic Mode is able to automatically adjust its scale factor per image based on the pixel size
of the detected feature. Dynamic Mode accepts a “sub-recipe” for detection and a defined dimension to
measure. When the main recipe is run, this sub-recipe first detects the scale-determining feature and sets
the scale factor according to the feature’s measured pixel and defined physical dimensions.

Recipe requirements:

• Final step must be a selection (binary) image
• Recommended that final step only selects one feature (largest feature will be used if there are more

than one)
• Any layers will be ignored (only final step considered)

To use Dynamic Mode:
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• Click the “Recipe” button > choose the recipe designed to detect feature to measure
• Select measurement of interest (line spanning feature will adjust automatically as measurement is

changed)

You may then proceed with step 2 and 3 (see below) to enter the physical distance and calculate the scale
factor.
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General Use

1. Set Line

Use Auto Mode, Manual Mode (activate the Distance Line tool), or Dynamic Mode (“Recipe” button)

2. Enter Distance

Enter known distance spanned by line

3. Calculate

Calculate the scale factor

4. Scale Factor

The scale factor is displayed. Click “Accept” or “Cancel”.
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Tutorial

https://www.youtube.com/embed/iI4U7UuiVbc?rel=0

https://www.youtube.com/embed/iI4U7UuiVbc?rel=0
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Scale Bar
Scale bar toggle allows users to overlay a scale bar based on parameters specified in the scale bar format
settings.

Scale Bar Formatting

1. Show/Hide Scale Bar

2. Scale Bar Settings

3. Location

4. Length

Allows users to toggle between manually set scale bar length, an automatically generated scale bar as well
are set scale bar units.
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5. Formatting

• Color: Toggles between a black line on a white background and a white line on a black background
color scheme.

• Thickness: User set scale bar thickness.
• Font Size: Font size of scale bar text.
• Outline: Outline toggle to accentuate the scale bar.

Example Scale Bar
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Optimization
This interface allows you to setup and start recipe step (process) optimization (i.e., auto-setting
determination). After selecting optimization parameters, you will be asked to enter a range for some of the
process’ parameters. This will start a loop which will execute the process at each parameter combination
within the specified range. The parameter combination which yields the best quality metric will be set as the
new parameter combination for the process. This calculation will be re-performed for any image the Recipe
is run on.

The optimization interface is available by clicking the the “Optimize” button in the top right corner of the
Recipe panel. The following steps are optimizable:

Pre-Processing

• Rotate Image
• Adjust Contrast
• Smart Cluster
• Interpolation

Segmentation

• Basic Threshold
• Range Threshold
• Adaptive Threshold
• E-M Threshold
• Watershed
• Local Threshold
• Region Grow
• Fast Marching Method
• Find Edges

Morphology

• Dilate Uniform
• Dilate Smart
• Dilate Retain
• Erode Uniform
• Erode Smart
• Erode Retain
• Separate Features
• Smooth Features

Clean-Up
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• Reject Features

1. Comparison Image

Image to compare processed image to during optimization

2. Smart Reference

Choose whether to apply high-pass FFT filtering to comparison image. When “On” Smart Reference with
make feature edges more important, and often improves the results of your optimization.

3. View Images

Choose whether to display optimization at each step

4. Save Images

Choose whether to save each frame of the optimization movie

5. Save Histograms

Choose whether to view/save the histograms of the processed image at each step
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6. Area of Interest

Choose whether to use a sub-region or the entire image for optimization

7. Metric

Choose metric to use for comparing processed image to the comparison image

• Selection Match: A fast measure of image similarity that describes how well the processed image
describes the comparison image. Only available when optimizing steps which result in a selection
image. Does not take into account the uncertainty of the comparison image. Better suited for simpler
segmentation problems with clear contrast between features and background. The optimization will
choose the parameter combination which yields a maximum Selection Match.

• Mutual Information: A more advanced measure of image similarity that describes how well the
processed image describes the comparison image [1,2]. Available when optimizing steps which result
in either a selection or grayscale image. Takes into account the uncertainty of the comparison image.
The optimization will choose the parameter combination which yields a maximum mutual information.

• Intensity Match: A measure of image similarity between two grayscale images. Only available when
optimizing steps which result in a grayscale image. Computed as the normalized correlation
coefficient between both images.

8. Compare

Choose whether to use the images, or their two-point correlation functions for comparison

9. Parameter Value (min)

Minimum value of the parameter range to explore
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10. Parameter Value (max)

Maximum value of the parameter range to explore

11. Parameter Value (inc)

Increment (step size) to take between the minimum and maximum parameter values

References
[1] Rahunathan, Smriti, D. Stredney, P. Schmalbrock, and B.D. Clymer. Image Registration Using Rigid
Registration and Maximization of Mutual Information. Poster presented at: MMVR13. The 13th Annual
Medicine Meets Virtual Reality Conference; 2005 January 26–29; Long Beach, CA.

[2] D. Mattes, D.R. Haynor, H. Vesselle, T. Lewellen, and W. Eubank. “Non-rigid multimodality image
registration.” (Proceedings paper).Medical Imaging 2001: Image Processing. SPIE Publications, 3 July
2001. pp. 1609–1620.

Tutorial

Some functions allow for 2 or 3 parameters to be optimized simultaneously. In this case,
additional sets of [min, max, inc] entries will be shown. Set the min and max equal to each
other to fix any parameter during optimization.
*
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Measurements
Measure Image

Global measurements report one measurement per image. Common measurements include area fraction of
features, total perimeter of features, and number of features. Click any link below for descriptions of the
many global measurements available in MIPAR.

• Area
• Area Fraction
• Count
• Estimate Count
• Intercepts
• Image Dimensions
• Number Density
• Perimeter
• Perimeter Fraction
• *Intensity Mean
• *Intensity StdDev
• *Intensity Sum
• *Correlation Coefficient
• *Mutual Information

Measure Features

Feature measurements report one measurement for each feature in an image. Descriptions of the many
feature measurements available in MIPAR can be found here.

Measure Local

Local measurements report one measurement for each pixel. For some measurements, each pixel in the
image is measured. For others, only pixels within features are measured. Common metrics include local
area fraction, thickness, and mean grayscale value. A description of the Local Measurements tool and its
available measurements can be found here.

Tutorials
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https://www.youtube.com/embed/kvhZrzKOubE?rel=0

https://www.youtube.com/embed/kvhZrzKOubE?rel=0
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https://www.youtube.com/embed/WhAKluBliXs?rel=0
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Functions
This section provides details on all functions available in MIPAR’s Image Processor.

Each function’s page contains the following information:

• Title
• Path
• Summary
• Screenshot (if applicable)
• Parameters (if applicable)
• References (if applicable)

Categories

• File
• Edit
• Color
• Pre-Processing
• Segmentation
• Morphology
• Clean-Up
• Memory
• Math
• View
• Measurements
• Tools

Note that many of these menus will not be displayed while in Simple Recipe Mode.
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File
Contains functions for image opening and saving, as well as Recipe loading and saving.

Functions

• Open Image
• Open Recent Image
• Open Images as Channels
• Load Reference Image
• Load Recipe
• Load Recent Recipe
• Save Current Image
• Save Reference Image
• Save All Images
• Save All Layers
• Save Recipe
• Save Recipe As
• Print Current Image
• Preferences
• Quit
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Open Image
File > Open

Opens an image. All common image formats and Bio-Formats are supported.

Supported Formats

• TIF
• JPG
• BMP
• PNG
• GIF
• Bio-Formats (over 140 formats)

Requires downloading the Bio-Formats package and placing inside the “plugins” folder in your
installation directory

Tips

You can drag and drop an image into the recipe or image panels at any time to open the image.
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Open Recent Image
File > Open Recent Image

Holds the last five images opened, for easy access.

Clear Recent clears this list.
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Open Images as Channels
File > Open Images as Channels

Allows for opening of multiple images into color channels. The individual color information can be accessed
using Color > Channel Operation.

Only grayscale images are able to be combined to channels*
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Load Reference Image
File > Load Reference Image

Loads an image as the reference image. All common image formats are supported. Grayscale images will
be read-in as 8-bit. Color images will offer a prompt which allows the user to decide how to convert the color
image to 8-bit grayscale.
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Load Recipe
File > Load Recipe

Loads and applies a Recipe to the Opened Image.

Tips

You can drag and drop a recipe into the recipe panel at any time to load the recipe.

MIPAR MIPAR User Manual - v5.0_en

Page 113 of 696



Load Recent Recipe
Holds the last five recipes opened, for easy access.

Clear Recent clears this list.
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Save Current Image
File > Save Current Image

Saves the Current Image as an 8-bit TIF-file. The image will be saved as it is shown in the Current Image
viewer.
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Save Reference Image
File > Save Reference Image

Saves the References Image as an 8-bit (if grayscale) or true-color (if color) TIF-file. The image will be
saved as it is shown in the Reference Image viewer.
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Save All Images
File > Save All Images

Saves an image from each Recipe step based on the current viewing mode.
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Save All Layers
File > Save All Layers

Saves a B/W image for each Layer in the Recipe with the name [Original Image Name]_[Layer Name].
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Save Recipe
File > Save Recipe

Save current Recipe as an RCP-file. The current processes, measurements, and calibration factor will be
saved as into the Recipe.
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Save Recipe As
File > Save As Recipe

Save current Recipe as an RCP-file with a specified name. The current processes, measurements, and
calibration factor will be saved as into the Recipe.
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Print Current Image
File > Print Current Image

Sends Current Image to the selected printer. The image will be printed as it is shown in the Current Image
viewer.
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Preferences
File > Load Recipe

Allows user to set MIPAR preferences.
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Quit
Quits the Image Processor.
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Edit
Contains functions for editing image dimensions and manipulating image position and rotation.

Functions

• Undo
• Burn Scale Bar
• Set as Reference Image

Size

• Crop Image
• Resize Image

Position

• Rotate Image
• Flip Image
• Translate Image
• *Register Image

Sample

• Sparsely Sample Image
• Draw Random Lines
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Undo
Edit > Undo

Undoes the last Recipe edit. Recipe will re-execute from the last change-point after undoing.
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Burn Scale Bar
Edit > Burn Scale Bar

Burns a scale bar to the Current Image. When the step is added, the shown scale bar will be burned. Scale
bar settings for this step can be edited at any time. This current Scale Factor will be used when burning the
scale bar.

More information on scale bar settings may be found on the Scale Bar page.
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Set as Reference Image
Edit > Set as Reference Image

Set the Current Image as the Reference Image. Future B/W Current Images will then be overlaid, outlined,
or labeled on this new Reference Image.
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Crop Image
Edit > Crop Image

Crops the image to a sub-area of the previous image. Dimensions are listed as X: upper left corner, Y:
upper left corner, with of crop box, height of crop box.

Draw
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1. Adjust crop area

Click and drag the blue box to adjust the crop area. Click “Accept” when finished.

2. Interruptible in batch

If this box is checked and the recipe is run in batch, recipe execution will pause and the crop dialog will
automatically open, allowing manual adjustment of the crop area for each image. Clicking “Accept” will
cause recipe execution to resume.

3. Enter Dimensions

Manually enter or adjust the desired crop box dimensions as the (X,Y) position of the upper left corner, and
the box width and height.

Auto
Crops the image to the perimeter of the features nearest to the image edges.

Apply Last
Requires a previous Crop Image step

Crops the image using the area defined in the last Crop Image step in the recipe.

Tips

• Recipe building is smoothest when all image cropping and resizing is done in the beginning of the
recipe.

• When working with large images, to improve performance, crop the image, optimize the recipe and
remove the crop step when complete.
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Resize Image
Edit > Resize Image

Resizes the image to the new dimensions, or by a size factor.

1. Dimensions

Resize image to new dimensions

• X: Enter new X-dimension. Leave blank (if Y is not) to maintain aspect ratio.

• Y: Enter new Y-dimension. Leave blank (if X is not) to maintain aspect ratio.

2. Size Factor

Resize by a multiplicative size factor (e.g., a size factor of 0.5 will reduce both X and Y dimensions by half)

Automatic Scale Adjustment

• In the Image Processor, when adding or removing a Resize step from a recipe, the scale will
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automatically adjust to compensate.
• In the Batch Processor, when loading an image where its scale is automatically read from its

metadata, this scale will automatically be adjusted by the presence of Resize steps in the recipe.
• These adjustments apply to the entire recipe, even steps before the Resize step.

Tips
• Recipe building is smoothest when all image cropping and resizing is done in the
beginning of the recipe.
• Depending on the resolution of the features you’re interested in segmenting, you can often
drastically improve performance by down-sampling your image. This is recommended only if
there is an insignificant loss of detail in the features of interest.
• Any steps involving image ‘Math’ will require both images to be the same size

!
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Rotate Image
Edit > Rotate Image

Rotates the image by the specified number of degrees. Positive rotation is counterclockwise and negative is
clockwise. Rotated image is clipped to maintain image frame dimensions.

Pixels that end up outside the image’s new location are set to 0, resulting in black regions in a grayscale
image and selected regions in a binary image.
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1. Angle

Angle to rotate image by. Positive rotations are counterclockwise and negative clockwise.

MIPAR MIPAR User Manual - v5.0_en

Page 133 of 696



Flip Image
Edit > Flip Image

Over Horizontal
Flips the image over the horizontal axis.

Over Vertical
Flips the image over the vertical axis.
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Translate Image
Edit > Translate Image

Translates the image by a specified X and Y pixel distance.

Pixels that end up outside the image’s new location are set to 0, resulting in black regions in a grayscale
image and selected regions in a binary image.
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1. X-Shift

Pixels to shift in X-direction

2. Y-Shift

Pixels to shift in Y-direction
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3. Padding

Choose to use black or white padding when translating the image

Tips

• You can create image borders to use as a ‘Companion’ by selecting: Blank > Translate Image.
• Example: Blank > Translate: can generate a 1 pixel boundary line that you can use to isolate features

touching a single edge.
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*Register Image
Edit > *Register Image

*Register Image
Requires Companion Image

Aligns the Current Image to the Companion Image using either a translation, rigid, similarity, affine, or free-
form registration.

1. Registration Type

• Free-Form: Allows full non-rigid image distortions

MIPAR MIPAR User Manual - v5.0_en

Page 138 of 696



• Translation: Allows only image translation in X and Y

• Rigid: Allows image translation and rotation

• Similarity: Allows image translation, rotation, and uniform scaling

• Affine: Allows image translation, rotation, uniform scaling, non-uniform scaling, and shearing

2. Processor (for Registration Type “Free-Form”)

Not used currently

3. Similarity Metric (for all other Registration Types)

• Monomodal: Used for aligning two images of the same contrast type

• Multimodal: Used for aligning two images of different contrast type

Apply Last
Requires a previous Register Image step

Aligns the Current Image to the Companion Image using the registration determined by the last Register
Image step in the recipe.
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Sparsely Sample Image
Edit > Sparsely Sample Image

Generate a Random distribution or regular Grid of pixels on a blank image. Can be done randomly with a
specified retained percentage or in a regular grid with specified pixel spacing.
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1. Method

• Random: Use random sampling to produce sparse image
• Grid: Sparsely sample using regularly-spaced grid. Can be used to generate horizontal or vertical

lines by setting the X Axis Value to 1 or Y Axis Value to 1 respectively. For example, X value of 1 and
Y value of 5 will result in a horizontal line every 5 pixels using the step method.

2. X Axis Value

Define either the step size, or number values.

3. X Axis Method

• Step: set space between selected pixels (black).
• Number: set a specified number of points per side.

4. Y Axis Value

Define either the step size, or number values.

5. Y Axis Method

• Step: set space between selected pixels (black).
• Number: set a specified number of points per side.

6. Link X and Y Method

Used to unlink the X and Y Methods allowing the grid to use different methods for the X and Y axis. For
example, X axis can use a set number of points and Y axis can use regular spacing.

MIPAR MIPAR User Manual - v5.0_en

Page 141 of 696



7. Random Rate

Percentage of pixels to select (black) vs total pixels in the image.

MIPAR MIPAR User Manual - v5.0_en

Page 142 of 696



Draw Random Lines
Edit > Draw Random Lines

Draws a number of random lines on the Current Image.
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1. Lines

Number of random lines to draw.

MIPAR MIPAR User Manual - v5.0_en

Page 144 of 696



Color
Contains functions that operate on colored original images, producing grayscale Current Images from
combinations of the various color channels.

Functions

• Color Select
• Color Cluster
• Color Deconvolution
• Channel Operation
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Color Select
Color > Color Select

Selects pixels from a color Opened Image within the specified hue, saturation, and value ranges.
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1. Hue

Sets the hue selection range. When the first limit is less than the second, the range between the two limits
will be selected. When the first limit is greater than the second, the selection will be above the first limit,
passed 360, to the second limit (selecting all the red hues).

2. Saturation

Sets the saturation selection range.

3. Value

Sets the value selection range.

Tips

• Color Select is always applied to the original color image
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Color Cluster
Color > Color Cluster

Assigns each pixel from the color Opened Image to one of the specified classes using k-means clustering
[1-4]. This can be a powerful and objective way of segmenting color images. Works well for color images
with 2 or more feature types of interest, where different colors define the different feature types. This
function results in a grayscale image where each class is colored according to the class which it belongs.

To split the resulting image into different Layers, add a Set Memory image step afterwards, then iteratively
call that restore image and use “Range Threshold” steps to select the different classes as B/W images.
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1. Classes

Number of classes to cluster each pixel into. If you are trying to segment one set of features from the
background, you should enter 2 classes.
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2. Flatten Background

Controls the window size used for background flattening prior to clustering. Use 0 for no background
flattening.

3. Speed

Parameter that controls the resolution of the cluster. Lower speed results in higher resolution clustering, but
takes longer. Higher speed results in faster execution but lower resolution clustering.

Example

Example Recipe following a Color Cluster step which selects each class and sets it as a Layer.

References
[1] Arthur, David, and Sergi Vassilvitskii. “K-means++: The Advantages of Careful Seeding.” SODA ‘07:
Proceedings of the Eighteenth Annual ACM-SIAM Symposium on Discrete Algorithms. 2007, pp.
1027–1035.

[2] Lloyd, Stuart P. “Least Squares Quantization in PCM.” IEEE Transactions on Information Theory. Vol.
28, 1982, pp. 129–137.

[3] Seber, G. A. F. Multivariate Observations. Hoboken, NJ: John Wiley & Sons, Inc., 1984.

[4] Spath, H. Cluster Dissection and Analysis: Theory, FORTRAN Programs, Examples. Translated by J.
Goldschmidt. New York: Halsted Press, 1985.
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Tips

• Color Cluster is always applied to the original color image
• Works best when the features of interest are further away from each other on the color spectrum

Tutorials

https://www.youtube.com/embed/xdrw2Utgb2c?rel=0

https://www.youtube.com/embed/xdrw2Utgb2c?rel=0

MIPAR MIPAR User Manual - v5.0_en

Page 152 of 696

https://www.youtube.com/embed/xdrw2Utgb2c?rel=0
https://www.youtube.com/embed/xdrw2Utgb2c?rel=0


Color Deconvolution
Color > Color Deconvolution

Function is always applied to the original color image. Color Deconvolution is used to separate a color
image into channels (colors) that are not the basic red, blue and green channels. It is a powerful tool in pre-
processing color images that generates grayscale channel operations that can be further filtered to select
features of interest.

Applications vary range from biomedical histology to mineral geology. Deconvolution works best on
uncompressed file formats such as a TIFF.
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1. Method

Select to manually outline the colors to be separated. Only option available at this time.

2. Resulting Channel Operation

Once the deconvolution is performed a channel operating is generated. Select Show to view the resulting
grayscale image and check ‘Add to Recipe’ to automatically generated the channel operation in the Image
Processor recipe.
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3. Perform/Update

Once at least two of the color fields were selected, the image can be deconvoluted into channel operations
which will appear under each color.

References
[1] Ruifrok, A. C., & Johnston, D. A. (2001). Quantification of histochemical staining by color deconvolution.
Analytical and Quantitative Cytology and Histology, 23(4), 291–299. https://doi.org/10.1097/
00129039-200303000-00014

Tips

• Color Deconvolution is always applied to the original color image
• Works best on uncompressed file formats such as TIFFs
• Critically important to be accurate and precise in manual selection of the colors

Tutorials

https://www.youtube.com/embed/KlkunloiWkE?rel=0

https://www.youtube.com/embed/KlkunloiWkE?rel=0
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Channel Operation
Color > Channel Operation

Performs an arithmetic operation on the channels of the opened image. Only applies to color images (i.e.
images with multiple channels).

Download a recipe of example channel operations for your color image. An example color image may be
downloaded here.

1. Channel Operation

Variables in the operation can be “Auto”, “auto”; “r”, “R”, “red”, or “Red”; “g”, “G”, “green”, or “Green”; “b”,
“B”, “blue” or “Blue”; “c1”, “c2”, . . . , “c50”; and “a”, “A”, “alpha”, or “Alpha”. “Auto” eliminates the hue and
saturation information while retaining the luminance.

Mathematical operators can be “+”, “-”, “*”, “/”, “^”, “(” and “)”, “[” and “]”, and “~”.

2. Overflow

Specify post-processing to make sure that the results of the mathematical expression fit within the numerical
limits of the image format (minimum is 0; maximum is 255 for 8-bit, 65,535 for 16-bit, and 1.0 for floating-
point).
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• Normalize Top: (default) The maximum pixel value of the expression’s output is normalized to the
format’s max value, 0 remains at 0, and numbers below 0 are clipped to 0.

• Normalize Bottom: The minimum pixel value of the expression’s output is normalized to 0, the
format’s max value remains at that max value, and numbers above the max value are clipped to the
max value.

• Normalize Both: The maximum pixel value of the expression’s output is normalized to the format’s
max value, and the minimum pixel value of the expression’s output is normalized to 0.

• Clip: Numbers below 0 are set to 0, and numbers above the max value are set to that max value.

3. Divide by Zero

How to handle pixels which generate divide-by-zero events during evaluation of the mathematical
expression:

• White: (default) X / 0 = white, -X / 0 = black, 0 / 0 = black
• Black: X / 0 = black, -X / 0 = white, 0 / 0 = black

Note that divide-by-zero pixels are ignored when calculating any normalization specified by the Overflow
option.
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Pre-Processing
Contains functions for manipulating grayscale pixel intensity. These functions as typically used as
precursors to segmentation and clean-up steps, to improve the accuracy of the final feature selection.

Functions

Contrast

• Adjust Contrast
• Histogram Equalization
• *Histogram Match
• Flatten Background

Cluster

• Smart Cluster
• Superpixels

Noise Reduction

• Median Filter
• Wiener Filter
• Non-Local Means

Blur

• Gaussian Blur
• Average Blur
• Sum Filter
• Grayscale Dilate
• Grayscale Erode

Edges

• StdDev Filter
• Entropy Filter
• Gradient Filter
• Highlight Lines

Texture

• Bright Texture
• Dark Texture
• Advanced Texture
• Pattern Mapping
• Symmetry Mapping
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• Orthogonal Correlate
• *Cross-Correlate

Correction

• Sharpen
• FFT Filter
• Make FFT
• Apply Stored FFT Filter
• *Grayscale Interpolation
• *Grayscale Reconstruction
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Adjust Contrast
Pre-Processing > Adjust Contrast

Enhances image brightness and contrast by setting new white and black grayscale levels, and scaling the
other levels accordingly. In 8-bit grayscale images, 0 is black and 255 is white by default. Image contrast
can enhanced by redefining new pixel values to represent black and white, and then stretching the in-
between values.

1. Mode

• Manual: Allows manual selection of levels

• Auto: Auto-selects new levels to maximize image contrast while minimizing information loss (levels
are recalcualted to each image to which this step is applied)
- Drop Down: Allows for automatic adjustment of either the Low Level, High Level or Both Levels.
- Adjustment: Specifies offset to make to auto-determined levels. A positive adjustment spreads the
auto-determined levels, and a negative adjustment contracts them.

2. Low Level

Pixel value to be the new black level
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3. High Level

Pixel value to be the new white level

4. Gamma

Controls the linearity of the black to white gradient of the grayscale spectrum. Lower values will more favor
the white end, and higher values the black. 1 is a perfect linear gradient.

Tips

Use Auto>High to white balance your image and use Auto>Low to black balance your image.
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Histogram Equalization
Pre-Processing > Histogram Equalization

Equalizes image brightness and contrast across the image by performing different histogram scaling in each
tile of grid of tiles whose size is defined by user [1].
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1. Method

Controls desired histogram shape for the image tiles

• Uniform: Flat-histogram

• Rayleigh: Bell-shaped histogram

• Exponential: Curved histogram

2. Tiles

Number of tiles to split the image into in each direction (Recommended: 8)

3. Enhancement

Adjusts amount of contrast enhancement. Higher values result in more contrast (Recommended: 0.01)

References
[1] Zuiderveld, Karel. “Contrast Limited Adaptive Histograph Equalization.” Graphic Gems IV. San Diego:
Academic Press Professional, 1994. 474–485.
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*Histogram Match
Pre-Processing > *Histogram Match

Requires Companion Image

Modifies the overall contrast of the Current Image to match as closely as possible to the overall contrast of
the Companion Image. Often used when you have a series of images that you want to normalize the
contrast of. In this case use Memory > Load Companion Image to load the “comparison image” into the
Companion Image slot. Then use Memory > Call Original Image to bring forward the original Opened Image.
Then Histogram Match will adjust the contrast of the Opened Image to match that of the Companion Image
(i.e., “comparison image”).
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Flatten Background
Pre-Processing > Flatten Background

Helps remove brightness gradients by applying a Gaussian blur to the Current Image and then subtracting
the blurred image from the Current Image.
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1. Sigma

Size of neighborhood (in pixels) which is considered about each pixel for the filter
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Smart Cluster
Segmentation > Smart Cluster

Assigns each pixel to one of the specified classes using k-means clustering [1-4]. This can be a powerful
and objective way of segmenting images. Works especially well for images with 3 or more feature types of
interest, where different grayscale levels define the different feature types. This function results in a
grayscale image where each class is colored according to the specified statistic of the underlying pixels.

To split the resulting image into different Layers, add a Set Memory image step afterwards, then iteratively
call that restore image and use “Range Threshold” steps to select the different classes as B/W images.
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1. Fill Type

Statistic to use to fill each cluster. Check “Auto Scale” to set the darkest class to black, set the brightest
class to white, and scale in-between classes accordingly.

• Mean: Fills each cluster with mean value of underlying pixels
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• Median: Fills each cluster with median value of underlying pixels

• StdDev: Fills each cluster with standard deviation of underlying pixels

• Min: Fills each cluster with minimum value of underlying pixels

• Max: Fills each cluster with maximum value of underlying pixels

• Class: Fills each cluster with value of its class. Image is normalized from 0 to 255 afterwards for
easier visualization.

2. Classes

Number of classes to cluster each pixel into. If you are trying to segment one set of features from the
background, you should enter 2 classes.

3. Edge Type

Class order for edge cleaning

• Dark to Bright: Expands each class to clean edges from darkest class to brightest class.
Recommended to clean edge artifacts for dark features on bright backgrounds.

• Bright to Dark: Expands each class to clean edges from brightest class to darkest class.
Recommended to clean edge artifacts for bright features on dark backgrounds.

4. Edge Clean

Factor which controls extent to which edge artifacts are removed. The value indicates the max pixel
thickness of edge artifacts that will be removed. Use 0 for no cleaning.

5. Speed

Parameter that controls the resolution of the cluster. Lower speed results in higher resolution clustering, but
takes longer. Higher speed results in faster execution but lower resolution clustering.

References
[1] Arthur, David, and Sergi Vassilvitskii. “K-means++: The Advantages of Careful Seeding.” SODA ‘07:
Proceedings of the Eighteenth Annual ACM-SIAM Symposium on Discrete Algorithms. 2007, pp.
1027–1035.

[2] Lloyd, Stuart P. “Least Squares Quantization in PCM.” IEEE Transactions on Information Theory. Vol.
28, 1982, pp. 129–137.
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[3] Seber, G. A. F. Multivariate Observations. Hoboken, NJ: John Wiley & Sons, Inc., 1984.

[4] Spath, H. Cluster Dissection and Analysis: Theory, FORTRAN Programs, Examples. Translated by J.
Goldschmidt. New York: Halsted Press, 1985.

Tips

• Smart cluster with 2 classes is equivalent to a basic threshold with the ‘Auto’ setting, avoid this to
improve objectivity

• Use smart cluster to objectively classify grayscale image data into discrete feature clusters where the
number of classes is equal to the number of discrete features you’re interested in.

Tutorial

https://www.youtube.com/embed/FxebQbpdRuE?rel=0

https://www.youtube.com/embed/FxebQbpdRuE?rel=0
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Superpixels
Segmentation > Superpixels

Groups pixels into regions with similar values. This can be a helpful processing step prior to other
segmentation or feature-finding steps. Uses the simple linear iterative clustering (SLIC) algorithm [1,2].
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1. Type

Statistic to use to fill each cluster

• Mean: Fills each superpixel with mean value of underlying pixels

• Median: Fills each superpixel with median value of underlying pixels

• Mode: Fills each superpixel with mode value of underlying pixels

• StdDev: Fills each superpixel with standard deviation of underlying pixels

• Min: Fills each superpixel with minimum value of underlying pixels

• Max: Fills each superpixel with maximum value of underlying pixels

2. Number

The target number of superpixels to create. Actual number may be different.

3. Shape

Factor which controls the shape of the superpixels. Lower numbers produce more realistic shapes that
follow boundaries. (Recommended: 10)

References
[1] Radhakrishna Achanta, Appu Shaji, Kevin Smith, Aurelien Lucchi, Pascal Fua, and Sabine Susstrunk,
SLIC Superpixels Compared to State-of-the-art Superpixel Methods. IEEE Transactions on Pattern Analysis
and Machine Intelligence, Volume 34, Issue 11, pp. 2274-2282, May 2012

[2] Radhakrishna Achanta, Appu Shaji, Kevin Smith, Aurelien Lucchi, Pascal Fua, and Sabine Susstrunk,
SLIC Superpixels. EPFL Technical Report, no. 149300, June 2010.
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Median Filter
Pre-Processing > Median Filter

Helps reduce sparse noise. Sets each pixel in the Current Image equal to the median pixel value of its
specified neighborhood.
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1. Window Size

Size of neighborhood (in pixels) which is considered about each pixel for the filter

Tips

• Noise-reduction filters are often very useful for removing granular noise while maintaining clean
feature boundaries.

• We recommend you try all of the filters to find which once works best.
• Starting Window Size Value: 7, increase to remove larger artifacts.
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Wiener Filter
Pre-Processing > Wiener Filter

Reduces sparse noise while preserving edges. Sets each pixel in the Current Image equal to the median
pixel value of its adjusted specified neighborhood size [1]. Pixels with near edges will use smaller
neighborhood sizes.
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1. Window Size

Size of neighborhood (in pixels) which is considered about each pixel for the filter

References
[1] Lim, Jae S., Two-Dimensional Signal and Image Processing, Englewood Cliffs, NJ, Prentice Hall, 1990,
p. 548, equations 9.26, 9.27, and 9.29.

Tips

• Noise-reduction filters are often very useful for removing granular noise while maintaining clean
feature boundaries.

• We recommend you try all of the filters to find which once works best.
• Starting Window Size Value: 5, increase to remove larger artifacts
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Non-Local Means
Pre-Processing > Non-Local Means

Reduces image noise using an advanced filtering algorithm [1]. Each pixel’‘s local window is compared to
windows around it. The windows’ center pixels are averaged together with weights depending on the
variations between the windows.
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1. Window Size

Size of neighborhood (in pixels) which is considered about each pixel for the filter (RECOMMENDED: 2-6)

2. Strength

Factor which controls the strength of the filter (Recommended: 0.2-0.6)
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References
[1] Buades, A., B. Coll, and J.-M. Morel. “A Non-Local Algorithm for Image Denoising.” 2005 IEEE®
Computer Society Conference on Computer Vision and Pattern Recognition. Vol. 2, June 2005, pp. 60–65.

Tips

• Noise-reduction filters are often very useful for removing granular noise while maintaining clean
feature boundaries.

• We recommend you try all of the filters to find which once works best.
• Non-Local Means is one of the more powerful pre-processing filters MIPAR has to offer, but can take

longer to execute for larger images.
• Starting Window Size Value: 2-4, Strength: 0.2, decrease Strength for low resolution images.

Increasing window size above 20 increases time of execution with little changes.

MIPAR MIPAR User Manual - v5.0_en

Page 179 of 696



Gaussian Blur
Pre-Processing > Gaussian Blur

Blurs the Current Image by setting each pixel equal to the weighted average pixel value of its specified
Gaussian neighborhood.
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1. Sigma

Size of neighborhood (in pixels) which is considered about each pixel for the filter

Tips

Blur filters are often very useful for removing small artifacts in order to threshold larger features.
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Average Blur
Pre-Processing > Average Blur

Blurs the Current Image by setting each pixel equal to the average pixel value of its specified box
neighborhood.
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1. Window Size

Size of neighborhood (in pixels) which is considered about each pixel for the filter

Tips

Blur filters are often very useful for removing small artifacts in order to threshold larger features.
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Sum Filter
Pre-Processing > Sum Filter

Sum filters the Current Image by setting each pixel equal to the sum pixel value of its specified
neighborhood.
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1. Window Size

Size of neighborhood (in pixels) which is considered about each pixel for the filter
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Grayscale Dilate
Pre-Processing > Grayscale Dilate

Sets each pixel in the Current Image equal to the maximum pixel value in its specified neighborhood.

1. Radius

Radius (in pixels) to consider about each pixel to calculate the local maxima
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Grayscale Erode
Pre-Processing > Grayscale Erode

Sets each pixel in the Current Image equal to the minimum pixel value in its specified neighborhood.

1. Radius

Radius (in pixels) to consider about each pixel to calculate the local minima
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StdDev Filter
Pre-Processing > StdDev Filter

Accentuates edges by brightening pixels which have dissimilar neighbors. Sets each pixel in the Current
Image equal to the standard deviation of the pixel values in its specified neighborhood.
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1. Window Size

Size of neighborhood (in pixels) which is considered about each pixel for the filter

Tips

• Used to find feature boundaries and to increase the contrast of features differing in intensity.
• Powerful filter that can be used in combination with Find Edges, Dilation, Erosion and the

Optimization Engine to improve segmentation of features.
• Example 1 (Faint grain boundaries): StdDev Filter
• Example 2 (Subjective feature Dilation/Erosion): StdDev Filter
• Starting Window Size: 5, increase to overpower small artifacts, decrease to maintain an accurate

feature edge
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Entropy Filter
Pre-Processing > Entropy Filter

Accentuates edges by brightening pixels which have dissimilar neighbors. Sets each pixel in the Current
Image equal to the entropy (measure of disorder) of the pixel values in its specified neighborhood [1].
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1. Window Size

Size of neighborhood (in pixels) which is considered about each pixel for the filter

References
[1] Gonzalez, R.C., R.E. Woods, S.L. Eddins, Digital Image Processing Using MATLAB, New Jersey,
Prentice Hall, 2003, Chapter 11.
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Gradient Filter
Pre-Processing > Gradient Filter

Sets each pixel in the Current Image inversely proportional to the average gradient magnitude of its
specified neighborhood.
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1. Sigma

Size of neighborhood (in pixels) which is considered about each pixel for the filter
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Highlight Lines
Pre-Processing > Highlight Lines

Uses the Frangi filter [1] to highlight linear-type features in the image. Combine with a threshold afterwards
to select certain linear-type features.
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1. Type

• Dark: Highlight dark linear-type features

• Bright: Highlight bright linear-type features

2. Thickness

Factor which controls the thickness of the lines that are targeted (Recommended: 1-3)

3. Strength

Factor which controls the strength of the Frangi (line-highlighting) filter (Recommended: 1-3)

Tips

• Useful for identifying continuous lines in an image. Image pre-processing is recommended to reduce
noise when using this function.

References
[1] Frangi, Alejandro F., Wiro J. Niessen, Koen L. Vincken, and Max A. Viergever. “Multiscale vessel
enhancement filtering.” In International Conference on Medical Image Computing and Computer-Assisted
Intervention, pp. 130-137. Springer Berlin Heidelberg, 1998.
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Bright Texture
Pre-Processing > Bright Texture

Highlights bright components of image textures that are no bigger than the specified window size. Also
known as a top-hat filter, it computes the grayscale opening (grayscale dilation followed by grayscale
erosion) of the Current Image by the specified window size, then subtracts the result from the Current
Image.
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1. Window Size

Window size (in pixels) to consider about each pixel to calculate the filter. Controls the maximum size of
bright feature components to highlight.

Tips

• Useful for increasing the contrast of flat grey scale features, for example, cells imaged under phase
contrast.

• Useful for removing large overexposed regions in fluorescence imaging.
• Starting Window Size: depends on image resolution, start in the middle of the slider, increase to

increase brightness, decrease to decrease brightness.
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Dark Texture
Pre-Processing > Dark Texture

Highlights dark components of image textures that are no bigger than the specified window size. Also known
as a bottom-hat filter, it computes the grayscale closing (grayscale erosion followed by grayscale dilation) of
the Current Image by the specified window size, then subtracts the result from the Current Image.
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1. Window Size

Window size (in pixels) to consider about each pixel to calculate the filter. Controls the maximum size of
dark feature components to highlight.
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Advanced Texture
Pre-Processing > Adjust Texture

Uses advanced algorithms to highlight various forms of texture in an image. Options include measuring
aspects of each pixel’s Hessian matrix [1] and Gabor filters [2].
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1. Type

• Module:

• Trace:

Note that the trace of the hessian matrix is the same as the laplacian operator.

• Determinant:

This filter is well-suited to finding corners.

• First Eigen:
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• Second Eigen:

• Orientation:

• Eigen Difference:
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• Square Eigen Difference:

• Gabor:

2. Radius

Radius (in pixels) to consider about each pixel to calculate the specified filter.

MIPAR MIPAR User Manual - v5.0_en

Page 203 of 696



References
[1] D. Eberly, “Ridges in Image and Data Analysis”, Kluwer Academic Publishers, 1996.

[2] Fogel, I.; Sagi, D. (1989). “Gabor filters as texture discriminator”. Biological Cybernetics. 61 (2).
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Similarity
Contains filters that detect similarity and symmetry within an image or between two images.

• Pattern Mapping
• Orthogonal Correlate
• Symmetry Mapping
• *Cross-Correlate
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Pattern Mapping
Pre-Processing > Similarity > Pattern Mapping

Processes and colors pixels based on their surrounding image pattern. Produces a grayscale map of the
pattern indicator for further processing into an ultimate selection.

Available tools for pattern analysis are local two-point correlation properties, mapping of selected FFT
intensities, and matching of local FFTs to selected references. This function can take some time to complete
depending on the size of the image and Window Size parameter.

After first clicking “Calculate”, a parallel-pool of CPU resources will be created which may take several
seconds. This parallel-pool is good for 30 minutes and will not have to be re-created within that time. It is
recommended that this function not be run on images larger than 1200×900, and that the window size be
kept to 40 pixels or less.
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1. Method

• Two-Point Correlation: Calculates the two-point correlation function at each pixel, using a surround
window of a specified size. The orientation, size, and shape of the “hotspot” of a pixel-window’s two-
point correlation tell you information about the window’s local directionality, the extent of that
directionality, and the size of features within the window.

• FFT Mapping: Allows you to define a mask to place around the FFT taken about each pixel, and
either sum the intensities or take the peak intensity within the mask. This measurement is then
assigned to each pixel. In essence, you are mapping out traits about each pixel’s local FFT, which can
reveal local pattern differences in the image. The size of the window taken about the click to define
the mask is determined by Window Size. It is often advised to set a large Window Size prior to
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clicking to define the mask, and then reducing the Window Size to something much smaller to perform
the mapping.

• FFT Matching: Allows to define a fixed number of reference FFTs (i.e., “fingerprints”) by clicking
points within the image. The size of the window taken about each click to define the “fingerprints” is
determined by Window Size . Each pixel’s local FFT is then compared to each “fingerprint”, and
labeled according to which “fingerprint” it matched the best.

2. Window Size

Window size to consider about each pixel for the pattern map

3. Speed

Controls the speed of the pattern mapping by increasing or decreasing the degree of downsampling

4. Metric

Mapped parameter to display

5. Colormap and Limits

Colormap to use for display, along with upper and lower limits for the colormap. Click “Auto” to automatically
set the default limits.
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Orthogonal Correlate
Pre-Processing > Matching > Orthogonal Correlate

Sets each pixel of the Current Image to the average correlation coefficient between its window and the
windows in each of the four orthogonal directions. Can be used to identify regions of certain symmetries in
“Normalized” mode, and as a contrast enhancement technique in “Absolute” mode.
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1. Type

Sets type for orthogonal correlation finding.

• Normalized: Calculate normalized correlation coefficient at each pixel. Helpful for highlighting out
regions of local similarity.
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• Absolute: Calculate absolute correlation coefficient at each pixel. Helpful for enhancing image
contrast.

2. Rotation

Choose whether rotate image about its center before correlating each pixel with its four orthogonal windows.

• Off: Do not rotate image before choosing orthogonal windows about each pixel

• On: Rotate image before choosing orthogonal windows about each pixel. Set the angle for rotation.

3. Step Size

Step size to move in either direction to choose orthogonal windows. For contrast enhancement, larger step
size can result in more blurring, and should be kept as close to 1 as possible.

4. Window Size

Size of the orthogonal windows. For contrast enhancement, larger window size can result in more blurring,
and should be kept as close to 2 as possible.
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Symmetry Mapping
Pre-Processing > Matching > Symmetry Mapping

Measures the degree of specified symmetry about each pixel. Bright pixels in the symmetry-filtered image
indicate pixels which had high similarity of the specified angles.

MIPAR MIPAR User Manual - v5.0_en

Page 212 of 696



1. Mapping

a. Window Size

Window size to consider about each pixel for the pattern map

b. Calculate

Calculate symmetry map

2. Display

a. Single Angle

Display symmetry map for single angle. Options are 90°, 180°, and 270°. For example, selecting 90° will set
each pixel based on the amount of 90° rotational symmetry about the pixel.

b. Multiple Angles

Display symmetry map for arithmetic between multiple angles. Set arithmetic for symmetry map from
dropdowns.

c. Auto

Auto-display symmetry map. Select a method for auto-display.
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*Cross-Correlate
Pre-Processing > Matching > *Cross Correlate

Requires B/W Companion Image

Correlates each pixel in the Current Image with the Companion Image.
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Sharpen
Pre-Processing > Sharpen

Sharpens the Current Image by deconvolving an unsharpening kernel out of each pixel.

1. Alpha

Parameter which controls sharpness. Higher values produce more sharpening.
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Tips

Useful for restoring the contrast of fine features dulled by noise removing filters.
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Frequency
Contains filters that work by manipulating the image’s FFT (fast-Fourier transform), which expresses pixels
in frequency space.

• FFT Filter
• Make FFT
• Apply Stored FFT Filter
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FFT Filter
Pre-Processing > Frequency > FFT Filter

Modifies the Fourier transform of the Current Image with either custom or preset filters. Has many
applications, ranging from background removal to edge-finding to artifact reduction.

1. Custom

a. Selection Tools

• Outline: Fill/erase a polygon area by clicking to create nodes. Click the last node to close the
polygon.

• Ellipse: Click, drag, and release to fill/erase an elliptical/circular selection

• Box: Click, drag, and release to fill/erase a rectangular/square selection

• Freehand: Click, drag, and release to fill/erase a freehand selection. Selection closes automatically.
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• Line: Click, drag, and release to fill/erase a straight line selection

• Pen: Click, drag, and release to fill/erase a pen (freehand line) selection

• Circle Click: Click a point to define a center of circular selection. Pixel diameter of circles is
determine by Pen Size.

b. Process Selection

• Erase: Erase the selection from the image’s FFT

• Keep: Keep the selection in the image’s FFT (discards the rest if no other selection has been
processed, adds the selected intensity back if one has been processed)

• Undo Undo the last fill/erase operation

b. Mirror/Invert Selection

• Mirror X-Axis: Mirror current filter over X-axis

• Mirror Y-Axis: Mirror current filter over Y-axis

• Mirror Origin: Mirror current filter over origin

• Invert: Invert current filter

b. Pen Size

Controls the thickness (in pixels) of the Line and Pen selection tools, as well as the diameter (in pixels) of
the circles created by the Circle Click tool

2. Cutoff

Use a cutoff filter. Places a hard-edged circle filter around the center of the FFT.

• Low-Pass: Keep frequencies within the filter

• High-Pass: Keep frequencies outside filter

• Cutoff Frequency: Size of the filter circle in frequency space

3. Ideal

Use an ideal filter. Places a 2D Gaussian filter around the center of the FFT.

• Low-Pass: Keep frequencies within the filter
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• High-Pass: Keep frequencies outside filter

• Sigma: Proportional to the size of the filter circle in frequency space

4. Annular

Use an annular filter. Places a ring filter around the center of the FFT.

• Inside-Pass: Keep frequencies within the filter

• Outside-Pass: Keep frequencies outside the filter

• Outer Frequency: Size of the outer ring diameter

• Inner Frequency: Size of the inner ring diameter

Tips

• The points on the FFT will always be perpendicular to the direction of the artifact you wish to remove.
• Example: SEM curtaining is causing vertical artifacts in the image, remove horizontal points in FFT to

remove curtaining. (See Tutorial Video)

Tutorial
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https://www.youtube.com/embed/X2GzqYL_i88?rel=0

https://www.youtube.com/embed/X2GzqYL_i88?rel=0
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Make FFT
Pre-Processing > Frequency > Make FFT

Generates FFT of the Current Image. Useful for building custom filters with subsequent recipe steps, and
then applying the filter with “Apply Stored FFT Filter” after setting filter as the Companion Image.
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Apply Stored FFT Filter
Pre-Processing > Frequency > Apply Stored FFT Filter

Applies the Companion Image as an FFT filter to the Current Image. Dark or black pixels in the filter will
remove those portions of the image’s FFT. Current Image should be the image to be filtered, and
Companion Image should hold the filter to apply in FFT space.
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*Grayscale Interpolation
Pre-Processing > *Grayscale Interpolation

Requires B/W Companion Image

Reconstructs missing pixels (identified as selection in the Companion Image) using by averaging the known
pixels (empty in Companion Image) within a specified neighborhood.
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1. Type

• Mean: Uses mean of known pixels within window to replace unknown pixels

• Median: Uses median of known pixels within window to replace unknown pixels

1. Iterations

• Single: Interpolates missing pixels once though the image

• Complete: Interpolates missing pixels until there are none left in the image

3. Window Size

Window size to consider about each pixel for the mean or median calculation
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*Grayscale Reconstruction
Pre-Processing > *Grayscale Reconstruction

Requires B/W Companion Image

Changes grayscale pixel values based on features in the Companion Image. Available modes are
morphological reconstruction, impose minima (ensures that minima in the grayscale image only occur at
feature pixels), or set pixels equal to the mean, median, or standard deviation of the pixels within each
feature.
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1. Mode

• Inpainting: Smoothly interpolates inward within each marked region from the pixel values on the
outer boundary of the region. Works by computing the discrete Laplacian over the regions and solves
the Dirichlet boundary value problem for each [1].

• Morphological Reconstruction: Performs morphological reconstruction using the defined markers
[2]
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• Impose Minima: Modifies the image so that it only has local minima wherever markers are defined

• Fill With Mean: Fills the pixels within the marker regions with the mean pixel value of that region

• Fill With Median: Fills the pixels within the marker regions with the median pixel value of that region

• Fill With Mode: Fills the pixels within the marker regions with the mode pixel value of that region

• Fill With StdDev: Fills the pixels within the marker regions with the standard deviation pixel value of
that region

• Fill With Min: Fills the pixels within the marker regions with the minimum pixel value of that region

• Fill With Max: Fills the pixels within the marker regions with the maximum pixel value of that region

References
[1] Pérez, Patrick, Michel Gangnet, and Andrew Blake. “Poisson image editing.” In ACM Transactions on
Graphics (TOG), vol. 22, no. 3, pp. 313-318. ACM, 2003. Harvard

[2] Vincent, L., “Morphological Grayscale Reconstruction in Image Analysis: Applications and Efficient
Algorithms,” IEEE Transactions on Image Processing, Vol. 2, No. 2, April, 1993, pp. 176-201.
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Deep Learning
Contains functions for applying AI-based models for feature detection. Models are created in the Deep
Learning Trainer.

Functions

• Apply Model
• Call Output
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Apply Model
Deep Learning > Apply Model

Applies a trained deep learning model to the selected image. Output can be a probability map of any of the
trained layers, or a layer map. A probability map indicates each pixel’s likelihood to belong to that layer. A
layer map represents the most likely layer for each pixel.
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1. Load Model

Load deep learning model. These are created and saved from the Deep Learning Trainer.

2. Apply To

Choose image to apply model to.

• Color Image: Model is applied to the originally opened color image (only available for color images).

• Current Image: Model is applied to Current Image.

3. Processor

Processor to apply model with.

• GPU: Apply model on the GPU (strongly recommended — see Deep Learning System Requirements
for more information).

• CPU: Apply model on the CPU.

4. Size Factor

Resize factor prior to applying model (0-1). Image will be resized according to the this factor, model applied,
then results upsampled back to original size. It is recommended to use the same size factor as was used to
train the model.

5. Apply Model

Apply deep learning model.

6. Output

Choose image to display and output.

• Layer Map: Represents the most likely Layer classification for each pixel.

• Other Options: Probability maps of the trained Layers. A probability map indicates each pixel’s
likelihood to belong to that layer.

Example
Applying a deep learning model
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Call Output
Deep Learning > Call Output

Calls an output from a deep learning model applied earlier in the Recipe. This is useful for performing
separate processing workflows on different probability maps from a single Apply Model step.
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1. Output

Choose image to display and output

• Layer Map: Represents the most likely Layer classification for each pixel

• Other Options: Probability maps of the trained Layers. A probability map indicates each pixel’s
liklihood to belong to that layer.
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Segmentation
Contains functions for selecting features in the image. These operate on grayscale images and range from
simple such as Basic Threshold, to more advanced such as Adaptive Threshold and Watershed.

Functions

• Invert
• Blank
• Manual Edit

Threshold

• Basic Threshold
• Range Threshold
• Adaptive Threshold
• E-M Threshold
• *Local Threshold

Edges

• Watershed
• Find Edges
• Find Circles
• Find Lines

- Find Text
- Find Facial Features

Snap

• Auto Segmentation
• *Region Grow
• *Fast Marching Method
• *Active Contour

Extrema

• Find Global Maximum
• Find Global Minimum
• Find Local Maxima
• Find Local Minima
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Invert
Segmentation > Invert

Inverts the Current Image. Grayscale pixels become 255 minus their value. Selected pixels become empty,
and empty pixels become selected.

Tips

When segmenting particles from matrix in a composite material, often times it is easier to accurately select
the sample matrix and invert to result in particle selection.
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Blank
Segmentation > Blank

Creates a blank segmentation. Useful for manually creating seeds with “Manual Edit” for use with steps
such as “Region Grow”, “Active Contour”, and “Local Threshold

Tips

• Use in combination with Manual Edit tools and Edit>Position tools to create masks used for ‘Math’
steps.

• Example: Blank>Translate: can generate a 1 pixel boundary line that you can use to isolate features
touching a single edge.
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Manual Edit
Segmentation > Manual Edit

Opens the Current Image in an editor which allows for manual edits to its segmentation. Here you can add
missed features and remove artifacts. Also useful for manually defining a region of interest (ROI), which
when set in a memory image, can be used to restrict your feature selection to a certain area in the image.

This function requires the previous step to produce a segmentation, not a grayscale image. Accordingly, it
also cannot be the first step in a recipe; to achieve a similar effect, precede it with a Segmentation -> Blank
step.
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1. Selection Tools

• Snap: Fill/erase objects using advanced AI segmentation. Powered by Spotlight.

• Magic Wand: Click a point to magic-wand select a region around it based on the surrounding
grayscale pixel values. Tolerance defines how different neighboring pixel intensities can be included
in the region. Higher tolerance leads to larger regions.

• Pen: Click, drag, and release to fill/erase a pen (freehand line) selection
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• Line: Click, drag, and release to fill/erase a straight line selection

• Select: Click a feature to fill/erase it.

• Freehand: Click, drag, and release to fill/erase a freehand selection. Selection closes automatically.

• Circle Click: Click a point to define a center of circular selection (pixel diameter of circles is
determine by Pen Size). Click 2 or 3 points (double-click the last) to define a circle which intersects
them.

• Ellipse: Click, drag, and release to fill/erase an elliptical/circular selection

• Outline: Fill/erase a polygon area by clicking to create nodes. Click the last node to close the
polygon.

• Box: Click, drag, and release to fill/erase a rectangular/square selection

2. Tool Settings

Context-aware settings show based on the active tool. Pen Size sets line thickness for Pen and Line, and
diameter for 1-click Circle Click. Tolerance sets sensitivity of Magic Wand. Snap settings are described
here.

3. Tool Mode

• Fill: Fill the selection (make it black in B/W view)

• Erase: Erase the selection (make it white in B/W view)

4. Options

• Invert Selection: Invert the current selection tool operation (select/erase everything else)

• Include Contacted: Include entire features that even partially contact the current selection

5. Undo

• Undo Undo the last fill/erase operation

6. Reset

Clears all edits, both fills and erasures, made to the selection.

See Keyboard Shortcuts for shortcuts relevant to manual editing tools.*
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7. Reset on Load

Clears manual edits each time the recipe is applied to a new image (or re-loaded on an image in the Image
Processor).
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Basic Threshold
Segmentation > Basic Threshold

Selects pixels based on whether they are below or above a certain pixel value. “Auto” determines this
threshold value using Otsu’s method, which chooses the value which minimizes the average grayscale
variance of the pixels which have been selected and not selected.

1. Value

Threshold value which sets pixels as selected or not

2. Select

• Dark: Selects pixels whose values are below the threshold value
• Bright: Selects pixels whose values are above the threshold value

3. Mode

• Manual: Allows manual selection of threshold value
• Auto: Auto-determines threshold value based on Otsu’s method [1]

- Adjustment: Specifies offset to make to auto-determined threshold value.
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4. Select

• Value: Selects pixels whose values are above or below the threshold value
• Percentage: Selects pixels whose values are above or below a percentage of the 0-255 image range

References
[1] Otsu, N., “A Threshold Selection Method from Gray-Level Histograms,” IEEE Transactions on Systems,
Man, and Cybernetics, Vol. 9, No. 1, 1979, pp. 62-66.

Tips

• Avoid using a Basic Threshold without any pre-processing. This often results in subjective,
inconsistent results.

• Recommend trying a Smart Cluster or other image normalization technique before applying a
threshold.
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Range Threshold
Segmentation > Range Threshold

Selects pixels if they are between a specified range of pixel values.

1. Minimum Value

Minimum threshold value

2. Maximum Value

Maximum threshold value

Tips

• Avoid using a Range Threshold without any pre-processing. This often results in subjective,
inconsistent results.

• It is recommended to try a Smart Cluster or other image-normalization technique before applying a
threshold.
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Adaptive Threshold
Segmentation > Adaptive Threshold

Selects pixels based on their intensity relative to some statistic of the surrounding neighborhood.

In the common Percentage mode, with “Statistic” set to Box Mean, pixel values are compared to their local
average grayscale value. For example, if Percentage and Box Mean modes are checked, “Select” is set to
Dark, Percentage value is 98, and Window Size is 30, then if a pixel is less than 98% of the average
grayscale value in a 30×30 pixel window centered around it, it will be selected. If “Select” is set to Bright,
then the pixel must be greater than 98% of its local 30×30 window average to be selected.

The window size is typically best set to be just larger than the size of the largest feature one is hoping to
capture. The Distance Line tool can help approximate this size.

1. Select

• Dark: Selects pixels which meet or fall below the criteria
• Bright: Selects pixels which meet or exceed the criteria
• Both: Selects pixels that are the + / – the “Departure” value, relative to their neighborhood statistic.

MIPAR MIPAR User Manual - v5.0_en

Page 244 of 696



Only applies to “Departure” mode.

2. Statistic

• Box Mean: Critical stat for each pixel is the mean of its neighborhood
• Box Median: Critical stat for each pixel is the median of its neighborhood
• Gaussian Mean: Critical stat for each pixel is the Gaussian mean of its neighborhood

3. Dynamic

• On: Critical difference or percentage for each pixel will be scaled based on local variance
- Direct: Higher local variance will raise critical difference or percentage
- Inverse: Higher local variance will lower critical difference or percentage

• Weight: Sets how strong the local variance will scale the critical difference or percentage

4. Mask

Only considers and thresholds pixels within the selection of the mask image

5. Operation

• Departure: Sets the critical threshold for each pixel as its difference from its neighborhood statistic
• Percentage: Sets the critical threshold for each pixel as its percentage of its neighborhood statistic

6. Percentage/Departure Value

Sets the critical value each pixel get assessed relative to (Recommended: Percentage = 100)

7. Window Size

Size of the local neighborhood that each pixel is considered against (Recommended: 30)
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Tips

• To determine a good starting window, using the line tool do some rough measurements of the
features you are interested in thresholding

• Starting Window Size Dark Selection: 90, reduce to reduce selection, increase to increase selection.
Bright Selection: 120, reduce to increase selection, increase to reduce selection.

• You can limit the threshold to a region of interest set by a Companion mask.
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E-M Threshold
Segmentation > E-M Threshold

Selects pixels if they are within a region in which none of its pixel have fallen below a threshold pixel value
distance from the nearest local minimum.

1. Connectivity

• 8-pixel: Uses 8-pixel connectivity (face-based) to determine local minima as the basis for the E-M
threshold

• 4-pixel: Uses 4-pixel (face+corner-based) connectivity to determine local minima as the basis for the
E-M threshold

2. Difference

Sets the maximum difference threshold pixel intensities can be from the nearest local minima in order to
grouped into that minima’s region
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*Local Threshold
Segmentation > *Local Threshold

Requires B/W Companion Image

Selects pixels if they meet the specified criteria relative to each feature in the Companion Image. “Auto
Threshold” mode calculates the Otsu-based optimum threshold for each feature. “Percentage Of” and
“Departure From” asses each pixel relative to its feature’s mean or median pixel value. “Upper Percentile
and “Lower Percentile” select the pixels within the specified percentile of their feature’s mean or median
pixel value.
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1. Mode

Selects which mode to use for local thresholding

• Auto Threshold: Selects pixels if they are below the auto-threshold value for each region determined
using Otsu’s method [1]

• Percentage Of: Selects pixels if they are below a certain percentage of their region’s critical statistic
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• Difference Below: Selects pixels if they are below a certain difference from their region’s critical
statistic

• Lower Percentile: Selects pixels if they are with in the specified lower percentile of their region’s
grayscale pixel values

• Upper Percentile: Selects pixels if they are with in the specified upper percentile of their region’s
grayscale pixel values

2. Statistic

Selects which statistic to consider for the current mode

• Mean (for Percentage Of and Difference Below): Compares pixels to their region’s mean grayscale
intensity

• Median (for Percentage Of and Difference Below): Compares pixels to their region’s median
grayscale intensity

3. Value

• Adjustment (for Auto Threshold): Offsets each region’s auto-determined threshold value by this
amount

• Percentage (for Percentage Of): Specifies the critical percentage of the region’s mean or median
each pixel must be below

• Difference (for Difference Below): Specifies the critical difference from the region’s mean or median
each pixel must be below

• Percentile (for Lower Percentile): Specifies the lower percentile of the region’s grayscale values
that pixels must be within

• Percentile (for Upper Percentile): Specifies the upper percentile of the region’s grayscale values
that pixels must be within

References
[1] Otsu, N., “A Threshold Selection Method from Gray-Level Histograms,” IEEE Transactions on Systems,
Man, and Cybernetics, Vol. 9, No. 1, 1979, pp. 62-66.
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Watershed
Segmentation > Watershed

Segments the Current Image by first interpreting its grayscale values as topography (ie, basins within level
ground). A rainfall simulation is then run such that areas of similar intensity are separated from others,
where their basins fill to meet [1].

1. Markers

Helps confine feature outlines near your marked locations. Choose to use the selection in a Memory Image
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as markers to control watershed. Forces “basins” to be formed at the marker locations prior to the
watershed algorithm being run.

2. Resolution

• High: Works better for separating features with high pixel density
• Low: Works better for separating features with low pixel density (more pixelated)

3. Thickness

Thickness of watershed lines

4. Separation

Controls strength of feature detection. Increase slider to create more feature outlines.

Tips

• Powerful algorithm that can be used in combination with Pre-Processing and Find Texture filters to
identify feature boundaries

• When trying to separate already segmented features, use the Separate Features tool instead

References
[1] Meyer, Fernand, “Topographic distance and watershed lines,” Signal Processing , Vol. 38, July 1994, pp.
113-125.
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Find Edges
Segmentation > Find Edges

Sets edge pixels as empty using the specified edge finding algorithm [1-3].
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1. Type

The edge finding algorithm used

• Sobel: Detect edges using the Sobel algorithm

• Prewitt: Detect edges using the Prewitt algorithm

• Roberts: Detect edges using the Roberts algorithm

• Laplacian: Detect edges using the Laplacian algorithm

• Zero-Cross: Detect edges using the Zero-Cross algorithm

• Canny: Detect edges using the Canny algorithm (tends to cleaner edges than other algorithms) [3]

2. Threshold

A weakness setting for the edge find algorithm. Higher thresholds are weaker edge finds, but maybe
produce less noise. (Recommended: 0.01)

Tips

• It is often useful to optimize the Find Edges function to a Standard Deviation Filter companion image.
This allows for dynamic edge finding in presence of variation.

Referrences
[1] Canny, John, “A Computational Approach to Edge Detection,” IEEE Transactions on Pattern Analysis
and Machine Intelligence,Vol. PAMI-8, No. 6, 1986, pp. 679-698.

[2] Lim, Jae S., Two-Dimensional Signal and Image Processing, Englewood Cliffs, NJ, Prentice Hall, 1990,
pp. 478-488.

[3] Parker, James R., Algorithms for Image Processing and Computer Vision, New York, John Wiley & Sons,
Inc., 1997, pp. 23-29.
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Find Circles
Segmentation > Find Circles

Finds circles in the Current Image using an algorithm based on searching within the image’s Hough
transform. This function can take some time to complete depending on the size of and number of circles in
the image.
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1. Method

Sets method for circle finding. Phase Code tends to be faster and more accurate.

• Phase-Code: Uses the phase-code algorithm for circle detection [1]
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• Two-Stage: Uses the two-stage algorithm for circle detection [2,3]

2. Polarity

Sets whether circle edges are bright or dark outlines in the image

• Bright: Looks for circles with bright outlines

• Dark: Looks for circles with dark outlines

3. Min. Radius

Minimum radius of circles to be found (Recommended: 10-20)

4. Max. Radius

Maximum radius of circles of the found (Recommended: 20 larger than Min. Radius)

5. Sensitivity

Sets how much contrast needs to be between circles and the background. A higher sensitivity will find more
circles, but may increase false positives.

6. Edge Threshold

Another parameter which affects how many circles are found. A lower Edge Threshold finds more circles,
but may increase false positives.

Tips

• For best performance we recommend spacing the min and max diameter by 20.
• If a max-min spacing of 20 is too narrow for your application, try running Find Circles over multiple

iterations to cover the necessary range, and add the results together using Set Companion Image and
Union.

References
[1] T.J Atherton, D.J. Kerbyson. “Size invariant circle detection.” Image and Vision Computing. Volume 17,
Number 11, 1999, pp. 795-803.

[2] H.K Yuen, .J. Princen, J. Illingworth, and J. Kittler. “Comparative study of Hough transform methods for
circle finding.” Image and Vision Computing. Volume 8, Number 1, 1990, pp. 71–77.

[3] E.R. Davies, Machine Vision: Theory, Algorithms, Practicalities. Chapter 10. 3rd Edition. Morgan
Kauffman Publishers, 2005,
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Find Lines
Segmentation > Find Lines

Finds lines in the Current Image using an algorithm based on searching within the image’s Hough transform.

MIPAR MIPAR User Manual - v5.0_en

Page 259 of 696



1. Minimum Length

Rejects lines under a certain length.

2. Infinite Lines

Allows the detection of lines that proceed to infinity, in addition to line segments.

3. Detection Strength Settings

Threshold determines how strong a feature must be above background to be considered as a candidate
line.

Sensitivity determines how eager the algorithm is to find lines within the image.

Comments

Line detection is relative to the strongest features in the image. Detection will be much more successful if
items such as scale bars and information boxes are removed from the image first.
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Advanced
Contains advanced functions to recognize and select different types of features.

Functions

• Find Text
• Find Facial Features
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Find Text
Segmentation > Advanced > Find Text

Finds text in the Current Image using optical character recognition (OCR) [1] and places boxes around each
detected word.

See the “Text” item under “Based on Companion” in Feature Measurements for information
on how to extract recognized text strings*
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1. Character Set

Specifies the type of characters searched for

• All: Searches for all English characters

• Numbers: Searches for numbers only
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2. Detection

Controls the minimum acceptable confidence of detected text. Increase the slider to increase the sensitivity
of the text detection algorithm. (Recommended: 0.5)

References
[1] R. Smith. An Overview of the Tesseract OCR Engine, Proceedings of the Ninth International Conference
on Document Analysis and Recognition (ICDAR 2007) Vol 2 (2007), pp. 629-633.
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Find Facial Features
Segmentation > Advanced > Find Facial Features

Finds facial features in the Current Image such as frontal faces, profile faces, eyes, nose, mouth, and
others.
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1. Feature

Sets type of facial feature to detect

• Face Frontal: Detects front-facing faces using CART-based classifiers [1]

• Face Profile: Detects upright face profiles using Haar features passed through a decision stump

• Eye Pair (small): Detects pairs of eyes. Better suited for smaller eye pairs [2].

• Eye Pair (large): Detects pairs of eyes. Better suited for larger eye pairs [2].

• Left Eye: Detects left eye using Haar features passed through a decision stump [2]

• Right Eye: Detects right eye using Haar features passed through a decision stump [2]

• Nose: Detects nose using Haar features passed through a decision stump [2]

• Mouth: Detects mouth using Haar features passed through a decision stump [2]

• Upper Body: Detects the upper body (i.e., head and shoulders area) [3]

• Pedestrians 1 (small): Detects pedestrians at a distance using HOG features [4]

• Pedestrians 1 (large): Detects pedestrians close up [4]

• Pedestrians 2: Detects pedestrians using ACF features trained on the INRIA Person dataset [5]

• Pedestrians 3: Detects pedestrians using ACF features trained on the Caltech Pedestrian dataset [5]

2. Detection

Factor which controls the detection strength of facial feature finding. Increase the slider to increase the
sensitivity of feature-finding algorithm. (Recommended: 4-10)

References
[1] Lienhart R., Kuranov A., and V. Pisarevsky “Empirical Analysis of Detection Cascades of Boosted
Classifiers for Rapid Object Detection.”, Proceedings of the 25th DAGM Symposium on Pattern Recognition.
Magdeburg, Germany, 2003.

[2] Castrillón Marco, Déniz Oscar, Guerra Cayetano, and Hernández Mario, “ENCARA2: Real-time detection
of multiple faces at different resolutions in video streams”. In Journal of Visual Communication and Image
Representation, 2007 (18) 2: pp. 130-140.
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[3] Kruppa H., Castrillon-Santana M., and B. Schiele. “Fast and Robust Face Finding via Local Context”.
Proceedings of the Joint IEEE International Workshop on Visual Surveillance and Performance Evaluation
of Tracking and Surveillance, 2003, pp. 157–164.

[4] Dalal, N. and B. Triggs. “Histograms of Oriented Gradients for Human Detection,“Proceedings of IEEE
Conference on Computer Vision and Pattern Recognition, June 2005, pp. 886-893.

[5] Dollar, C. Wojeck, B. Shiele, and P. Perona. “Pedestrian detection: An evaluation of the state of the art.”
Pattern Analysis and Machine Intelligence, IEEE Transactions.Vol. 34, Issue 4, 2012, pp. 743–761.
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Auto Segmentation
Segmentation > Auto Segmentation

May use up to two B/W memory images

Uses Smart Find™, geodesic distance, or marker-based watershed segmentation to auto-identify features
based on two seed images. One seed image roughly identifies features and the other the background. Seed
images can be any of the available B/W memory images.
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1. Method

• Smart Find: Uses a graph cut algorithm [1] to auto-determine feature boundaries in the image based
on the feature and background markers. The most effective algorithm for this purpose. Effective even
when only “scribbles” have been manually drawn and stored as memory images, and especially
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effective when partial selections of some features and background have been made from other
Recipe steps.

• Geodesic Distance: Uses the geodesic distance method [2] to auto-determine feature boundaries in
the image based on the feature and background markers. Useful when only partial selections of
nearly all features have been captured and the user needs the software to “snap” the boundaries into
place.

• Marker-Based Watershed: First forces the image to have local minima at the feature and background
marker locations. Then applies the watershed algorithm [3] to auto-determine feature boundaries.
Tends to grow the existing feature boundaries about halfway to the background markers.

2. Features

Uses manual tracings, or takes selected (black) features from a memory image, to help identify features for
auto segmentation

3. Background

Uses manual tracings, or takes selected (black) features from a memory image, to help identify the
background for auto segmentation

References
[1] Y. Li, S. Jian, C. Tang, H. Shum, Lazy Snapping In Proceedings from the 31st International Conference
on Computer Graphics and Interactive Techniques, 2004.

[2] A. Protiere and G. Sapiro, Interactive Image Segmentation via Adaptive Weighted Distances, IEEE
Transactions on Image Processing, Volume 16, Issue 4, 2007.

[3] Meyer, Fernand, “Topographic distance and watershed lines,” Signal Processing , Vol. 38, July 1994, pp.
113-125.

Demo
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Tutorial

https://www.youtube.com/embed/Fx0G8hCYDes?rel=0
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https://www.youtube.com/embed/GSrwRvSFh4E?rel=0

https://www.youtube.com/embed/GSrwRvSFh4E?rel=0
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*Region Grow
Segmentation > *Region Grow

Requires B/W Companion Image

Grows each seed (features in Companion Image) until the specified percentage of new pixels do not fall
within the threshold pixel-value distance from the seed pixel value. Seeds are are obtained from the
features in the Companion Image.
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1. Use

• Entire Seeds: Use entire seeds for region growing. Entire seed will be superimposed on each region
after growing. Region growing will still start from seed centroids.

• Centroids: Use centroid of each seed for region growing.

2. Tolerance

Tolerance for region growing. Only pixels within the tolerance threshold of the seed pixel get added to the
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region.
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*Fast Marching Method
Segmentation > *Fast Marching Method

Requires B/W Companion Image

Applies the fast marching method [1] to grow the seeds specified by the centroids of the features in the
Companion Image. The algorithm is a more robust version of region growing, where regions grow according
to the local grayscale difference around them. The seeds mark the locations to first measure grayscale.
Then, all pixels are weighted according to the relative grayscale value difference to the nearest seed. This is
referred to as the weight map.
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1. Threshold

Cutoff value to determine when centroids of features (seeds) stop growing. Larger value allows greater
growth. (Recommended: 0.01-0.05)

References
[1] Sethian, J. A. Level Set Methods and Fast Marching Methods: Evolving Interfaces in Computational
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Geometry, Fluid Mechanics, Computer Vision, and Materials Science, Cambridge University Press, 2nd
Edition, 1999.
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*Active Contour
Segmentation > *Active Contour

Requires B/W Companion Image

Uses active contouring [1,2] to set the boundaries of each feature in the Companion Image based on the
Current Image. Active contouring grows or shrinks features to “snap” them to locally high-contrast
boundaries. The Contraction Bias allows users to add some external “force” to the contour to increase the
likelihood that it will shrink.
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1. Method

• Chan-Vese: Uses the Chan-Vese method to drive the contour [1]. Tends to work faster than the edge
method.
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• Edge: Uses the edge method to drive the contour [2]. Is naturally more biased to shrink the contour.
Tends to work more slowly than the Chan-Vese method.

2. Max. Iterations

The maximum number of iterations to evolve the active contour

3. Smooth Factor

Controls the resulting roughness of the active contour. Higher is smoother.

4. Contraction Bias

Controls the external force on the active contour. Higher makes it tougher for the active contour to grow.

References
[1] T. F. Chan, L. A. Vese, Active contours without edges. IEEE Transactions on Image Processing, Volume
10, Issue 2, pp. 266-277, 2001

[2] V. Caselles, R. Kimmel, G. Sapiro, Geodesic active contours. International Journal of Computer Vision,
Volume 22, Issue 1, pp. 61-79, 1997.
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Find Global Maximum
Segmentation > Find Global Maximum

Selects the global maximum pixel in the Current Image.
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Find Global Minimum
Segmentation > Find Global Minimum

Selects the global minimum pixel in the Current Image.
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Find Local Maxima
Segmentation > Find Local Maxima

Selects the local maxima pixels in the Current Image.

1. Connectivity

• 8-pixel: Uses 8-pixel connectivity to determine local maxima regions
• 4-pixel: Uses 4-pixel connectivity to determine local maxima regions
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2. Threshold

Ignores local maxima whose intensity is not at least the threshold value above their surroundings
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Find Local Minima
Segmentation > Find Local Minima

Selects the local minima pixels in the Current Image.

1. Connectivity

• 8-pixel: Uses 8-pixel connectivity to determine local minima regions
• 4-pixel: Uses 4-pixel connectivity to determine local minima regions
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2. Threshold

Ignores local minima whose intensity is not at least the threshold value below their surroundings
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Morphology
Contains functions for manipulating the shape and size of selected features. These include functions such
as dilation, erosion, separation, skeletonization, and shape replacement.

Functions

Dilate and Erode

• Dilate
- Uniform
- Smart
- Retain

• Erode
- Uniform
- Smart
- Retain

Edges

• Separate Features
• Clean Boundaries
• Smooth Features
• Extend Features
• Perimeter Pixels

Thin

• Skeletonization
• Thin
• Shrink
• Distance Map

MIPAR MIPAR User Manual - v5.0_en

Page 289 of 696



Dilate
Contains morphological operations which expand a selection mask according to certain parameters.

Functions

• Dilate Uniform
• Dilate Smart
• Dilate Retain

MIPAR MIPAR User Manual - v5.0_en

Page 290 of 696



Dilate Uniform
Morphology > Dilate > Uniform

Grows selection by a specified number of pixels in all directions

1. Depth

The number of pixels by which selected regions will be grown in all directions

2. Units

Units for dilation depth. Choose between pixels and physical units (available when scale factor is set).
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Dilate Smart
Morphology > Dilate > Smart

Selects pixels if they are surrounded by a number of selected pixels greater than or equal to the specified
threshold number.
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1. Threshold

The minimum number of selected pixels that must surround an unselected pixel for it to be added to the
selection (Recommended: 5)
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2. Iterations

The number of iterations to perform the dilation
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Dilate Retain
Morphology > Dilate > Retain

Prevents feature merging, while growing selected regions by a specified number of pixels in all directions

1. Depth

The number of pixels by which selected regions will be grown in all directions without merging
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Erode
Contains morphological operations which reduce a selection mask according to certain parameters.

Functions

• Erode Uniform
• Erode Smart
• Erode Retain
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Erode Uniform
Morphology > Erode > Uniform

Shrinks selection by a specified number of pixels in all directions

1. Depth

The number of pixels by which selected regions will be shrunk in all directions

2. Units

Units for erosion depth. Choose between pixels and physical units (available when scale factor is set).
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Erode Smart
Morphology > Erode > Smart

Removes selected pixels if they are surrounded by a number of empty pixels greater than or equal to the
specified threshold number.
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1. Threshold

The minimum number of empty pixels that must surround a selected pixel for it to be removed
(Recommended: 5)
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2. Iterations

The number of iterations to peform the erosion
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Erode Retain
Morphology > Erode > Retain

Prevents feature disconnection, while shrinking selection by a specified number of pixels in all directions

1. Depth

The number of pixels by which unselected regions will be grown in all directions without disconnecting
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features
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Separate Features
Morphology > Separate Features

Separates connected features using the watershed algorithm
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1. Maximum Line Length

Set a maximum allowable line length for new separation lines.

2. Edge Lines

Toggle allowing separation lines to touch the edge of the image.

3. Resolution

• High: Works better for separating features with high pixel density
• Low: Works better for separating features with low pixel density (more pixelated)

4. Thickness

Thickness of separation lines

5. Separation

Controls strength of separation. Increase the slider to create more separations. (Recommended: 2-5)

Tips

• Recommend starting separation value:3
• Match thickness to existing separation lines for best result
• In case of separation line artifact, isolate separation lines and reject lines based on size, orientation or

roughness
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Clean Boundaries
Morphology > Clean Boundaries

Grows features to fill the image until they are separated by boundaries of a specified thickness. This will
also
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1. Thickness

The resulting distance between features.

Notes

• Will not increase the border between features that are already closer than the specified thickness.
• Also completely fills any holes inside a feature.

Tips

• Use step sequence ‘Clean Boundaries > Manual Edit > Clean Boundaries’ to quickly remove or add
separation lines.
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Smooth Features
Morphology > Smooth Features

Smooths feature boundaries using a specified window size. The threshold parameter controls the degree of
feature erosion or dilation that also occurs.

MIPAR MIPAR User Manual - v5.0_en

Page 307 of 696



1. Window Size

Window size which passes over each pixel for smoothing. Larger windows result in more smoothing.

2. Threshold

Threshold value which controls erosion/dilation of features. Larger thresholds lead to less dilation/more
erosion.
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Extend Features
Morphology > Extend Features

Extends features along local orientations by a set length and thickness
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1. Length

Length to extend features by (in pixels)

2. Thickness

Thickness of extended portions (in pixels)

MIPAR MIPAR User Manual - v5.0_en

Page 310 of 696



Perimeter Pixels
Morphology > Perimeter Pixels

Sets pixels which are on the perimeter of features as empty, while all other pixels in an image are selected.

To select only the perimeter of your features, follow this step with an Invert.
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Skeletonization
Morphology > Skeletonization

Skeletonize
Thins features down to their 1-pixel thick centerlines and branches without allowing features to break apart.

Keep Branch Points
Keeps skeleton branch points while removing the branches themselves. Works best on skeletons.

Remove Branch Points
Removes skeleton branch points to allow for subsets of branches to be removed (e.g., with Reject
Features). Works best on skeletons.
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Thin
Morphology > Thin

Thins features to skeletons with fewer branches than traditional skeletonization.
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Pixel Lines
Morphology > Pixel Lines

Adds pixels to single-pixel lines so that each pixel in the line is connected on their faces. This ensures the
lines are seen as fully connected features under the default “4-pixel” labeling connectivity.
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Distance Map
Morphology > Distance Map

Generates a grayscale distance map of the current segmentation where each pixel is colored by its
euclidean distance to the nearest empty pixel. White = zero distance, black = 255 distance.

The original distance map with floating-point precision is stored alongside the displayed image, where zero
distance = 0.0. By saving the distance map into the companion image, this floating-point version is available
for measurements with Feature Measurement: Intensity Mean/Sum/StdDev
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Clean-Up
Contains functions for selectively removing features from the segmentation. Most commonly used is the
Reject Features tool, which can remove or keep features based on a variety of shape and size metrics.

Functions

Reject

• Reject Features
• Fill All Holes
• Relative Size Filter
• Remove Edge Features

Replace

• Replace With
• Mark Center
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Reject Features
Clean-up > Reject Features

Removes objects or fills holes based on their selected parameters being above or below a specified
threshold. Parameter options include area, eccentricity, convex area/area ratio, and many more.
Neighborhood conditionals are also optional, where features will only be removed if they meet both the
parameter and neighborhood criteria.
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1. Measurement

Determines the measurement that will be considered for each features potential rejection. Features will be
rejected based on whether they are above or below the measurement threshold you specify.

• Area: Area of each feature.
• Area Fraction: Area fraction occupied by each feature relative to entire image.
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• Aspect Ratio: Ratio of the major and minor axis lengths of each feature.
• Average Neighbor: Each feature’s average distance to its neighbors, as defined by the features’

Delaunay triangulation. Triangulation and distance are both calculated from the features’ centroids.
• Caliper Diameter: Largest line length that fits across each feature. Equivalently, the distance

between the two points in the feature farthest from each other, including those points.
• Convex Area: Area of each feature’s tightest-fitting convex hull.
• Eccentricity: Describes how elongated or circular each feature is. 0 is a perfect circle. 1 is a straight

line.
• Equivalent Diameter: Diameter of each feature if each was a circle of the same area.
• Feature Number: Numbers that are assigned to features when measurements are generated.
• Filled Area: Area of each feature with holes filled in.
• Filled Area/Area:
• First Moment of Inertia: First moment of each feature. Describes how much feature area is extended

away from its centroid.
• First Moment of Inertia/Area: Ratio between the first moment of each feature and its area.
• Intensity Mean: (requires Companion Image) Grayscale intensity average of the entire Current

Image.
• Intensity StdDev: (requires Companion Image) Grayscale intensity standard deviation of the entire

Current Image.
• Intensity Sum: (requires grayscale Companion Image) Grayscale intensity sum over the entire

Current Image.
• Length – X: Length of each feature’s bounding box in the X-direction.
• Length – Y: Length of each feature’s bounding box in the Y-direction.
• Major Axis Length: Major axis length of ellipse fit to each feature.
• Minor Axis Length: Minor axis length of ellipse fit to each feature.
• Moment Invariant (Omega-1): High-order moment which describes shape properties of each feature

[1,2].
• Moment Invariant (Omega-2): High-order moment which describes shape properties of each feature

[1,2].
• Moment Invariant (Phi-1): High-order moment which describes shape properties of each feature

[1,2].
• Moment Invariant (Phi-2): High-order moment which describes shape properties of each feature

[1,2].
• Nearest Neighbor: Each feature’s distance to the closest other feature, calculated from the features’

centroids.
• Number of Features: (requires Companion Image) Number of features in the companion image

contained within the feature.
• Number of Holes: Number of holes contained within the feature.
• Orientation: Angle of the ellipse fit to each feature with respect to the positive X-axis. Positive angles

are clockwise rotations and negative counterclockwise.
• Perimeter: Length of perimeter of each feature.
• Perimeter/Area: Perimeter of each feature relative to its area.
• Roughness: Ratio between the area of tightest-fitting convex hull and the area of each feature.
• Roundness: Ratio of equivalent diameter to caliper diameter (see above).
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2. Features, Edge Features, Units

• Features: You can choose which features you want to be rejected between white and black.
• Edge Features: You can choose to include or ignore edge features when choosing features to reject.

You can also choose to only reject edge features.
• Units: The units you would like use to reject features.

3. Threshold Value

Select the threshold value (of the set measurement) for rejecting features and specify whether you would
like to reject or keep features below the threshold value.

4. Proximity Awareness

Lets you consider the features above or below the threshold as candidates for removal, but only actually
removed them if their neighbors pass the specified threshold.

• Less Than / =, Greater Than / =: Choose whether neighboring features must be less than or equal
to, or greater than or equal to, in order to pass the threshold.

• None: Do not use neighborhood conditionals
• Within Distance: Consider features whose centroids are within certain distance. Enter distance in

which to search (in pixels);
- Number: Consider number of features. Enter critical number of features.
- Total Area: Consider total area of features. Enter critical total area (in pixels).
- Average Area: Consider average area of features. Enter critical average area (pixels).

• Local Window: Consider local window about each feature, including partial neighboring features.
- Number: Consider number of features. Enter critical number of features.
- Total Area: Consider total area of features. Enter critical total area (in pixels).
- Average Area: Consider average area of features. Enter critical average area (pixels).

References
[1] Rosin, Paul L. 2003. “Measuring Shape: Ellipticity, Rectangularity, and Triangularity.” Machine Vision
and Applications 14 (3): 172–184.

[2] MacSleyne, J P, J P Simmons, and M De Graef. 2008. “On the Use of Moment Invariants for the
Automated Analysis of 3D Particle Shapes.” Modelling and Simulation in Materials Science and Engineering
16 (4) (June 1): 045008.
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Fill All Holes
Clean-Up > Fill All Holes

Removes all holes contained within features. If this unintentionally removes large areas of trapped empty
space, try using Reject Features to only remove holes below a certain area.
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Relative Size Filter
Clean-Up > Relative Size Filter

Removes features if their areas are in the upper or lower specified percentage of all feature areas.

1. Metric

• Number: Select largest/smallest number of features
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• Percentage: Select largest/smallest percentage of features

2. Largest

Threshold number or percentage to select the largest features

3. Smallest

Threshold number or percentage to select the smallest features

Tips

• Avoid using strictly number threshold unless confident in the number of features that should be
removed or kept.
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Remove Edge Features
Clean-Up > Remove Edge Features

Removes features if they contact the edge of the image.

Tips

• Useful for removing partial features in the image; recommended for generating representative size
measurements.
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Replace With
Clean-Up > Replace With

Replace each feature in the Current Image with the selected representative feature.

Box
Replaces each feature with its bounding box.

Caliper Diameter
Replaces each feature with its caliper diameter.

Centroid
Replaces each feature with its centroid.

Convex Hull
Replaces each feature with its convex hull.

Ellipse
Replaces each feature with its equivalent ellipse.

Equivalent Circle
Replaces each feature with its equivalent circle.

Fit Circle
Replaces each feature with its best fitting circle.

Largest Circle
Replaces each feature with its largest circle. The largest circle is defined as the circle whose diameter is the
feature’s caliper diameter, and whose center is the midpoint of the line segment drawn along the caliper
diameter.
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Local Normal
Replaces each feature with its local normal based on surrounding features.

Major Axis
Replaces each feature with the major axis of its equivalent ellipse.

Minimum Diameter
Replaces each feature with its minimum diameter.

Minor Axis
Replaces each feature with the minor axis of its equivalent ellipse.

Nearest Distance
Replaces each feature with a line between it and its nearest neighbor.

Triangulation
Replaces all features with a Delaunay triangulation calculated from the features’ centroids.
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Mark Center
Clean-Up > Mark Center

Mark the center of a blank image with a selected pixel
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Memory
Contains functions for storing and recalling images from various image memory slots.

Functions

Companion Image

• Set Companion Image
• Load Companion Image
• Call Companion Image

Memory

• Set Memory Image #1-6
• Call Memory Image #1-6
• Call Original Image

Tutorial

https://www.youtube.com/embed/ex7UHo7tvro?rel=0

https://www.youtube.com/embed/ex7UHo7tvro?rel=0
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Set Companion Image
Memory > Set Companion Image

Stores the Current Image in memory as the Companion Image. This is the most important memory slot as it
is used for various arithmetic, masking, and measurement operations between it and the Current Image.

The companion image will maintain the original bit depth when the following steps are immediately before
the Set Companion step:

• Call Original Image
• Load Companion Image
• Channel Operation
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Call Companion Image
Memory > Call Companion Image

Call the Companion Image to be the Current Image.
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Load Companion Image
Memory > Load Companion Image

Loads in an image from a file as the Companion Image and as the Current Image.

If the chosen image’s directory will hold a set of images to be paired with starting images in a batch process,
then select check the “Dynamic Image Loading” checkbox in the Batch Settings panel. Otherwise, the single
chosen image will be used in each batched application of the recipe.

The Companion Image is the most important memory slot as it is used for various arithmetic, masking, and
measurement operations between it and the Current Image.
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1. Image Settings

Filename

File to load as Companion Image, select Browse to select file.

Resize to match Current Image

Forces Companion Image to resize to match that of the Current Image, in the event they are different.

2. Preview Window

Window reflects the applied Color Settings.

3. Color Settings

See Channel Operation

4. Batch Settings

Dynamic Image Loading

This setting allows the user to set a folder of images to be used as companion during a batch process. This
setting will successively load the images from the companion image folder location based on which image
number is being processed in the Batch Processor. For example:

• Load Companion is set to load an image in a folder of other companion images.
• 10 images are added to the Batch Processor for processing.
• As the first image is being processed, the first image in the folder specified in Load Companion is

loaded.
• As the second image is being processed, the second image in the folder specified in Load Companion

is loaded.
etc

Multiple Load Companion steps can be used in the recipe, each with their respective folder of images.

Use Relative Path

Dynamic Image Loading must be turned on to use Relative Paths. Instead of using a static folder location to
load companions, relative paths will calculate a relative path between the currently processed image and the
image loaded as companion to be used for future batch processes. For example:

• Image in folder home/project is loaded into the image processor
• Load Companion has image selected in folder home/project/companions
• Relative path is calculated to be /companions
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When a Batch Process is ran, Load Companion will look for the companion image in the /companion folder
relative to the location of the image that is actively being processed. Image indexing still applies, so the first
image being processed, will select the first image in the companion folder.

Relative paths can be based on a common parent folder as well. For example:

• Image in folder home/project is loaded into the image processor.
• Load Companion has image selected in folder home/companions.
• Relative path is calculated to be ../companions meaning up one folder and forward into companions.

Multiple levels of separation is supported.

Sort File Names

Sort files in folder before loading during batch processing.

File Type Filter

Only consider a specified file type for companion image loading. For example:

• Companion file type filter is specified as: .jpg
• Companion folder has files 1.jpg, 2.jpg, 1.tiff, 2.tiff
• Only images 1.jpg and 2.jpg will be considered as companions during batch processing.
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Set Memory Image #1-6
Memory > Set Memory Image #1-6

Stores the Current Image in memory as Memory Image #1-6. You can store up to six different images.
These images can be recalled later as well as used in some masking operations.

MIPAR MIPAR User Manual - v5.0_en

Page 335 of 696



Call Memory Image #1-6
Memory > Call Memory Image #1-6

Calls Memory Image to be the Current Image. You can call up to six different images to be the Current
Image.
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Call Original Image
Memory > Call Original Image

Calls the Original Image to be the Current Image.
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Math
Contains functions for performing mathematical operations between two images. These operations can
range from blending two grayscale images together, to only keeping features in one image that contact
features in another.

Functions

Operations on selection masks (a.k.a. black-and-white images)

• *Feature Union
• *Feature Minus
• *Feature Intersection
• *Keep Mutual Features
• *Keep Exclusive Features
• Make Grayscale

Operations on grayscale images

• *Add
• *Average
• *Divide
• *Multiply
• *Subtract
• Add Value…

Operations on both black-and-white and grayscale images

• *Merge Darker Pixels
• *Merge Lighter Pixels

MIPAR MIPAR User Manual - v5.0_en

Page 338 of 696



*Union
Math > *Union

Requires Companion Image

Combines the features between the Current and Companion Images. All features from both images will
appear in the result.
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*Minus
Math > *Minus

Requires Companion Image

Subtracts the Companion Image features from the Current Image features.
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*Intersection
Math > *Intersection

Requires Companion Image

Keeps the areas of features which overlay between the Current and Companion Images. Only overlapping
feature areas from both images will appear in the result.

MIPAR MIPAR User Manual - v5.0_en

Page 341 of 696



*Keep Mutual
Math > *Keep Mutual

Requires Companion Image

Keep features from the Current Image that contact or overlap a feature in the Companion Image.
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*Keep Exclusive
Math > *Keep Exclusive

Requires Companion Image

Keep features from the Current Image that do not contact or overlap a feature in the Companion Image.
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Make Grayscale
Math > Make Grayscale

Convert a binary Current Image into a grayscale image. Selected pixels become 0, while deselected pixels
become 255.
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*Add
Math > *Add

Requires Companion Image

Adds the Current Image to the Companion Image.
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*Average
Math > *Average

Requires Companion Image

Averages the Current Image with the Companion Image.
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*Divide
Math > *Divide

Requires Companion Image

Divides the Companion Image into the Current Image.
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*Multiply
Math > *Multiply

Requires Companion Image

Multiplies the Companion Image into the Current Image.
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*Subtract
Math > *Subtract

Requires Companion Image

Subtracts the Companion Image from the Current Image.
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Add Value
Math > Add Value

Add a constant integer value to each pixel in a grayscale Current Image. May be positive or negative.
Resultant pixel values below 0 or above 255 are clipped to 0 or 255.
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*Merge Darker Pixels
Math > *Merge Darker Pixels

Requires Companion Image

Merges the darker pixels between the Current and Companion Images. Each pixel in the resulting will be the
darkest value of that pixel in the Current and Companion images.

When merging a grayscale image with a binary selection, selected = black (0) and unselected = white (255).

MIPAR MIPAR User Manual - v5.0_en

Page 351 of 696



*Merge Lighter Pixels
Math > *Merge Lighter Pixels

Requires Companion Image

Merges the lighter pixels between the Current and Companion Images. Each pixel in the resulting will be the
lightest value of that pixel in the Current and Companion images.

When merging a grayscale image with a binary selection, selected = black (0) and unselected = white (255).
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View
Contains functions for viewing the Current Image’s histogram, finding a specific feature by its ID number,
and managing various properties of Recipe Layers.

Functions

• Image Histogram
• Specific Feature
• Manage Layers
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Image Histogram
View > Image Histogram

Histogram of the current image. For binary selections, selected = 0 and unselected = 1.
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Specific Feature
View > Specific Feature

Specific Feature allows you to view where the feature is in the image by highlighting.

The list of feature numbers can be found by generating feature measurements. Then, you will be able to tell
what the maximum number of features you have.
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The image can be saved or printed. The feature number you entered will be highlighted in the image.
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Manage Layers
View > Manage Layers

While Layers are most conveniently set, edited, and removed from the controls directly in the Image
Processor, this window allows more control over Layer positioning. It also provides a comprehensive
management center for your Layers.

Layers are essentially “favorited” recipe steps, which can be overlaid and viewed simultaneously. Any
measurements in the recipe will be performed on layers when run in a batch and the result of any “layered”
step will be saved and, if applicable, added as a layer to a 3D reconstruction. If there are no layers in a
recipe, then any batch measurements, image saves, and reconstruction layers will just come from the last
step in the recipe.

1. Selection

Click on a Recipe step to view its result in the viewer below this panel. B/W Recipe steps can be set as
Layers using the “Add Layer” button.

2. Add Layer

Added selected Recipe step as a Layer

MIPAR MIPAR User Manual - v5.0_en

Page 357 of 696



3. Remove Layer

Remove selected Layer

4. Layers

Currently set Layers. Layer names, colors, and overlay position can be set from the surrounding controls.

5. Show/Hide Layer

Show/hide selected Layer in the viewer on the right
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Measurements
Layout

1. Active measurement

2. Show/Hide Measurements Panel

3. Run active measurement on active Recipe step or shown Layers

4. Edit active measurement settings

5. Edit which Layers the active measurement is executed on

6. Generate measurements report for all Layers and measurements

7. Delete measurement

Functions

Per Image

• Area
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• Area Fraction
• Count
• Count Fraction
• Estimate Count
• Intercepts
• Image Dimensions
• Number Density
• Perimeter
• Perimeter Fraction
• Path Length
• *Intensity Mean
• *Intensity StdDev
• *Intensity Sum
• *Correlation Coefficient
• *Mutual Information

Per Feature

• Feature Measurements
• Color by Measurements

Per Pixel

• Local Measurements
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Area
Measurements > Area

Measures the total area of selected pixels in the Current Image.

MIPAR MIPAR User Manual - v5.0_en

Page 361 of 696



Area Fraction
Measurements > Area Fraction

Measures the area fraction of selected pixels in the Current Image. Counts all selected pixels and divides
the number by either the total number of pixels in the image, or the total number of selected pixels in a
chosen Memory Image.

1. Measure Relative To

Choose to measure relative to either the entire image, or the selection in a Memory Image

MIPAR MIPAR User Manual - v5.0_en

Page 362 of 696



Count
Measurements > Count

Measures the total number of separate features in the Current Image.
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Count Fraction
Measurements > Count Fraction

Measures the count of features in the Current Image as a percentage relative to the count of features in a
chosen Memory Image.

1. Measure Relative To

Choose which Memory Image to use to measure the count fraction. The feature count in the Current Image
is divided by the feature count in the chosen Memory Image and expressed as a percentage.
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Estimate Count
Measurements > Estimate Count

Estimates number of features as the total area of selected pixels in a layer divided by the average area of
features in a chosen Memory Image. Essentially, it determines how many average features from the
Relative To selection would fit within the layer selection. Works best for features which are difficult to
separate, and which are all similar in size. Several representative features of interest should be selected in
the chosen Memory Image to provide the most accurate estimated count

1. Measure Relative To

Choose which Memory Image to use to estimate the number of features. The total selected area in the
image of interest is divided by the average feature area in the chosen Memory Image.
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Intercepts
Measurements > Intercepts

Random Lines
Measures metrics such as mean intercept by drawing a specified number of random or rotating lines through
the features in the Current Image.

1. Number of Lines

Number of lines to draw

2. Noise Removal

Method for removing small intercepts
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• Reject < / =: Simply ignores intercepts below a certain length
• Fit to Noise: (Only for “Random Lines”) Fits an exponential to the first few bins and subtracts this

exponential out of the intercept histogram.

3. Noise Thresholds

Thresholds for either the minimum intercept length (for “Reject </=”), the number of bins to use for “Fit to
Noise”

4. Partial Intercepts

Choose whether to discard or keep intercepts that start or end at an image edge

5. Save All Intercepts

Choose whether to save all intercept lengths into text files

6. Lines Along Vector

Choose whether to draw all “Random Lines” along a specific direction. Starting points of each line will still
be random.

7. Measurements

Choose which measurements to report (described below).

Rotating Lines
Measures metrics such as mean intercept by rotating a grid of specified number of lines through the
features in the Current Image.
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1. Number of Lines

Number of lines to draw

2. Noise Removal

Method for removing small intercepts

• Reject < / =: Simply ignores intercepts below a certain length
• Fit to Noise: (Only for “Random Lines”) Fits an exponential to the first few bins and subtracts this

exponential out the intercept histogram.

3. Noise Thresholds

Thresholds for either the minimum intercept length (for “Reject </=”), the number of bins to use for “Fit to
Noise”
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4. Partial Intercepts

Choose whether to discard or keep intercepts that start or end at an image edge

5. Save All Intercepts

Choose whether to save all intercept lengths into text files

6. Lines Along Vector

Disabled in “Rotating Lines” mode

7. Rotation Range

Range of angles through which to rotate the grid of parallel lines

8. Rotation Step Size

Increment with which to step though angle range to rotate the grid of parallel lines

9. Measurements

Choose which measurements to report (described below).

Measurements
• Mean Intercept – Objects: Average length of intercepts which pass through selected features

(objects)
• Mean Intercept – Holes: Average length of intercepts which pass through un-selected areas (holes)
• Mean Inverse Intercept – Objects: Average inverse length of intercepts which pass through selected

features (objects)
• Mean Inverse Intercept – Holes: Average inverse length of intercepts which pass through un-

selected areas (holes)
• Mode Intercept – Objects: Mode (most common) length of intercepts which pass through selected

features (objects)
• Mode Intercept – Holes: Mode (most common) length of intercepts which pass through un-selected

areas (holes)
• Mode Inverse Intercept – Objects: Mode (most common) inverse length of intercepts which pass

through selected features (objects)
• Mode Inverse Intercept – Holes: Mode (most common) inverse length of intercepts which pass

through un-selected areas (holes)
• ASTM Grain Size Number: ASTM standard grain size number derived from mean intercept length

through selected features (objects)
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• Total Line Length: Total length of all lines which are drawn in order to collect intercepts.
• Total Intersections: Number of intersections produced between the drawn lines and intercepted

features.

References
[1] ASTM E112-13, Standard Test Methods for Determining Average Grain Size, ASTM International, West
Conshohocken, PA, 2013, www.astm.org

ASTM number is only produced from random line measurements, is only valid for grain size
measurements, and is only produced when a calibration factor is present. It is calculated
using the equation: ASTM = 10-2*log2([Mean Int Black in Microns]/10) [1]
*
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Image Dimensions
Measurements > Image Dimensions

Measures the X and Y dimensions of the Current Image.

May be performed on grayscale Current Images.
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Number Density
Measurements > Number Density

Measures the total number of separate features per area in the Current Image, or per selection area in a
chosen Memory Image.

1. Measure Relative To

Choose to measure relative to either the entire image, or the selection in a Memory Image

MIPAR MIPAR User Manual - v5.0_en

Page 372 of 696



Perimeter
Measurements > Perimeter

Measures the total perimeter length around all features in the current image.
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Perimeter Fraction
Measurements > Perimeter Fraction

Measures the total perimeter fraction of features in the current image. This is calculated as the total
perimeter length divided by the either the total number of pixels in the image, or the total number of selected
pixels in a chosen Memory Image.

1. Measure Relative To

Choose to measure relative to either the entire image, or the selection in a Memory Image
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Path Length
Measurements > Path Length

Measures the total path length of features in the current image. This path is first calculated by applying the
Thin function, and then the path length is calculated with a formula similar to that used in Vossepoel and
Smeulders, 1982 with end-points extended to the edge of each end pixel.

1. Measure Relative To

Choose either to extract the path either from the current image, or to use a path supplied by a memory
image. Note that the Thin operation is still applied to these supplied paths. The supplied path for each
feature in the current image is considered to be the paths of features in the memory image where those
features overlap the feature in the current image.
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*Intensity Mean
Measurements > *Intensity Mean

Requires Companion Image

Measures the average grayscale intensity within selection based on latest Companion Image

MIPAR will generate the intensity measurement using the original image bit depth, see Companion Image
for a list of recipe steps that maintain bit depth.
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*Intensity StdDev
Measurements > *Intensity StdDev

Requires Companion Image

Measures the standard deviation of grayscale intensity within selection based on latest Companion Image

MIPAR will generate the intensity measurement using the original image bit depth, see Companion Image
for a list of recipe steps that maintain bit depth.
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*Intensity Sum
Measurements > *Intensity Sum

Requires Companion Image

Measures the total of grayscale intensity within selection based on latest Companion Image

MIPAR will generate the intensity measurement using the original image bit depth, see Companion Image
for a list of recipe steps that maintain bit depth.
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*Correlation Coefficient
Measurements > *Correlation Coefficient

Requires Companion Image

Measures the normalized and absolute correlation coefficient [1-3] between the Current and Companion
images. The normalized value is a measure of image similarity that well-suited for images of similar intensity
types.

May be performed on grayscale Current Images.

References
[1] Fisher, R.A. Statistical Methods for Research Workers, 13th Ed., Hafner, 1958.

[2] Kendall, M.G. The Advanced Theory of Statistics, 4th Ed., Macmillan, 1979.

[3] Press, W.H., Teukolsky, S.A., Vetterling, W.T., and Flannery, B.P. Numerical Recipes in C, 2nd Ed.,
Cambridge University Press, 1992.
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*Mutual Information
Measurements > *Mutual Information

Requires Companion Image

Measures the normalized and classical (absolute) amount of mutual information [1,2] between the Current
and Companion images. The normalized value is a measure of image similarity that is well-suited for images
of both similar and different intensity types.

May be performed on grayscale Current Images.

References
[1] Rahunathan, Smriti, D. Stredney, P. Schmalbrock, and B.D. Clymer. Image Registration Using Rigid
Registration and Maximization of Mutual Information. Poster presented at: MMVR13. The 13th Annual
Medicine Meets Virtual Reality Conference; 2005 January 26–29; Long Beach, CA.

[2] D. Mattes, D.R. Haynor, H. Vesselle, T. Lewellen, and W. Eubank. “Non-rigid multimodality image
registration.” (Proceedings paper).Medical Imaging 2001: Image Processing. SPIE Publications, 3 July
2001. pp. 1609–1620.
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Feature Measurements
Measurements > Feature Measurements

Feature Measurements allows a variety of measurements to be made from each feature in the image or
Layer.

MIPAR MIPAR User Manual - v5.0_en

Page 381 of 696



1. Size

• Area: Area of each feature.
• Area Fraction: Area fraction occupied by each feature relative to entire image.
• Caliper Diameter: Largest line length that fits within each feature.
• Minimum Diameter: Smallest line length that fits between two parallel lines tangential to each
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feature.
• Equivalent Diameter: Diameter of each feature if each was a circle of the same area.
• Filled Area: Area of each feature with holes filled in.
• Length – X: Length of each feature’s bounding box in the X-direction.
• Length – Y: Length of each feature’s bounding box in the Y-direction.
• Major Axis Length: Major axis length of ellipse fit to each feature [1].
• Minor Axis Length: Minor axis length of ellipse fit to each feature [1].
• Intercepts: Measures statistics from intercept length recorded from each feature.

- Through Centroid: Draw each line through each feature’s centroid.
- Along Vector: Draw each line along the same direction through each feature.

2. Shape

• Roughness: Ratio of area of tightest-fitting convex hull and area of each feature.
• Eccentricity: Describes how elongated or circular each feature is. 0 is a perfect circle. 1 is a straight

line. Eccentricity is calculated from the ellipse fit to each feature as sqrt(-1([minor axis length]/[major
axis length])^2) [1])

• Aspect Ratio: Ratio of major and minor axis lengths, as defined by the ellipse fit to each feature [1].
• Roundness: Ratio of equivalent and caliper diameters.
• Perimeter: Length of perimeter of each feature.
• Perimeter/Area: Perimeter of each feature relative to its area.
• First Moment of Area: Describes how much area is extended away from each feature’s centroid.

Calculated as the summation of (area x distance from centroid) over all pixels in the feature.
• Moment Invariants: High-order moments which describe different shape properties of each feature

[2,3].

3. Location

• Centroid: Centroid location of each feature.
• Orientation: Angle of the ellipse fit to each feature with respect to the positive X-axis. Positive angles
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are clockwise rotations and negative counterclockwise.
• Tilt: Angle of the caliper diameter of each feature with respect to the positive X-axis. Positive angles

are clockwise rotations and negative counterclockwise.
• Nearest Neighbor: Each feature’s distance to the closest other feature, calculated from the features’

centroids.
• Average Neighbor: Each feature’s average distance to its neighbors, as defined by the features’

Delaunay triangulation. Triangulation and distance are both calculated from the features’ centroids.
• Edge Feature: Boolean status whether or not the feature is touching the edge of the image.

4. Based on Companion

Requires Companion Image Each layer’s Companion Image is determined independently from the recipe,
as the latest Companion Image set before the layer step. MIPAR will generate the intensity measurement
using the original image bit depth, see Companion Image for a list of recipe steps that maintain bit depth.

• Companion ID: ID number of the feature in the Companion Image that contains the centroid of each
feature being measured.

• Companion Features: Number of features in the Companion Image which are within or in contact
with each feature in the Current Image.

• Companion Area: Average, total, and fractional area of features in the Companion Image within each
feature in the Current Image.

• Companion Perimeter: Average and total perimeter length of features in the Companion Image
within each feature in the Current Image.

• Companion Path Length: Average and total path length of features in the Companion Image within
each feature in the Current Image, calculated similarly to Image Path Length.

• Text: Recognizes text within each feature. Set the binary mask or grayscale image as the companion.
The Current Image should the the bounding box of the text, with the major axis running parallel to the
text orientation.
- Edit: Allows the text search to be limited to just numbers
- Sample Image Sample Recipe

• Intensity Mean: Average grayscale intensity in the latest Companion Image within each feature in the

MIPAR MIPAR User Manual - v5.0_en

Page 384 of 696

https://cdn.manula.com/user/7310/docs/s-l300.jpg
https://cdn.manula.com/user/7310/docs/recipe-find-text_v1.rcp


Current Image. Select the bit-depth from the dropdown.
• Intensity StdDev: Standard deviation of grayscale intensity in the latest Companion Image within

each feature in the Current Image. Select the bit-depth from the dropdown.
• Intensity Sum: Sum grayscale intensity in the latest Companion Image within each feature in the

Current Image. Select the bit-depth from the dropdown.

5. Output

• Save to File: Saves the selected feature measurements to a tab-delimited .txt file.
• View Measurements: View the selected measurements as a list, histogram, and image overlay (in

Color by Measurements only). For measurements made on one layer, they will be viewed in our Color
by Measurements tool, while measurements made on several or all layers will be viewed in our
Histogram of Measurements tool.

• Add to Recipe: Adds the selected summary statistics to the recipe. Options are Mean, Min, Max,
Median, Standard Deviation, and Sum.

References
[1] Ellipse is fit to the feature as the ellipse with the same second moments as the feature. Second moments
are calculated as:
uxx = sum(x^2)/N + 1/12
uyy = sum(y^2)/N + 1/12
uxy = sum(x*y)/N

where x is the x coordinate of each pixel in the feature, y is the y coordinate of each pixel, and N is the
number of pixels.

The major and minor axes are calculated as:

common = sqrt((uxx – uyy)^2 + 4*uxy^2)
MajorAxisLength = 2*sqrt(2)*sqrt(uxx + uyy + common)
MinorAxisLength = 2*sqrt(2)*sqrt(uxx + uyy – common)

[2] Rosin, Paul L. 2003. “Measuring Shape: Ellipticity, Rectangularity, and Triangularity.” Machine Vision
and Applications 14 (3): 172–184.

[3] MacSleyne, J. P., Simmons, J. P., & De Graef, M. (2008). On the use of 2-D moment invariants for the
automated classification of particle shapes. Acta Materialia, 56(3), 427–437.
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Color by Measurements
Measurements > Color By Measurements

Colors the separate features in the Current Image according to a set of feature measurements.

1. Load

• If you have already generated measurements beforehand and then decide to produce a color-coded
image, you can load the measurements file here.

2. Generate

• If you have not yet generated measurements, you can generate measurements here to produce a
color-coded image. Then, the following window will appear where you can select your desired feature
measurements for your color-coded image. Refer to Feature Measurements page for further
description on each feature measurement.
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3. Generate

Perform the selected measurements and return to the Color by Measure window.
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4. Load, Generate, Export

• Load: You can start over and create a new color-coded image by loading a new feature
measurements file.

• Generate: You can create a new color-coded image by selecting new feature measurements.
• Export: You can export the existing feature measurements results to a spreadsheet, or to local

measurements using a sliding window.
• Show Highlighted Feature: Outlines the feature corresponding to the highlighted cell.
• Show Feature IDs: Places the Feature Number next to each feature. Select the Edit button to limit

the percentile displayed, change the text font size and color.
• Show on Histogram: Places a marker on the histogram for the highlighted cell.

Click on any cell in the column you desire to create the corresponding color-coded image.

5. ID

Click a feature to identify its corresponding measurement in table

6. Save Image

Save Image allows you to save the current “color by measurements” image.
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7. Measurement Stats

Displays the mean, standard deviation, min, and max of the selected measurements.

8. Histogram Display Settings

• Bins determines the number of bins to divide the histogram into. The default value is auto-calculated
to provide an effective histogram shape. Typing in a new value sets a manual number of bins. Erase
the typed in value anytime to revert back to the auto-calculated value. Click the ellipsis box next to
“Bins” to manually set the limits of each bin.

• Click the pencil icon to show the X- and Y-axis limits, which can be edited by entering in the desired
values.

• Coloring controls the color of histogram bars, either to be linked to the chosen colormap or to all be of
a single chosen color.

• Add a Curve Fit by selecting any of the 3 fit types: Normal, Lognormal and Bimodal. Fit parameters
are displayed by selecting the Fit Parameters button. These are automatically added to the Report
Generator.

9. Export Data, Save Plot

• Export Data: Export histogram data to spreadsheet.
• Save Plot: Save plot as image.

Right-click on these stats and select “Copy” to copy them to the clipboard*
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10. Save Settings

If Color by Measurements is reached through the play button, then adjustments to display settings, such as
selected column, image limits and coloring and histogram bins, limits, and coloring, will be saved into the
recipe. The next time Color by Measurements is run on this measurement, these settings will be
automatically used.

Tutorial

https://www.youtube.com/embed/kvhZrzKOubE?rel=0

https://www.youtube.com/embed/kvhZrzKOubE?rel=0

https://www.youtube.com/embed/kvhZrzKOubE?rel=0
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Local Measurements
Measurements > Local Measurements

Generates and visualizes measurements from individual pixels in the image.

1. Measurement

Select the following types of measurements you would like to see visualized in the image.

• Anisotropy: Measures the amount of local directionality of features at each pixel in the image, with 0
being completely random in direction and 1 being highly directional

• Area Fraction: Measures the local area fraction of selected features at each pixel in the image
◦ Step Size: Determines the steps to take between measured pixels. Measurements for pixels in

between are interpolated
• Count: Measures the number of features around each pixel
• Curvature: Generates the local curvature of the feature perimeter by fitting a circle at each pixel. [1]

◦ Smoothing: The smoothing determines the “search radius” (in pixels) about each pixel on the
perimeter which is used to find pixels to fit a circle to. Larger smoothing values will results in
more gradual transitions between curvatures along the perimeter, but may prevent very high
curvatures from being measured properly.

◦ Method: Local curvature measurements are made at each pixel along the features’ skeleton.
The algorithm which calculates this skeleton can be selected here.

▪ Perimeter: Local curvature measurement is made along the perimeter of the features
▪ Skeleton: Local curvature measurement is made along the skeleton of the features
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• Number Density: Measures the number of features per unit area around each pixel
• Thickness: Measures the local thickness along features by measuring the diameter of the largest

circle that can fit inside a feature with the center of the circle at each point along the feature’s
skeleton

◦ Trim Thresh: The trim threshold determines the minimum length (in pixels) that all skeleton
branches must be. Any branches below this length will be removed. This can be useful for
removing small branches in the corners of features which do not represent pixels that one
wishes to measure for thickness. Setting this threshold will cause the skeleton to be adjusted;
however, the measurements themselves will not be re-calculated until the user clicks
“Generate”.

◦ Method: Local thickness measurements are made at each pixel along the features’ skeleton.
The algorithm which calculates this skeleton can be selected here.

▪ Advanced: Uses morphological thinning to produce skeletons typically with fewer
branches. Often leads to more accurate thickness measurements.

▪ Smooth: Uses morphological thinning to produce skeletons typically with very few
branches. Generates continuous skeletons best used for curved features.

▪ Classic: Uses traditional skeletonization to produce skeletons typically with more
branches. However, in the case of very simple shapes, this method can produce slightly
longer skeletons such that more desired pixels are measured than with the advanced
method.

▪ Fit to Major: Draws lines along the major axes of all features. This is the recommend
method for measuring local thickness, parallel to the thinnest dimension, along a single,
or a just few, feature(s) (e.g., a layer of some sort) in the image. This method avoids
branches that can occur near image edges when using the “Advanced” and “Classic”
methods.

▪ Fit to Minor: Draws lines along the minor axes of all features. This is the recommend
method for measuring local thickness, parallel to the thickest dimension, along a single,
or a just few, feature(s) (e.g., a layer of some sort) in the image. This method avoids
branches that can occur near image edges when using the “Advanced” and “Classic”
methods.

• Orientation: Measures the local orientation of features at each pixel in the image from – 90 degrees
to + 90 degrees

• * Intensity Mean: Requires that a grayscale Companion Image be set earlier in the Recipe. Measures
the local average grayscale intensity at each pixel within the features. The measured grayscale
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intensities come from the latest set Companion Image.
• * Intensity StdDev: Requires that a grayscale Companion Image be set earlier in the Recipe.

Measures the local standard deviation in grayscale intensity at each pixel within the features. The
measured grayscale intensities come from the latest set Companion Image.

• * Nearest Distance: Requires that a B/W Companion Image be set earlier in the Recipe. Measures
the the distance between each feature’s pixel and the nearest feature pixel from the latest set
Companion Image.

Shared Parameters

• Window Size: For Anisotropy, Area Fraction, Count, Number Density, Orientation, Intensity
Mean, and Intensity StdDev the window size can be adjusted. The window size determines the
number of pixels that will be used to calculate a measurement value for each pixel.

• Method: For ,Area Fraction, Count, Number Density, Intensity Mean, and Intensity StdDev the
method can be selected. Sets the method for window translation across the image. Options are
Sliding (Slide) or Blocks (Step).

• Speed: For Orientation and Anisotropy the speed can be adjusted. Speed controls the speed vs
precision tradeoff. Higher speed settings use more downsampling on the image prior to map
calculation.

3. Generate

• Generate measurements with the current settings and print them in the table on the left
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4. Save Image

• Save image anywhere on your computer.

5. Measurement Stats

Displays the mean, standard deviation, min, and max of the selected measurements.

6. Histogram Parameters

• Determines the number of bins to divide the histogram into. The default value is auto-calculated to
provide an effective histogram shape. Typing in a new value sets a manual number of bins. Erase the
typed in value anytime to revert back to the auto-calculated value.

• Edit bin limits, font size etc
• Add a Curve Fit by selecting any of the 3 fit types: Normal, Lognormal and Bimodal. Fit parameters

are displayed by selecting the Fit Parameters button. These are automatically added to the Report
Generator.

7. Export Data, Save Plot

• Export Data: Export histogram data to spreadsheet.
• Save Plot: Save plot as image.

Right-click on these stats and select “Copy” to copy them to the clipboard*
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8. Add to Recipe

• Add to Recipe: Add local measurement as step to recipe. Measurement and format settings will be
preserved and recalled when step is played from recipe.

• Stats: Summary statistics to add to the recipe, which will appear in the global measurement report.
Options are Mean, Min, Max, Median, Standard Deviation, and Sum.

References
1. Bravo, L., & Aldana, M. (2010). Volume curvature attributes to identify subtle faults and fractures in

carbonate reservoirs: Cimarrona Formation, Middle Magdalena Valley Basin, Colombia. SEG
Technical Program Expanded Abstracts 2010. doi:10.1190/1.3513293

Tutorial

https://www.youtube.com/embed/WhAKluBliXs?rel=0

https://www.youtube.com/embed/WhAKluBliXs?rel=0

https://www.youtube.com/embed/WhAKluBliXs?rel=0
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Custom Measurements

Custom Measurements
Custom Measurements can be generated as an image measurement or a feature measurement. Image
measurements result in a single value per image, feature measurements result in per feature
measurements. Custom measurements allow for user defined formulas and mapping of existing MIPAR
image and feature measurements.

Custom Measurement Manager
Used to manage available measurements and to add/remove measurements added to the recipe.
Custom image measurements manager can be created and added to the recipe via Measurements>Custom
Image Measurements…
Custom feature measurements manager can be created and added to the recipe via
Measurements>Feature Measurements>Add Custom.

Note: To support custom measurements, the backend measurement engine has been
redesigned. Therefore, recipes built in v4.3.x or later which contain any measurements will
not load in earlier versions.
*
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1. Save/Load Available

• Save to File: Save available measurement list to a sharable file.
• Load from File: Load available measurement list from a file. This will overwrite the existing

measurement list.

2. Manage Available

• Create New: Create new custom measurement and add to Available Measurements
• Edit: Edit selected Available Measurement, measurement will not be edited in the Added to Recipe

list.
• Delete: Delete selected Available measurement, measurement will not be deleted from the Added to

Recipe list.
• Duplicate: Create a copy of a selected measurement with a unique variable name.

3. Available Measurements

Measurements available to be added to the Recipe.

• Measurement Name: user defined measurement name, this is how the measurement is listed in
MIPAR generated reports and measurement tables.

• Variable: user defined measurement name allows for the custom measurement to be used by other
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custom measurements.

4. Added to Recipe

Measurements added to the Recipe.

• Measurement Name: user defined measurement name, this is how the measurement is listed in
MIPAR generated reports and measurement tables.

• Variable: user defined measurement name allows for the custom measurement to be used by other
custom measurements.

5. Manage Added to Recipe

• Add >>: add selected Available Measurement to Added to Recipe
• Remove: remove selected Add to Recipe measurement from the Add to Recipe list.
• << Import: import selected Added to Recipe measurement to the Available Measurements list if the

measurement is not already present in the Available Measurements.

6. Summary

• Formula: user defined custom measurement formula.
• Description: user defined custom measurement description.
• Mapping: Yes/No, defines if the custom measurement output is mapped.

Demo
Watch an introduction video for custom image and custom feature measurements.
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https://www.youtube.com/embed/7LOS7q4ZQ5g?rel=0
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Create Custom Measurement

Create Custom Measurement
An interface to create a new custom measurement or edit an existing custom measurement.

1. Measurement Setup

• Name: (required) measurement name as it should appear in MIPAR reports and tables. Must not have
special characters.

• Variable Name: (required) measurement variable name that is used to reference the current
measurement in other custom measurements. Must not have special characters or use reserved
words.

• Formula: (required) measurement formula defined by using built in MIPAR measurement variables,
other custom measurement variables or arithmetic.

• Description: user defined measurement description or notes.
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• Status: Error status describing the error field and reason for the error.

2. Map Values

Allows for output value mapping to a new value.

• Range: map input (formula output) range, values in this range will be mapped to Value field. Range
must be continuous, use [] (inclusive) and () (exclusive) parentheses to define range and <-inf> and to
define lower and upper bounds.

• Value Type: data type value for map Value field, can be double, logical or text.
• Value: map output must be valid based on the Value Type selection. Double: any negative, zero or

positive numeric value. Logical: true or false. Text: any text

3. Save/Load

• Save to File: Save current measurement to a sharable file.
• Load from File: load measurement from a file, this will overwrite the existing Measurement Setup and

Map Values fields.

4. Formula Help

• Variables/Operators: assistant dialog for formula building that lists all valid operators, built in and
custom measurement variables and their syntax.
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Variables and Operators

Variables and Operators
Helpful list of all valid formula operators and their syntax as well as built in and custom measurement
variables.

Variables and Operators windows is accessed through Custom Measurement Manager>Create New/
Edit>Variables/Operators

1. Operators Table

List of valid operators and their syntax for building custom measurement formulas.

2. Measurement Table

List of built in image and feature measurements. Select a measurement to view description.

3. Custom Measurement Table

List of custom image and feature measurements. Select a measurement to view description.
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4. Selection Description

Detailed description of the selection and feature measurements. Measurement mapping status (Yes/No)
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Tools
Contains miscellaneous tools for handling data output by MIPAR functions.

Functions

• Histogram of Measurements
• Construct Polar Plot
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Image Tile Extractor
Tools > Image Tile Extractor

Splits images into a specified number tiles. Can accept a mixture of images and folders of images. An
“image_tiles” folder is created in the specified output location.

Especially useful for subsectioning images prior to applying a Spotlight-based recipe to automate feature
tracing for Deep Learning model training. Spotlight and Snap’s resolution improves as the field of view
shrinks and features occupy a larger fraction of the image.

1. Images and Folders

List of images and folders to process for tile extraction. Count will reflect number of individual images plus
number of images in the root of all selected folders. Folder entries in the list are denoted by a folder icon.
Drag and drop images and folders into this box to add.

MIPAR MIPAR User Manual - v5.0_en

Page 405 of 696



2. Add

Browse the file explorer to add images and folders.

3. Remove

Remove images and folders from the list.

4. Clear

Remove all images and folders from the list.

5. Output Location

Folder where tiles should be output. Set by default to the parent directory of the first image or folder added
to the list. Can be changed either by browsing the file explorer of manually typing a valid folder path. An
“image_tiles” subfolder will be created to store all tiles in the output directory.

6. Tiles

Number of tiles to split each image into in X by Y format.

7. Extract

Perform the tile extraction. A status message will appear to the right after extraction to confirm the number
of extracted tiles.
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Histogram of Measurements
Tools > Histogram of Measurements

Plots a histogram from a .CSV or .TXT file of previously-made measurements. These files can be output
from tools such as Measure Features, Color By Measurements, and Local Measurements.

1. Load

• To begin, load previously generated measurements. These must be .TXT or .CSV files with
continuous rows and columns.
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2. Load, Export

• Load: You can start over and create a new histogram image by loading a new feature measurements
file.

• Export: You can export the existing feature measurements results to a spreadsheet.

3. Measurement Stats

Displays the mean, standard deviation, min, and max of the selected measurements.

4. Histogram Settings

• Determines the number of bins to divide the histogram into. The default value is auto-calculated to
provide an effective histogram shape. Typing in a new value sets a manual number of bins. Erase the
typed in value anytime to revert back to the auto-calculated value. Click the ellipsis box next to “Bins”
to manually set the limits of each bin.

• Formatting changes such as font size
• Bin limits, and axes limits
• Add” Curve Fit”:#curve-fitting to data by picking one of 3 fit types, Normal, Log-normal and Bimodal.

Fit Parameters can be viewed by selecting Show Fit Parameters.

Right-click on these stats and select “Copy” to copy them to the clipboard*
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5. Export Data, Save Plot

• Export Data: Export histogram data to spreadsheet.
• Save Plot: Save plot as image.

6. Save Settings

If Histogram of Measurements is reached through the play button, then adjustments to display settings, such
as selected column, histogram bins, limits, and coloring, will be saved into the recipe. The next time
Histogram of Measurements is run on this measurement, these settings will be automatically used.

7. Unfold Histogram

Estimates the shape of a histogram of 3D features which, when sliced with a plane, would produce the
original 2D measurements [1]. Launches a window which explains the process and requirements, and allows
selection of the input and output measurements.

Histogram unfolding may only be applied to a histogram of feature areas or equivalent
diameters. The original histogram should contain at least 500 features.*
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8. Input and Output Measurements

• Input Measurements: Select the type of measurements to be unfolded. Choose between Equivalent
Diameters or Areas.

• Output Measurements: Select the type of measurements to output from the unfolding. Choose
between Equivalent Diameters or Volumes.

9. Original, Unfolded, and Edit

• Original: Show original histogram.
• Unfolded: Show unfolded histogram.
• Edit: Edit histogram unfolding parameters

References
[1] Payton, E. 2012. “Revisiting Sphere Unfolding Relationships for the Stereological Analysis of Segmented
Digital Microstructure Images.” Journal of Minerals and Materials Characterization and Engineering 11 (3):
221–242.
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Construct Polar Plot
Tools > Construct Polar Plot

Re-plots the rose plot of mean intercept values calculated from a rotating line Intercepts measurement. You
must load a “polarPlotData.txt” file output from this type of measurement.
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Curve Fitting

Introduction
MIPAR is able to fit a probability distribution curve to a measurement histogram. The supported fit types are:
Normal, Log-normal and Bimodal.

Normal Fit

MIPAR uses a Gaussian distribution function to generate a probability curve from the feature
measurements.
Equation describing the curve:

MIPAR reports the mean, standard deviation, and mode using the mu-1 and sig-1 parameters, to display
parameters select ‘Show Fit Parameters’

Log-normal Fit

MIPAR uses a Galton distribution function to generate a probability curve from the feature measurements:
Equation describing the curve:

MIPAR reports the mean, standard deviation, and mode using the mu-1 and sig-1 parameters, to display
parameters select ‘Show Fit Parameters’.

Note that mu-1 and sig-1 are the mean and standard deviation of logs and therefore describe the curve and
not the mean and standard deviation in the original measurement units. To calculate the log normal fit peak
(mode) use this equation:

Bimodal Fit

MIPAR uses a Gaussian mixture model with two peaks to generate a fit from the feature measurements.
MIPAR reports the mean, standard deviation, mode, and mixing proportion of each component using the
mu-1,2; sig-1,2; mix-1,2 parameters, to display parameters select ‘Show Fit Parameters’.
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Measurement at Percentile

MIPAR reports the inverse cumulative distribution function values of the Normal and Log-normal fits at
probabilities 10%, 25%, 75%, 90%, noted as D10, D25, D75 and D90.
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Batch Processor
The Batch Processor is used for batch applying a Recipe to multiple images. A batch process will save the
last Recipe step (or each Layer step) for each image, along with a spreadsheet of any global or feature
measurements that were set in the Recipe.

Topics

• Layout
• The Session
• Running a Batch
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Layout
Below is labeled screenshot of the Batch Processor which reveals the layout of and purpose behind each
user interface element.
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The Session
Sessions

When running a MIPAR Batch, Real Time Process, building a data set in the Session Processor or AI
Session Processor, MIPAR will organize the data into a session.

• In the Batch Processor and Real Time Processor MIPAR automatically collects the detected binary
images into folders and matches them up with the reference images. This session can be opened in
the (AI) Session Processor to make manual corrections and regenerate the measurements or start a
deep learning training.

• In the (AI) Session Processor MIPAR automatically builds a session when putting together data by
loading Reference and B/W Images. These sessions can be saved for later or merged with other
sessions to create a master data set.

Portable Sessions

MIPAR offers users to save the session as a portable session. This option will organize the reference and
binary images together with the session file for easy organization, and data transfer. Keep in mind that this
will make a copy of the original reference images which may double the data size.
Even though these sessions are better organized, loading of the session file will fail if the original images
were removed or moved from their folders.

In order for the session files to work, the original reference images and binary images
cannot be moved or removed from their original folders. For easier data organization, see
Portable Sessions

!
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Running a Batch
Tutorial

Shows how to setup and run a batch process to segment and measure features from a set images.

https://www.youtube.com/embed/KXbY8vPeroM?rel=0

https://www.youtube.com/embed/KXbY8vPeroM?rel=0
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Combine Channels

Using Combine Channels
1. Add images to the batch process that would be combined to a multipage image
2. Check ‘Combine Channels’
3. Specify the number of channels that will be stacked, for example, if every 4 images should be

combined to a single multipage image, enter the values 4. The images when sorted must follow the
scheme: 1st image is the 1st channel, 2nd image is the 2nd channel, 3rd image is the 3rd channel
and so on.

Tutorial Video
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Batch Pause and Resume

Resuming a batch
It is possible to resume a batch process that has finished or been stopped, provided the session has not
been edited in the Session Processor. To resume a batch, use the “Resume Session” button to load the
session file (.ssn or .ssn2).

The session file is saved after each image is processed, so it is available to resume processing even if the
batch is interrupted unexpectedly (for example, a power outage), though it is possible for the
“measurements.csv” file to contain an incomplete or duplicated measurement line if processing stopped as
the measurements were being written but before the session file was saved.

The recipe and calibration will have been saved in the session and will be re-loaded automatically, so it is
not necessary to have the original recipe file available. Before after loading the batch for resumption but
before the actual processing, it is available to add new images to the list to be processed. New processed
images and measurements will be placed alongside those from the original batch.

Pausing and stopping a batch
While a batch is running, it is available to pause or stop before the batch finishes. These function similarly;
the only difference between Pause and Stop is that Pause will automatically load the batch for resuming.
While the batch is paused, it is available to shut down MIPAR or even the workstation; to then resume, the
batch will need to be loaded into the Batch Processor manually. Any images that did not get processed
before will automatically be added to the file list.

Limitations:
When resuming a session, the recipe and scale factor cannot be changed.
It is not available to resume inter-image settings, such as AOI tracing, tilt correction,
alignment, stacking, and reconstruction.

!
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Real-Time Processor
The Real-Time Processor is similar to the Batch Processor, but used for applying a Recipe to multiple
images, every time a new image is added to a folder being “watched”. Any global or feature measurements
added to the recipe will be output into the save directory. This is typically a folder on a network storage
drive, such that images may be processed in real-time as they acquired and saved from an imaging
instrument.

With 3D Extension: Real-Time Processor can output Image Stacks and Reconstructions

Topics

• Layout
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Layout
Below is labeled screenshot of the Real-Time Processor which reveals the layout of and purpose behind
each user interface element.
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Session Processor / AI Session Processor
Application Description

The Session Processor and AI Session Processor is used to review Batch Process Sessions, generate
measurements on a data set and train new Deep Learning Models.

Topics

• Layout
• Measurements
• AI Training

MIPAR MIPAR User Manual - v5.0_en

Page 422 of 696



General Layout
Below is labeled screenshot of the Post Processor which reveals the layout of and purpose behind each
user interface element.

• Measurements Layout
• AI Layout

See the Keyboard Shortcuts page for shortcuts relevant to the Post Processor.*
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Measurements (formerly Post Processor)
The Session Processor is used for reviewing the results of a batch or real-time process. All saved
processed images are loaded and overlaid/outlined, etc. on their respective references. The user can flip
through each processed result to assess accuracy. Manual edits can be made to correct errors. Global and
feature measurements can be made from all processed images at once.

Topics

• Layout
• Reviewing a Batch
• Bulk Measurements
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Measurement Layout
Measurement Panel Layout

Image

Add global measurements, for example; total layer area, layer feature count, layer area fraction.

Feature

Add feature measurements, for example; area per feature, roundness per feature, nearest neighbor distance
per feature. View the results table and histogram, save the results to file or add to the summary table report.
(See Generate)

Generate

Generate a summary table for both Image and Feature measurements added.

Scale

“ session to convert pixel units (px) to physical units (cm, mm, in, etc)
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Reviewing a Batch
Tutorial

Shows how to review and edit multiple images after they have been batch processed to segment features of
interest.

Manual Editing

For a list of available manual editing tools and their descriptions, please click the links the below:

• Manual Editing Tools (same tools in this editor apply to the Session Processor)

https://www.youtube.com/embed/whP1423oY1k?rel=0

https://www.youtube.com/embed/whP1423oY1k?rel=0
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Bulk Measurements
Tutorial

Shows how to review and edit multiple images after they have been batch processed to segment features of
interest.

Measurements

For lists of available measurements and their descriptions, please click the links below:

• Global Measurements

• Feature Measurements

https://www.youtube.com/embed/KyzyMeVz0bM?rel=0

https://www.youtube.com/embed/KyzyMeVz0bM?rel=0
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AI (formerly Deep Learning Trainer)
Requires Deep Learning Extension

The Deep Learning Trainer is used to train deep learning models, which are capable of automating some of
the most challenging feature detection problems across many applications.

Below is a short video demonstrating the use of the Deep Learning Trainer:

These models may be applied as part of a Recipe by adding an Apply Model step in the Image Processor.

Topics

• Layout
• System Requirements
• Tracing
• Training

https://www.youtube.com/embed/ACvg6LAsqRY?rel=0

https://www.youtube.com/embed/ACvg6LAsqRY?rel=0
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• Updating
• Applying
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AI Layout
Below is labeled screenshot of the AI Session Trainer which reveals the layout of and purpose behind each
user interface element.

Layout

Train New

Train new deep learning model using the reference and BW images and the Training Settings

Update Model

Update deep learning model with new images/layers in the session.

Save/Apply Model

Save the trained model/apply the model in the image processor to the reference image in focus.

Training Settings

See Keyboard Shortcuts for shortcuts relevant to the Deep Learning Trainer.*
Session files are cross-compatible between the Deep Learning Trainer and Post Processor.*
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1. Tiles

Grid spacing to split each image into tiles prior to training. This reduces memory load on the GPU and
provides more data to the training algorithm, which tends to produce better results. (Example: Tiles = 3×2
splits each image into 6 sub-images)

2. Size Factor

Resize factor for training images (0-1). This reduces GPU memory load and significantly speeds up training
times. A factor down to 0.5 can often be used and still provide adequate precision.

3. Epochs

Number of epochs to run training for. The below table offers some recommendations based on your amount
of training data:

Number of Training Sub-images Epochs

< 200 500-700

200-500 300-500

500-1000 100-300

> 1000 50-100

4. Processor

• GPU: Train model on single GPU (strongly recommended — see Deep Learning System
Requirements for more information). Active GPU is set in “GPU Computation” panel in File >
Preferences.

• CPU: Train model on the CPU
• Multi-GPU: Train model on multiple GPUs on your local system (only available when more than 1

GPU is detected)
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AI Training System Requirements

Training

GPU

A GPU is strongly recommended for training deep learning models. Training performance on a GPU can be
up to 20x faster than on a CPU, and can shorten training time from weeks to hours.

Below is a list of recommended GPU options. In general:

• More CUDA cores leads to faster training and application times
• Architectures (later is better): 1000=Pascal, 2000=Turing, 3000=Ampere, 4000=Ada Lovelace
• The more RAM the better. More important than core count. 8GB+ is recommended for deep learning

training, 12GB+ for Spotlight.
• HBM2 > GDDR6X > GDDR6 > GDDR5X > GDDR5 in terms of memory bandwidth

Basic Mid-Range Performance High-End CUDA Cores RAM

GeForce GTX 1060 x 1280 6 GB GDDR5

GeForce GTX 1070 x 1920 8 GB GDDR5

GeForce RTX 2060 x 1920 6 GB GDDR6

Quadro P4000 x 1792 8 GB GDDR5

GeForce GTX 1080 x 2560 8 GB GDDR5X

GeForce RTX 4060 x 3072 8 GB GDDR6

GeForce RTX 4060 Ti x 4352 8 GB GDDR6

GeForce RTX 2070 x 2304 8 GB GDDR6

Quadro RTX 4000 x 2304 8 GB GDDR6

GeForce RTX 3070 x 5888 8 GB GDDR6

GeForce RTX 3080 x 8704 10 GB GDDR6X

GeForce RTX 2080 Ti x 4352 11 GB GDDR6

GPU training requires an NVIDIA GPU with compute capability 5.0 to 9.x (Maxwell,
Pascal, Volta, Turing, Ampere, or Ada Lovelace architecture), and your driver must support
CUDA Toolkit 11 or higher. We recommend you update your NVIDIA driver to the latest
version here. Learn more about CUDA here.

*
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GeForce GTX 1080 Ti x 3584 11 GB GDDR5X

Titan Xp x 3840 12 GB GDDR5X

GeForce RTX 4070 x 5888 12 GB GDDR6X

GeForce RTX 4070 Super x 7168 12 GB GDDR6X

GeForce RTX 4070 Ti x 7680 12 GB GDDR6X

GeForce RTX 4070 Ti Super x 8448 12 GB GDDR6X

GeForce RTX 3080 Ti x 10240 12 GB GDDR6X

Titan V x 5120 12 GB HBM2

Quadro RTX A4000 x 6144 16 GB GDDR6

Tesla V100 x 5120 16/32 GB HBM2

GeForce RTX 4080 x 9728 16 GB GDDR6X

GeForce RTX 4080 Super x 10240 16 GB GDDR6X

Quadro RTX 6000 x 4608 24 GB GDDR6

Titan RTX x 4608 24 GB GDDR6

GeForce RTX 4090 x 16384 24 GB GDDR6X

Applying

GPU

A GPU is also recommended for applying deep learning models. Application performance on a GPU can be
up to 20x faster than on a CPU.

CPU

Since applying often takes seconds, compared to hours for training, a CPU can more reasonably be used if
necessary. Please refer to the general System Requirements for more information on CPU requirements
and recommendations.
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Tracing
There are several approaches to tracing features to setup a deep learning training. Below are examples of
three recommended approaches. Tracing can be done directly in the Deep Learning Trainer (fully manual,
or semi-automated), in the Image Processor, or in an external application.

• In AI Session Processor
• In Image Processor
• In External Application

Tip: The quality of model training will depend on tracing quality, so take care to trace
features as accurately as possible. Tracing all features of interest is recommended, but not
required.
*

Tip: Training with more layers tends to produce better results. For example, consider using
3 or 4 layers, when you might have only used 2. (Example: Detecting faint pores in the
presence of dark artifacts. Use at least 3 layers: pores, artifacts, and background.)
*
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Tracing in AI Session Processor

Fully Manual
This example shows a fully manual approach to tracing features directly in the AI Session Processor.

Downloads

You may download the sample reference images to use as learning tools and follow this example.

⇩ Reference Images

Load References

Begin by launching AI Session Processor from the Launch Bar.

Drag and drop your reference images.

Add Layers

Click + in the Layers Panel to add a blank layer. Set the name and click “OK”. You may add additional
Layers at any time using the + button. Click the Layer name in the Layers Table to set the active Layer for
tracing.
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Trace Features

Use manual editing tools to trace features of interest.

Click Save and advance to the next image to continue tracing.

After all features have been traced in each image, you may use the dropdown arrow next to the + followed
by Add Inverse of All Layers to add a background Layer if needed. Name the Layer and click “OK”. You’ll
usually choose “No” when asked if you want to erode after inversion. This will add all undefined pixels as
another Layer.

Tip: The quality of model training will depend on tracing quality, so take care to trace
features as accurately as possible. Tracing all features of interest is recommended, but not
required. Pixels which are not assigned to any Layer will be ignored during training.
*
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Semi-automated
This example shows a semi-automated approach to tracing features in the AI Session Processor. This
approach is useful if you have a Recipe which does a reasonable job of detecting features of interest, but
leaves room for improvement

⇩ Download example Recipe and image

Batch Apply

Launch the Batch Processor.

Load Recipe and drag and drop images to batch process.

Click Process.

Clean Up

When batch is finished, launch AI Session Processor.

Drag and drop the Session file which was saved to the output directory of the batch process.

Use manual edit tools to correct any detection errors in all Layers of the first image.

Click Save and advance to the next image to continue correcting. Repeat until all images are corrected.

Tip: Training requires at least 2 Layers. Only use the above inversion method if all features
in Layer 1 are traced. If they are not, click + to add the second Layer, and trace a few areas
of the background.
*
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Tracing in Image Processor
This example shows a Recipe-assisted approach to tracing features in the Image Processor. This approach
is most useful for tracing grain boundaries, or other similar features.

Load Image and Recipe

⇩ Download “trace-grains” recipe. This can be used as a “starter-kit” for any Recipe-assisted tracing of
grain boundaries (or similar features).

Drag and drop your first image to open. Drag and drop “trace-grains.rcp” to load.

Trace Features

Select Manual Edit (first flagged step) and click Edit (pencil icon beneath Recipe).

Use the manual edit tools in this window to roughly trace boundaries. It is recommended that you click
Accept, save the Recipe, and re-open the editor every so often to preserve your work.
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If needed, select Clean Boundaries and click Edit to adjust the “Thickness” setting. This controls final
tracing thickness.

Save Results

When you have finished tracing on this image, double-click the last Recipe step.

Switch viewing mode to “B/W”.

Tip: Use as thin a line as possible, while still covering important pixel information at the
boundaries. A thickness of 1-3 usually works best.*
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Click Save Image > Current Image and save the image with a unique name (e.g., add _BW to the end of
the file).

Repeat this example for each image you have to trace.

Tip: Save a separate copy of this Recipe after you trace each image. This will allow you to
recall each image’s full edit history and make changes later.*
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Tracing in External Application
There are several applications available for manual image tracing on desktop and mobile operating systems.
Below are just a few of the options for Windows and Mac platforms:

Windows Mac

Adobe Photoshop x x

Gimp x x

Microsoft Paint x

Preview x

Trace in Paint (Windows)
This example shows an approach to tracing features in Microsoft Paint, such that they can then be imported into
MIPAR for deep learning training.

Load Image

Open ‘Paint’ application.
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Drag and drop image into ‘Paint’.

Trace Features

Select color ‘Red’ (Class 1), Blue (Class 2), Yellow (Class 3), Green (Class 4).

Tip: Each class should be a different item of interest, the more classes produce significantly
better results i.e. background, negative classes (things we don’t want).*
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Select any pen from ‘Brushes’ drop down menu.
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Left click and hold the mouse to draw/trace areas of interest .

Use magnify glass to zoom in on areas of interest If you make a mistake and would like to delete it hold ‘Ctrl
+ z’ to remove.
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Save Results

Once finished tracing, press the floppy disk icon in bar to ‘save’ image .

Tip: Save in either TIF or PNG format to avoid blurring at the edges of your tracings.*
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Example Tracings

We want to identify the spine, but also selected three other classes in order to give the algorithm more data
to learn from. Using these negative classes gives the software more information to know exactly what
makes your desired features unique.
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Trace in Preview (Mac)

This example shows an approach to tracing features in Preview on Mac systems, such that they can then be
imported into MIPAR for deep learning training.

Load Image

Open ‘Preview’ application.
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Select your image file from your computer drive

Trace Features

Once you’ve selected and opened your image, you must open the ‘preview’ tool box to
utilize tools

Select your pen from the tool box menu
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Select color ‘Red’ (Class 1), ‘Blue’ (Class 2), ‘Yellow’ (Class 3), ‘Green’ (Class 4) from the color drop down
menu
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Left click and hold the house to draw/trace areas of interest

Once you release the mouse after tracing, you can select to keep manual edit instead of
the auto-lines generated by ‘Preview’

Use the magnify glass icon to zoom into areas of interest. If you make a mistake just simply press the delete
key or ‘Command + z’ to remove

Tip: Each class should be a different item of interest, the more classes produce significantly
better results i.e. background, negative classes (things we don’t want).*
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Save Results

Once you’re finished you can save by simply pressing file save or ‘Command + s’. You may want first select
‘File > Duplicate’ and then use ‘Command + s’ save a copy of the traced image separate from the original.

Tip: Save in either TIF or PNG format to avoid blurring at the edges of your tracings.*

MIPAR MIPAR User Manual - v5.0_en

Page 451 of 696



Example Tracings

We want to identify the spine, but also selected three other classes in order to give the algorithm more data
to learn from. Using these negative classes gives the software more information to know exactly what
makes your desired features unique.
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Import Tracings into MIPAR

⇩ Download “extract-tracings” Recipe. This can be used as a “starter-kit” for extracting color tracings from any
image. The Recipe has steps to extract red and green tracings to start, but feel free to add others as needed.

Launch the Batch Processor.

Load the “extract-tracings.rcp” Recipe and drag and drop the set of tracings to process.

Click Process.

When the batch is finished, launch the AI Session Processor.

Click Load Session and choose the Session file output from the batch.

Replace the loaded Reference Images with the originals by shift-selecting all images, choosing Replace,
and selecting all original images.
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Training
Once features are traced, a deep learning model can be trained. This example shows how to train a deep
learning model and assumes tracing has been completed as shown in either of the tracing examples.

Downloads

You may download the sample session file and reference images to use as learning tools and follow this
example.

⇩ Session File (unzip > open .ssn2 file in AI Session Processor)

⇩ Reference Images

Load Images

Launch the AI Session Processor.

If you already have a Session file saved, load it using Load Session, or by dragging and dropping. Session
files are cross-compatible between the AI Session Processor and Session Processor.

OR

Drag and drop reference images to “Reference Images” panel to add.
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Drag and drop B/W tracings to “B/W Images” panel to add as Layer. Name Layer when prompted and click
“OK”.

Repeat for as many Layers as needed.

If necessary, use the dropdown arrow next to the + followed by Add Inverse of All Layers to add a
background Layer. Name the Layer and click “OK”. You’ll usually choose “No” when asked if you want to
erode after inversion. This will add all undefined pixels as another Layer.

Tip: Training requires at least 2 Layers. Only use the above inversion method if all features
in Layer 1 are traced. If they are not, click + to add the second Layer, and trace a few areas
of the background.
*
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Configure Settings

1. Tiles

Grid spacing to split each image into tiles prior to training, defined as columns x rows. This reduces memory
load on the GPU and provides more data to the training algorithm, which tends to produce better results.
(Example: Tiles = 3×2 splits each image into 6 sub-images, 3 columns across by 2 rows down)

2. Size Factor

Resize factor for training images (0-1). This reduces GPU memory load and significantly speeds up training
times. A factor up to 0.5 can often be used and still provide adequate precision.

3. Epochs

Number of passes through all the images to run training for. The below table offers some recommendations
based on your amount of training data:

Number of Training Sub-images Epochs

< 200 500-700

200-500 300-500

500-1000 100-300

> 1000 50-100

4. Processor

• GPU: Train model on the GPU (strongly recommended — see Deep Learning System Requirements
for more information). Active GPU is set in “GPU Computation” panel in File > Preferences.

Training images are randomly shuffled once prior to training to prevent their order biasing
model convergence. Augmentation is also applied each iteration using randomized
translation, rotation, and reflection.
*
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• CPU: Train model on the CPU

Train Model

Click Train New to begin training. It may take several seconds to initialize. When training begins, progress
percentage and time remaining will display above the “Training” panel.

You may click Stop Training at any time to stop the training. The current state of the model will be
preserved and you will be able to save it.

When training is complete, click Save Model to save model as a .DLM (MIPAR Deep Learning Model) file.

See Applying for information on applying the model.
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Advanced Settings

The advanced settings menu gives access to additional parameters to configure MIPAR’s Deep Learning
model training. These settings can help tune the trainer for model accuracy, model robustness, and training
performance. To access the Advanced Settings menu, select the training settings icon (wrench) and select
the Advanced Settings button (1).

Advanced Settings Window

2. Model Parameters

Model Depth

Number of network layers (building blocks). More layers can help the model learn larger, more complex
features, but risk overfitting, or memorizing the data set instead of general learning, and may lose the fine
details within the features.

Filter Size

Window for how many surrounding pixels the model considers when analyzing a pixel. A larger window will
result in more awareness of the neighboring environment but may lose the fine details within the features.

This documentation is still under development. Additional information about settings and
their potential impact on the training will be added in a future version.*
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3. Data Augmentation: Geometry

Rotation

Rotate the images a random number of degrees clockwise or counterclockwise up to the specified value to
simulate variation in feature orientation.
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Shift

Translate the images a random number of pixels in the x and y directions up to the specified value to
simulate variation in feature location.

Min and Max Scale Factors

Resize the image in a range between the minimum and the maximum to simulate variation in feature size or
resolution.

Reflection

Randomly flip the image over the specified axes to simulate variation in feature reflected duplication.

4. Data Augmentation: Color and Grayscale Intensity

Color Intensity

Randomly shift the color channel intensities to simulate variation in feature color. Channel intensity shift can
be defined individually, using the R, G and B entries.

Grayscale Intensity

Randomly shift the overall image brightness to simulate variation in feature exposure.
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5. Training Options: General Settings

Batch Size

Define number of images (or tiles, if tiling is used) sent through the network trainer at once. A lower number
can result in suboptimal detection accuracy and GPU resource utilization, a higher number ran result in
overfitting (data memorization) and GPU resource overflow.
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Image Order Shuffle

Mitigates image dropping if the batch size is not divisible into the number of images (or tiles, if tiling is
used). This setting also helps reduce overfitting.

Tiles X and Y

Define the number of tiles the images should be divided into before being passed into the trainer. Defined
by the number of tiles in the X and Y axis. Helps increase the training data set and can be used to reduce
GPU memory usage.

Size Factor

Resizes the images before passing them into the model trainer to reduce GPU memory usage.

Processor

Select the training hardware. A dedicated Nvidia GPU is strongly recommended. See Deep Learning
hardware requirements.

Epochs

Number of times to iterate through all images in the training set. If the value is too low, the model will not
converge to anything useful. If the epochs are too high and early stop is not turned on, the training can run
longer than needed or risk overfitting.

6. Training Options: Learning Rate

Initial Learning Rate

Defines how much a model changes each time it is presented with training data. Values that are too high
may result in failure to converge.

Progressively Drop Learning Rate

Recommended for the model training to reach maximum accuracy, but can result in longer training times.

Learning Rate Drop Period

Defines how often the learning rate is adjusted, expressed in number of epochs.

Learning Rate Drop Factor

Defines the rate at which the Learning Rate is reduced.
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7. Training Options: Validation

Validation

Enables checking of model accuracy on all images every specified number epochs, at the cost of increased
training time. Model accuracy is reported in the Session Processor once the training has started. (9)

Validation Frequency

Defines how often the model accuracy is checked, expressed in number of epochs.

Output Model

Best: returns the model that resulted in the highest accuracy score.
Last: returns the model that was returned at the end of the training.

Early Stop Patience

Will stop the model training early if the model training accuracy has reached an asymptote, defined by a
number of validations to be considered when concluding a maximum accuracy.

8. Training Options: Preprocessing Recipe

Load Recipe

Select a recipe to apply to the images before training begins. For example, to reduce noise or increase
contrast of the features of interest. Recipes cannot have Layers or Measurements. It is not recommended
for the recipe to have a crop or resize step.
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Updating
Updating a deep learning model allows new classes to be added without retraining on the entire set that had
been used up to that point.

However, our testing has shown that an extensively trained and validated model is required for updating to
work properly.

Whether adding new classes or not, unless the model has been trained on at least thousands of previous
images, we recommend to refine models by adding the new tracings to the original Session, and training a
new model on all images using Train New in the AI Session Processor.

Tip: When updating, make sure that your new tracings contain some features that look like
those from the old images, otherwise the model may start forgetting them in favor of the
new ones.
*
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Applying
Once a deep learning model is trained, it can be applied to a new image to automate feature detection.
Effectively, application of a deep learning model results in a pre-processed version of the original image,
where features of interest are “lit-up” against a dark background. The rest of MIPAR’s processing library can
then take over to accurately select features.

This example shows how to apply a deep learning model to a new image in the Image Processor. It
assumes a model has been trained as shown in the training example. If you have not followed that example,
you may download the session file below and open it in the AI Session Processor.

Downloads

You may download the sample session file, reference images, recipe, and model to use as learning tools
and follow this example.

⇩ Session File (unzip > open .ssn2 file in AI Session Processor)

⇩ Reference Images

⇩ Recipe

⇩ Model

Apply Model

After training is complete and you have saved the model, you may auto-apply the model to the active
Reference Image by clicking Apply Model.

If you have not saved the model, you may click the arrow next to “Save Model” and choose Save and Apply
Model. This will auto-launch the Image Processor, auto-launch Deep Learning > Apply Model, and auto-
load and apply the model.

OR

OR
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Launch the Image Processor from the Launch Bar.

Open an image by dragging and dropping.

Choose Deep Learning > Apply Model

Click Load Model and choose the saved .DLM file.

Click Apply Model.
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Output Result

From the Output dropdown choose either the layer map, or one of the probability maps.

Click Accept.

Tip: The “Size Factor” box is auto-populated with the size factor used to train the model. It
can be adjusted if desired. See Apply Model documentation for more details.*
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Finish Detection

After outputting the probability map, select the features of interest with Segmentation > Basic Threshold.
When added after an Apply Deep Learning step, Basic Threshold will auto-launch with Type = “Percentage”
and Selection = “Bright”.

Set the percentage threshold. This sets the lowest probability percentage that counts as a feature.

Click Accept.

Add any additional steps needed to complete the feature detection.

Tip: A key capability of working with deep learning in MIPAR is the ability to further process
the probability map(s) or layer map after output. This is often critical to achieve accurate
feature detection.
*
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If you had output a probability map, use Deep Learning > Call Output to call other probability maps if
needed.

If you had output the layer map and need to use it more than once, add a Set Memory Image #X after Apply
Deep Learning and then use Call Memory Image #X as often as you need to select all Layers.
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3D Toolbox
Requires 3D Extension

The 3D Toolbox is used for visualizing and editing Image Stacks as well as visualizing, editing, and
quantifying 3D Reconstructions. Reconstructions can be exported to other visualization applications such as
commercial Avizo and open source ParaView for high-end rendering and animation.

Topics

• Layout
• Reconstruction
• Visualization
• Measurements
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Layout
Below are labeled screenshots of the 3D Toolbox which reveals the layouts of and purpose behind each
user interface element.

Layout #1: Recon (recommended when working with a reconstruction)

Shows the Reconstruction side only. Used when working with a Reconstruction.

Layout #2: Stack+Recon

Shows both the Image Stack and Reconstruction side. Used when working with an image stack prior to
segmentation and reconstruction, or when comparing the reconstruction to the aligned image stack which
preceded it.

See Keyboard Shortcuts for shortcuts relevant to the 3D Toolbox.*
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Reconstruction
Tutorial

Shows the workflow for creating, processing, visualizing, and measure a 3D Reconstruction.

Downloads

You may download the below assets to use as learning tools and follow this tutorial.

⇩ Raw Dataset

⇩ Calibration Data

⇩ Segmentation Recipe

https://www.youtube.com/embed/sTMwAB9xPgQ?rel=0

https://www.youtube.com/embed/sTMwAB9xPgQ?rel=0
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Visualization
MIPAR

MIPAR provides basic tools for visualizing your 3D Reconstruction with tools like volume slicing, surface
rendering, and simple animation.

Avizo

Avizo is the leading high-performance 3D visualization and analysis software for scientific and industrial
data. We recommend using Avizo for your final visualization tasks if you have access. MIPAR supports
export of its surfaces, reference volumes, and segmented volumes to an Avizo file format.

More information about Avizo can be found at: https://www.fei.com/software/amira-avizo/

ParaView

ParaView is a powerful open-source visualization environment. MIPAR supports export of its surfaces,
reference volumes, and segmented volumes to a VTK file format, which can be opened in ParaView.

Also, if ParaView is installed in C:\Program Files\Paraview (not C:\Program Files\Paraview-x.x.x) on a PC,
or in “/Applications/paraview” on a Mac, the “Power Render” button in the Shortcut Bar will become active,
and clicking it will export the current view of the reconstructed volume (i.e, Reference, B/W, Outline,
Overlay, Labels, Layers) in a VTK file and automatically open it in ParaView.

ParaView can be downloaded at: http://www.paraview.org/download/
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Measurements
Global Measurements

Global Measurements report one measurement per reconstruction. Common measurements include volume
fraction of features, total surface area of features, and number density. Click any link below for descriptions
of the many global measurements available in MIPAR.

• Volume
• Volume Fraction
• Surface Area
• Surface Area Fraction
• Count
• Number Density
• Intensity Mean
• Intensity StdDev
• Intensity Sum
• Intercepts

Feature Measurements

Feature Measurements report one measurement for each feature in a reconstruction. Descriptions of the
many feature measurements available in MIPAR can be found here

Centroid Paths

Centroid Paths measurement generates a data table for either a selected feature or all features. The data
generated consists of two tables per features (Centroid_X and Centroid Y) where the tables consist of the Z
or slice position vs X or Y centroid position. File nomenclature is
‘Feature Number’_Centroid’Coordinate’

Surface Measurements

Surface Measurements report one measurement for each feature rendered. Surface render must be enabled
to allow Surface Measurements. Description of the types of surface measurements can be found here
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Volume
3D Measurements > Volume

Measures the total volume of selected pixels in the reconstruction.
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Volume Fraction
3D Measurements > Volume Fraction

Measures the volume fraction of the selected pixels in the reconstruction. Counts all selected pixels in the
active layers and divides it by the number of pixels in the layer specified in the “Relative To” window.
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Surface Area
3D Measurements > Surface Area

Measures the total surface area of the selected features.
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Surface Area Fraction
h.3 3D Measurements > Surface Area Fraction

Surface Area Fraction measures the surface area of all the selected features in the active layer and divides
it by the surface area of the layer specified in the ‘Relative To’ window.
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Count
3D Measurements > Count

Reports how many selected features are present in the reconstruction.
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Number Density
3D Measurements > Number Density

Number Density measures the number of features per unit volume, where the total volume is specified in the
‘Relative To’ window.
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Intensity Mean
3D Measurements > Intensity Mean

Measures the average grayscale intensity within selection.
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Intensity StdDev
h.3 3D Measurements > Intensity StdDev

Measures the standard deviation of grayscale intensity within selection.
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Intensity Sum
3D Measurements > Intensity Sum

Measures the total of grayscale intensity within selection.
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Intercepts
3D Measurements > Intercepts

Random Lines
Measures metrics such as mean intercept by drawing a specified number of random lines through the
features in the reconstruction.

1. Number of Lines

Number of lines to draw
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2. Noise Removal

Method for removing small intercepts

• Reject < / =: Simply ignores intercepts below a certain length
• Fit to Noise: (Only for “Random Lines”) Fits an exponential to the first few bins and subtracts this

exponential out the intercept histogram.

3. Noise Thresholds

Thresholds for either the minimum intercept length (for “Reject </=”), the number of bins to use for “Fit to
Noise”

4. Partial Intercepts

Choose whether to discard or keep intercepts that start or end at an image edge

5. Save All Intercepts

Choose whether to save all intercept lengths into text files

6. Lines Along Vector

Choose whether to draw all “Random Lines” along a specific direction. Starting points of each line will still
be random.

Measurements
• Mean Intercept – Objects: Average length of intercepts which pass through selected features

(objects)
• Mean Intercept – Holes: Average length of intercepts which pass through un-selected areas (holes)
• Mean Inverse Intercept – Objects: Average inverse length of intercepts which pass through selected

features (objects)
• Mean Inverse Intercept – Holes: Average inverse length of intercepts which pass through un-

selected areas (holes)
• Mode Intercept – Objects: Mode (most common) length of intercepts which pass through selected

features (objects)
• Mode Intercept – Holes: Mode (most common) length of intercepts which pass through un-selected

areas (holes)
• Mode Inverse Intercept – Objects: Mode (most common) inverse length of intercepts which pass

through selected features (objects)
• Mode Inverse Intercept – Holes: Mode (most common) inverse length of intercepts which pass

through un-selected areas (holes)
• Total Line Length: Total length of all lines which are drawn in order to collect intercepts.
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• Total Intersections: Number of intersections produced between the drawn lines and intercepted
features.

References
[1] ASTM E112-13, Standard Test Methods for Determining Average Grain Size, ASTM International, West
Conshohocken, PA, 2013, www.astm.org
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Feature Measurements
3D Measurements > Feature Measurements

Feature Measurements allows a variety of measurements to be made from each feature in the
reconstruction or Layer.
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1. Size

• Volume: Volume of each feature.
• Volume Fraction: Volume fraction occupied by each feature relative to entire reconstruction volume.
• Filled Volume: Volume of each feature with holes filled in.
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• Length – X: Length of each feature’s bounding box in the X-direction
• Length – Y: Length of each feature’s bounding box in the Y-direction.
• Length – Z: Length of each feature’s bounding box in the Z-direction.
• Maj/Min Axis – XY: Stats of each feature’s major and minor axis in the XY plane.
• Maj/Min Axis – XZ: Stats of each feature’s major and minor axis in the XZ plane.
• Maj/Min Axis – YZ: Stats of each feature’s major and minor axis in the YZ plane.
• Equivalent Diameter: Diameter of each feature if each was a sphere of the same volume.
• Caliper Diameter: Largest line length that fits within each feature.
• Intercepts: Measures statistics from intercept length recorded from each feature.

- Through Centroid: Draw each line through each feature’s centroid.
- Along Vector: Draw each line along the same direction through each feature.

2. Location

• Centroid: Centroid location of each feature.
• Orientation – XY: Stats of each feature’s orientation in the XY plane, where the angle is calculated by

replacing the XY section with an ellipse [1] and measuring its major axis orientation relative to the X-
axis.

• Orientation – XZ: Stats of each feature’s orientation in the XZ plane, where the angle is calculated by
replacing the XZ section with an ellipse [1] and measuring its major axis orientation relative to the X-
axis.

• Orientation – YZ: Stats of each feature’s orientation in the YZ plane, where the angle is calculated by
replacing the YZ section with an ellipse [1] and measuring its major axis orientation relative to the Y-
axis.

• Nearest Neighbor: Each feature’s distance to the closest other feature, calculated from the features’
centroids.

• Average Neighbor: Each feature’s average distance to its neighbors, as defined by the features’
Delaunay triangulation. Triangulation and distance are both calculated from the features’ centroids.

3. Shape

• Surface Area: Total surface area of each feature.
• Aspect Ratio: Magnitude of the largest principal axis, divided by the average of the remaining axes
• Eccentricity – XY: Describes how elongated or circular each feature is in the XY plane per Z section.

0 is a perfect circle. 1 is a straight line.
• Eccentricity – XZ: Describes how elongated or circular each feature is in the XZ plane per Y section.

0 is a perfect circle. 1 is a straight line.
• Eccentricity – YZ: Describes how elongated or circular each feature is in the YZ plane per X section.

0 is a perfect circle. 1 is a straight line.
- Eccentricity is calculated from the equivalent ellipse as sqrt(1-([minor axis length]/[major axis
length])^2) [1]

• First Moment of Volume *: Describes how much volume is extended away from each feature’s
centroid. Calculated as the summation of (volume x distance from centroid) over all voxels in the
feature.
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• Moment Invariants: High-order moments which describe different shape properties of each feature
[2,3].

4. Based on Layer

• Companion ID: Feature ID of the Companion that contains the Current feature being measured.
• Companion Features: Number of features in the Companion layer that are in the Current layer.
• Companion Volume: Average and total volume of features in the Companion layer that is in the

Current layer.
• Companion Surface Area: Average total surface area in the Companion layer that is in the Current

layer.
• Intensity Mean: Average grayscale intensity within each feature.
• Intensity StdDev: Standard deviation of grayscale intensity within each feature.
• Intensity Sum: Sum grayscale intensity within each feature.

5. Save Measurement File As

The “Set” button will allow you to choose where you would like the measurement results to be saved. Check
“View Histogram of Measurements” to view results as a histogram after generation.

References

[1] Ellipse is fit to the feature as the ellipse with the same second moments as the feature. Second moments
are calculated as:
uxx = sum(x^2)/N + 1/12
uyy = sum(y^2)/N + 1/12
uxy = sum(x*y)/N

where x is the x coordinate of each pixel in the feature, y is the y coordinate of each pixel, and N is the
number of pixels.

The major and minor axes are calculated as:

common = sqrt((uxx – uyy)^2 + 4*uxy^2)
MajorAxisLength = 2*sqrt(2)*sqrt(uxx + uyy + common
MinorAxisLength = 2*sqrt(2)*sqrt(uxx + uyy – common)

[2] Rosin, Paul L. 2003. “Measuring Shape: Ellipticity, Rectangularity, and Triangularity.” Machine Vision
and Applications 14 (3): 172–184.

[3] MacSleyne, J P, J P Simmons, and M De Graef. 2008. “On the Use of Moment Invariants for the
Automated Analysis of 3D Particle Shapes.” Modelling and Simulation in Materials Science and Engineering
16 (4) (June 1): 045008.
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Slice-by-Slice Measurements
Measurements > Slice-by-Slice Measurements

Slice-by-Slice Measurements allows a variety of measurements to be made from each feature in each X-Y
slice in the reconstruction. The 3D feature labeling is retained throughout the slices.

Details of available measurements are identical to those in 2D Feature Measurements.
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Surface Measurements
3D Measurements > Surface Measurements

Surface Measurements allow you to make measurements from the currently rendered surface(s).

• Positions: Measures the X, Y, Z coordinates of each point on the surface

• Curvatures: Measures the local radius curvature (in um) at each point on the surface [1]. The
averaging radius controls the extent (in um) to which the surface positions are averaged prior to the
local curvature calculation.

• Thicknesses: Measures at each point on the surface, the distance to the other side along that point’s
local normal

• Normals: Measures the local normal at each point on the surface

References
[1] David Cohen-Steiner and Jean-Marie Morvan. Restricted Delaunay triangulations and normal cycle. In
Proc. 19th Annual ACM Symposium on Computational Geometry, pages 237-246, 2003.

Surface measurements can take some time depending on the resolution and feature density
of your rendered surface(s). It is recommended that you render your surface with 50% or
more simplification prior to taking surface measurements. Enter the desired simplification
percentage in the “Simp” box in the Render Panel prior to generating your surface.

*
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Report Generator
Requires Report Extension

The Report Generator is used to export MIPAR results into a Microsoft Office Word or PDF document.

Topics

• System Requirements
• Layout
• Templates
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System Requirements
Microsoft Office Word

• Microsoft Office Word 2003 – Microsoft Office 365

PDF Viewer

• Any PDF viewer on the operating system.
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Layout

Report Types
Available report types are as follows:

Report Type Generated From

Single Image Global Measurements table in Image Processor

Single Image Feature Color by Measurements

Single Image Local Local Measurements

Batch Image Process Batch Processor and Real-Time Processor

Batch Image Global Measurements table in the Session Processor

Batch Image Feature Histogram of Measurements opened by the Session Processor

Generate Report Buttons
User can find the option to generate a report in most measurement windows and any window that has a
Print Report button or checkmark.

In Measurement Windows:

In the Batch Processor or Real-Time Processor:

User Information
Below is a screenshot of the Report Generator Settings interface. The information entered into the fields will
be entered into the header of the report.
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Report Generator Interface

Report Settings

• Compress Images: saves images as JPEG to reduce the final report size. Images pulled from a
compressed image report are lossy and are no longer original resolution or quality.

• Export Overlays: saves the report resulting images to stand alone files.

Batch Settings

• Per Field Measurements: exports the individual feature measurements table to the report.
• Aggregate Statistics: compiles summary statistics for all measurements across the image set.
• Include Images: for Batch reports select which images to include in the report. Representative to

select an image, None to add none, All to add all images.
• Representative Image: select an image from the batch to include in the report.

Generated Report Header
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Report Data
Below is a screenshot demonstrating how the data setup in MIPAR will be transferred into the report.

MIPAR Interface
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Generated Report
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Templates

Report Generator Templates
The report generator template can be found in the MIPAR install directory.
Default directory: C:\Program Files\MIPAR\reports\reportTemplate.dotx

Editing the Template
Users can rearrange and add content to the template. With some restrictions:

• Do not move fields in the header of the template into the body of the template file
• Do not rename the template file, MIPAR is looking for a file named: reportTemplate.dotx
• When making changes to the templates, save a copy of the original template under a different file

name

Adding a Company Logo

Users can add a Logo/Image to the template in the header in the ‘companyLogo’ field, right click on the field
and select ‘Remove Content Control’. Save the document as a Word Template with the same name.
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Spotlight ✧✧˙₊₊
Spotlight enables the next generation of feature detection. It is a based-on groundbreaking generalized
artificial intelligence, enabling software to “see” objects from simple to complex, even those it has not been
trained on.

The technology has been integrated into MIPAR in the form of two tools:

1. The first is simply named “Spotlight”. Accessible from a menu item in the Image Processor, it allows
users to configure Spotlight to automatically select objects from provided prompts. The result of the
Spotlight detection is output as its own recipe step.

2. The other is a new intelligent drawing tool named “Snap, available in the Image Processor’s Manual
Edit and Session Processor.

Spotlight in action Snap in action

Sections

• System Requirements
• Install and Activate
• Spotlight Tool
• Snap Tool
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System Requirements

Summary
• Windows and Mac (Apple Silicon) supported
• NVIDIA GPU with at least 6GB VRAM (12-16GB recommended) on Windows
• Other hardware in-line with general system requirements

Operating System

Windows (64-bit only)

• Windows 11
• Windows 10 (version 21H2 or higher)
• Windows Server 2022

Mac (Apple Silicon only)

• macOS Sequoia (15)
• macOS Sonoma (14)
• macOS Ventura (13)
• macOS Monterey (12.6)

GPU

Spotlight is resource intensive. Due to the significant acceleration provided, a Windows system with NVIDIA
GPU is strongly recommended. 6GB of VRAM is minimum, 12-16GB is recommended, greater than 16GB is
optimal. Apple Silicon Mac systems offer GPU acceleration through their unified chip architecture, though
performance will be lower compared to Windows systems with NVIDIA GPUs.

Spotlight is available in two performance modes: Fast and Accurate. Fast uses a lighter-weight model,
Accurate uses the full model. Fast can offer acceptable performance on a CPU, though GPU mode is
recommended for both models.

A table of NVIDIA GPU options categorized by performance is available here. The table is relevant for both
Spotlight execution and Deep Learning training on Windows systems.

NVIDIA GPUs with compute capability 5.0 to 9.x (Maxwell, Pascal, Volta, Turing, Ampere,
or Ada Lovelace architecture) are supported, and your driver must support CUDA Toolkit
11 or higher. We recommend you update your NVIDIA driver to the latest version here.
Learn more about CUDA here.

*
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Install and Activate

Install Spotlight
1. Have MIPAR v5.0.0 or later installed. Users on active maintenance may update from mipar.us/

download. Contact your MIPAR representative if need assistance.
2. Download the Spotlight installer either from the link provided by your MIPAR representative, or from

mipar.us/download
3. Double-click the installer to run
4. Follow the prompts to complete. It will install all necessary libraries and models to run Spotlight and

Snap.

Activate Spotlight

Trial

1. Download the V2C license file provided
2. Launch MIPAR v5.0.0 or later with Spotlight installed
3. Open any app > Help > Activate License > Update
4. Click Activate > select downloaded V2C file
5. Restart MIPAR > Spotlight and Snap should now be available

Full License

1. Launch MIPAR v5.0.0 or later with Spotlight installed
2. Follow the instructions provided in your delivery email
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Spotlight Tool
The Spotlight recipe step works like any other MIPAR recipe step. It’s applied on recipe load and interacts
with the rest of the recipe like a detection step. Users have full access to the rest of the MIPAR toolkit which
enables detection filtering, clean up and assigning Layers and measurements.

Spotlight works with “prompts”. They tell it where to look. Prompts can be fed through 2 different modes,
Grid or Custom:

• Grid uses a regular point grid. This is simplest, but requires density is appropriate for the features of
interest.

• Custom allows selections from earlier in the recipe to be fed as a Memory Image. This requires
additional steps prior to Spotlight but allows for more targeted and efficient prompts.

Layout
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1. Apply to

Choose to apply Spotlight to either the original opened image, or the current image in the recipe.

2. Prompt Mode

Choose to prompt Spotlight with either a regular point grid, or seeds from a Memory Image.

3. Performance

• Fast = lightweight model
• Accurate = full size model

Fast will initialize faster, but typically offers lower edge detection precision. Accurate has longer
initialization, but offers optimal precision. If you do happen to run Spotlight on the CPU, Fast is the only
practical performance mode.

• CPU = run model on CPU
• GPU = run model on GPU

4. Adjustment

Scale controls the size-scale of the targeted features.

• 1 = fine resolution
• 2 = mid resolution
• 3 = coarse resolution
• Auto = decide resolution based on quality score

Scale has more significance when using single point prompts (as in Grid or Custom-Centers modes).
Imagine pointing to a car window. “1” will select the window. “2” will select the door.”3” will select the entire
car.

Score Filter removes selections with poor scores. Higher score (85-95) better for Grid, lower (0-25) better
for Custom.

The wrench icon exposes advanced settings, which contains Batch Size control. Higher batch size will
process more prompts in parallel and generally increase performance, as long as your system has the RAM
headroom. If processing on the GPU, batch sizes from 10-30 tend to be optimal. Batch sizes above 30
saturate the RAM of most GPUs and can actually result in decreased performance. However, if your GPU

Spotlight is resource intensive. Due to the significant acceleration provided, a Windows
system with NVIDIA GPU is strongly recommended. Make sure your workstation meets
system requirements.
*

MIPAR MIPAR User Manual - v5.0_en

Page 506 of 696



has 16GB+ RAM, you may be able to increase batch size further with improved performance.

5. Processing Preferences

• Live preview allows you to watch Spotlight as it runs. Useful for understanding prompt impact and to
optimize settings without waiting for entire run. Performance will be significantly reduced during live
preview.

• Auto-update will automatically re-run Spotlight after every setting change

Grid Mode

Density is a setting specific to Grid mode. It controls the number of points per side of the grid.
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Custom Mode

Custom prompt mode can be run in Centers, Boxes, or Areas mode.

• Centers uses feature centroids as prompts.
• Boxes uses feature bounding boxes as prompts.
• Areas uses multiple points per feature. Sampling % an adjustable setting.
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Boxes

In Boxes, Dilation is an adjustable setting and grows seed bounding boxes prior to prompting.

Areas
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In Areas, Sampling % is an adjustable setting and controls number points used per feature in selected
Memory Image.

Quick Start Videos

Grid Mode Introduction

An introduction to the grid mode in Spotlight. Highlights how contiguous features like grains can be
segmented using Spotlight along with an example workflow.

Custom Mode Introduction

An introduction to the custom seed Spotlight mode. Highlights how clusters of features can be separated
using Spotlight along with an example workflow.

https://www.youtube.com/embed/NGQbTDGo3GY?rel=0
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https://www.youtube.com/embed/UDsnHtos6zQ?rel=0
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Snap Tool
Snap is a new intelligent drawing tool powered by Spotlight. Available in Manual Edit and Session
Processor, it lives alongside the other manual drawing tools.

Layout

1. Activate

Click to activate Snap.

2. Performance Mode

• Fast = lightweight model
• Accurate = full size model

Fast will initialize faster, but typically offers lower edge detection precision. Accurate has longer
initialization, but offers optimal precision. Snap will automatically run on your NVIDIA GPU if available. If
not, it will run on CPU, in which case Fast is the only practical performance mode.

3. Prompt Mode

• In Point, hover over an object, get a preview of the selection, and select the object with a click.
• In Box, click and drag a box around the object to preview, then release to make the selection.

4. Scale

Scale controls the size-scale of the targeted feature.

• 1 = fine resolution
• 2 = mid resolution
• 3 = coarse resolution
• Auto = decide resolution based on quality score

Scale has more significance when using Point mode. Imagine pointing to a car window. “1” will select the
window. “2” will select the door.”3” will select the entire car.
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Quick Start Video
A quick introduction to Snap, a powerful manual edit tool which can make segmentation corrections and
deep learning training data acquisition faster than ever before.

https://www.youtube.com/embed/Mjm65PaXVao?rel=0
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Quick Start Videos

Grid Mode Introduction
An introduction to the grid mode in Spotlight. Highlights how contiguous features like grains can be
segmented using Spotlight along with an example workflow.

Custom Mode Introduction
An introduction to the custom seed Spotlight mode. Highlights how clusters of features can be separated
using Spotlight along with an example workflow.

https://www.youtube.com/embed/NGQbTDGo3GY?rel=0

https://www.youtube.com/embed/NGQbTDGo3GY?rel=0
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Snap Introduction
A quick introduction to Snap, a powerful manual edit tool which can make segmentation corrections and
deep learning training data acquisition faster than ever before.

https://www.youtube.com/embed/UDsnHtos6zQ?rel=0

https://www.youtube.com/embed/UDsnHtos6zQ?rel=0
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Example (Full Grain Segmentation)
A full grain segmentation workflow showcasing multiple uses of Spotlight within a single recipe. Use of both
grid and custom Spotlight modes lays the groundwork for a robust grain segmentation.

https://www.youtube.com/embed/Mjm65PaXVao?rel=0

https://www.youtube.com/embed/Mjm65PaXVao?rel=0
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https://www.youtube.com/embed/88qEWhxaDkg?rel=0
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Live
MIPAR Live is an extension that allows MIPAR to connect directly to a supported camera and capture
images to analyze. It provides a direct path from image capture to analysis, without having to switch
software or load image files into MIPAR.

Topics

• Supported cameras
• Layout
• Starting MIPAR Live
• Setting up a camera
• Connecting to a camera
• Controlling camera settings
• Capturing images
• Applying recipes
• Batch analysis
• Calibrating captured pixel size
• Known software conflicts
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Supported Cameras
Camera Manufacturer Supported Models Camera installation utility

Sentech
STC-MCS241U3V
STC-MCS322U3V

1. StCamSWare (obtain from your camera distributor)
Minimum install:

Driver(x64)
GenTL(USB3Vision)(x64)

2. Matrix Vision
Minimum install:

Base Libraries
USB3 Device Drivers
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Starting MIPAR Live
MIPAR Live resides inside the Image Processor and is started simply by starting the Image Processor from
the Launch Bar (1).

When you have an active MIPAR Live license, the Image Processor opens in Live mode. To switch between
Live and Recipe modes, use the Live / Recipe mode switch just above the rightmost panel (2).
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Layout
Access to MIPAR Live is gained through 1. the Recipe/Live Mode toggle.

MIPAR Live MIPAR Live is laid out in three main sections, from right to left: Camera Controls, Live Image
Preview, and Captured Image. Generally, a workflow proceeds from right to left as:

2. the camera is started,
3. the live field of view is previewed,
4. settings are adjusted,
5. the image is captured, and
6. a recipe is applied.
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Setting up a Camera
The Camera Setup window is accessed from the Preferences window, using the (1) Calibrate Objectives
button.
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The Camera Setup window allows the user to rename the camera’s display name in the (2) camera
dropdown, as well as define (3) preset objectives and calibrations.
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Connecting a Camera
The list of available cameras is populated when the Image Processor is opened. To connect to a camera,
select it from the camera dropdown:

Reselecting a camera from the dropdown will reset the connection to the camera.

When a camera is selected, MIPAR will take exclusive control of the camera. To release the camera, select
“Unload camera” from the camera dropdown.

The camera’s display name can be changed using the Camera Setup window.

• Refreshing the camera list
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Refreshing the Camera List
The camera list is populated when the Image Processor is opened. To refresh the camera list, close and re-
open the Image Processor.

The camera list is also populated when the Camera Setup window is opened. Opening the Image Processor
or the Camera Setup window while the other is also open simply re-uses the current camera list. To refresh
the camera list, make sure both windows are closed.
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Controlling Camera Settings
Camera settings are controlled in the right-most panel of the Image Processor, in the same location as the
Recipe panel in Recipe Mode. Basic settings are exposed directly in this panel. Advanced settings are
available through the Advanced Settings button at the bottom of the panel.

Classes of settings:

• Image size
• Brightness, contrast, and color
• Advanced settings
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Image Size and Calibration
Image size controls are located in the top of the Camera Controls panel, just below the Camera Select
dropdown.

Image size

The image size dropdown (1) allows the user to select between different available sizes, determined by
what the camera makes available. Choosing an image size will set the camera’s binning (or decimation if no
binning is available) to achieve the desired image size.

Pixel calibration

Below the image size dropdown are the pixel calibration controls. If objectives have been specified in the
Camera Setup window, these controls will consist of an Objective Dropdown (2) showing the available
objectives. If no objectives have been specified, there will be two controls: one to specify the current
magnification (3) and one to specify the camera’s native sensor pixel size (4) and units. If the camera
reports its own sensor pixel size, this control will be auto-populated. If the camera is installed using a C-
mount with magnification other than 1, be sure to adjust the entered objective magnification accordingly.

Once the user selects an objective or inputs magnification and pixel size, the image calibration will be
calculated, taking into account any binning or decimation specified by the Image Size selection. This
calibration is displayed in the Calibration Panel (5) and will be recorded into the image file when it is saved
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to disk. Note that a captured image’s calibration is determined when the image is captured and ignores any
changes in image size or objective magnification performed after capture.
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Brightness, Contrast, and Color

Image brightness and color balance are controlled by the bottom two sections of the Camera Control Panel.
Available settings are Exposure, Gain, Black Level, and Color Balance Red/Green/Blue. These are
manipulated using the provided sliders, with the minimum, maximum, and current values for each setting
listed around the slider. To enter a specific value, use the Advanced Settings Window. If a particular setting
isn’t available on the selected camera, the control will be disabled.

Auto checkboxes enable and disable continuous automatic control of each associated setting. The slider
and current value for a setting with auto turned on will be updated periodically. If the selected camera
doesn’t support automatic control for a particular setting, that Auto checkbox will be disabled.
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Advanced Settings
The Advanced Settings Window is accessible is available through the Advanced Settings Button, located at
the bottom of the Camera Control Panel. This button gives control of all settings that the camera makes
available.

If the camera is being previewed when the Advanced Settings Window is opened, some settings may be
disabled. Close the Advanced Settings Window, stop previewing, and re-open the Advanced Settings
Window to make these settings adjustable.

Note that it is possible to produce a combination of settings that MIPAR Live does not support, such as
trigger-based image capture or non-square pixels. If this happens, re-load the camera to restore defaults.
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Capturing Images
• (1) Connecting the camera: Images can be captured from a camera after it has been connected with

the camera dropdown.
• (2) Previewing the camera: Optionally before you capture an image, you can preview a live feed of the

camera’s field-of-view with the Preview button.
• (3) Auto-save: Auto-save allows the automatic saving of images as they are captured.
• (4) Capturing an image: Images are captured with the Capture button.
• (5) Saving a captured image: Once captured, images can be saved with the Save Image button or

with the menu option File -> Save Captured Image
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Previewing the Camera
To live preview the selected camera’s current field-of-view, use the Preview button (1). The preview feed will
appear in the right Live Image panel. This feed will reflect, in real time, changes in the camera settings and
in the sample.

Note that previewing is optional. It is possible to connect a camera and start capturing images without
previewing.
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Auto-save
The auto-save option instructs MIPAR to save images as they are captured off the microscope. It is enabled
through the Auto Save Captured checkbox (1).

When auto-save is enabled for the first time, the Auto Save Settings window will appear. This window can
also be accessed through the Auto Save Settings button (2) next to the Auto Save Checkbox. This allows
the user to control the following aspects of the auto-save process:

• Save location (3)
• Common image name prefix (4)
• Unique image identifiers (5)
• Image file format (6)

Unique Image Identifiers

Auto-save offers two different unique identifiers: image number and capture timestamp. These identifiers will
be appended to the image file name. At least one of these options must be chosen.

For image number, there is also a setting to control the minimum number of digits to use for this number.
File numbers with less than the specified number of digits will be padded with leading zeros. For example,
image number “12” with a 3-digit number field will be inserted into the file name as “012”. When determining
which image number is next, the algorithm looks only at the image name prefix, ignoring any timestamps. It
also skips missing numbers. For example, in a folder with “image_01.png” and
“image_03_2023-02-03_11-02-41.482.png”, with 3 digits and no timestamp, the next auto-saved image will
be named “image_004.png”.
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Capturing an Image
To capture an image, first connect a camera as described in “. Then, push the Capture button (3). The
captured image becomes displayed in the left, Captured Image, panel.

The capture time and calibration (if one exists) are determined at the time of capture and are unaffected by
changes made to camera settings afterward.
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Saving a Captured Image
To save an image once it has been captured, use either the Save Image button or the Save Captured Image
menu item.

When an image is saved, the time of capture, camera vendor and model, and calibration (if it exists) are
saved into the file’s metadata if the chosen format supports them.
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Applying Recipes
To apply a recipe to a captured image, the recipe can be preloaded in Live Mode, using the Load Recipe
button (1) or menu option. This causes the recipe to be placed in the Preloaded Recipe dropdown (2):

This pre-loading can be performed either before or after image capture. Also present in this dropdown are
options to start a new recipe and to apply the recipe already loaded into Recipe Mode (if one exists).

Once a preloaded recipe has been selected and an image has been captured, the recipe can be applied to
the image with the Apply button (3). This causes the Image Processor to switch to Recipe Mode and the
chosen recipe to be applied to the captured image.
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Batch Analysis
To perform batch analysis of captured images, use either the Batch Processor or the Real-Time Processor.
The Batch Processor is useful if you wish to perform the analysis once all the images have been captured.
The Real-Time Processor is useful if you wish each image to be analyzed as it is captured. Either way, it is
very helpful to use the Auto-Save feature, which automatically saves the captured images into a specified
folder. Point the Real-Time Processor at this folder before you begin to capture images, or load the images
from this folder into the Batch Processor after capture is complete.
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Calibrating Captured Pixel Size
To specify the calibration of an image, you may either manually enter values for pixel size and objective
when you load the camera, or you may use objective presets.
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Calibrating and Certifying Objectives
To add objectives to the objective list, use the (+) button to the right of the objective table (1). Once added,
you can manually enter a scale and choose calibration units (2).

Alternatively, choosing “Calibrate from Live” (3) will bring up a live preview of the camera inside the
Calibration Window. After calibrating the scale, a new objective will be added to the list with this calibration
automatically populated.

Additionally from this window, it is possible to save a backup of all the cameras (4). When restoring from
backup (5), the user can choose to restore information for all the cameras or just the current one.

The Camera Setup window also displays information about any certification done to the microscope
objectives, and allows the certifying entity to password-protect the objective list and calibration for a
particular camera (6).
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Known Software Conflicts
Camera manufacturer Conflicting software

Sentech StCamSWare 2015 and StViewer installed together

MIPAR MIPAR User Manual - v5.0_en

Page 541 of 696



Checkpoint: Compliance by TotalLab
MIPAR Checkpoint: Compliance by TotalLab, is specially designed to provide 21-CFR Part 11 (US) and
GMP Annex 11 (EU) compliance.

A typical MIPAR Checkpoint setup consists of three parts:

1. A MIPAR recipe
2. A MIPAR Checkpoint Server
3. A MIPAR Checkpoint workstation with a MIPAR Checkpoint Client and MIPAR Analysis Engine

installed

MIPAR Recipe
The MIPAR Recipe contains the image analysis algorithm. It is typically built by R&D or QC using the Base
version of MIPAR. It could also be purchased from MIPAR with our custom recipe service.

MIPAR Checkpoint Server
The MIPAR Checkpoint Server is software installed on one of your systems which manages user accounts,
tracks project changes, and stores project data between check-outs.

Analysis Workstation
The MIPAR Checkpoint workstation contains the MIPAR Checkpoint Client and MIPAR Analysis Engine
installations for performing analysis and signoffs. The MIPAR Checkpoint Client communicates with the
Server and runs the MIPAR Analysis Engine to perform and review analysis.

Manual Contents
• System Requirements
• Install and Activate
• Reference Documents
• User Accounts
• Developing an Analysis Workflow
• Typical Workflow
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System Requirements

MIPAR Checkpoint Server
Operating System: Windows 10 required, Windows 11 recommended
Machine Type: Physical or virtual
CPU: Intel Core i3 (i5 recommended) or AMD Ryzen 3 (Ryzen 5 recommended)
GPU: WebGL 1.0 compatible required, 2.0 recommended
Storage: SSD recommended, 2 GB free required, plus necessary capacity dependent on project size and
number
RAM: 2 GB required, 16 GB recommended

MIPAR Checkpoint Client and MIPAR Analysis Engine
Operating System: Windows 10 required, Windows 11 recommended
Machine Type: Physical or virtual
CPU: Intel Core i3 (i5 recommended) or AMD Ryzen 3 (Ryzen 5 recommended)
GPU: WebGL 1.0 compatible required, 2.0 recommended. Integrated graphics acceptable for lightweight
processing. Discrete NVIDIA card recommended, options available here. See Spotlight requirements if
needed by your recipes.
Storage: SSD recommended, 12 GB free required, 14 GB free recommended
RAM: 8 GB required, 16 GB recommended
Connectivity: Network access to the Server component (may be localhost)
Other software: Microsoft Word

Administrative access required for installation and setup.*
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Install and Activate
• MIPAR Checkpoint Server
• MIPAR Checkpoint Client and MIPAR Analysis Engine
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MIPAR Checkpoint Server

Required materials
• MIPAR Checkpoint Server Install Pack

Instructions
• Detailed installation instructions are included in the Server Install Pack
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MIPAR Checkpoint Client and MIPAR Analysis
Engine

Required Materials
• MIPAR Checkpoint server installed
• Network address to MIPAR Checkpoint Server (including port number)
• A MIPAR Checkpoint user account
• MIPAR Checkpoint Client installer (retrieved from Server)
• MIPAR Analysis Engine license key
• MIPAR Analysis Engine activation method (Offline or Online)

MIPAR Checkpoint Client
• Installation instructions are distributed with the MIPAR Checkpoint Server

MIPAR Analysis Engine
1. Follow the installation instructions here
2. After successful activation, you will receive a warning about not being started through Checkpoint and

then close.

MIPAR MIPAR User Manual - v5.0_en

Page 546 of 696



Reference Documents
Server Install Guide
Admin Walkthrough
Client Walkthrough
Compliance Guide
HTTPS
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User Accounts
A typical MIPAR Checkpoint Server setup uses three types of user accounts: Analysis, Sign-off, and Admin.
Analysis accounts create new projects and perform analysis. Sign-off accounts view results and approve
projects. Analysis and Sign-off accounts use Client installations. Admin accounts manage the MIPAR
Checkpoint Server and set up other users.

User accounts and account types are configured in the MIPAR Checkpoint Server. Once an account type is
configured, it can be assigned to a user. At any time, the permissions assigned to an account type and the
types assigned to an account can be changed.

Account type – typical permissions

Other setups are possible, for example combining Signoff and Admin responsibilities into a
single account type or restricting project creation to supervisors.*
For additional documentation on configuring users, refer to the Admin Walkthrough
document also linked in Client tab of the server admin portal (or use https://localhost:19811/
doc/admin-walkthrough.html on the server system).
*
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Analysis users
1. Add Project
2. Check Out
3. Check Out (non-editable)

Signoff users
1. Check Out (non-editable)
2. Access Log
3. Signoff

Admin users
1. Check Out (non-editable)
2. Emergency Login
3. Access Log
4. Admin Login

To restrict data export, the “Check Out (non-editable)” permission can be withheld from
Analysis users

!
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Developing an Analysis Workflow

Required materials
• MIPAR Base + Report Generator
• Images to analyze

Building the recipe
1. Using the standard images and the MIPAR Image Processor, develop a recipe to perform the desired
analysis
2. Record any Preferences that may impact analysis: Measurement and calibration units, Image -> Scale
to 8-bit on Load (if the input images are not 8-bit), Labeling -> 2D Labeling Order, Labeling -> Labeling
Connectivity, GPU Computation, and Hardware Acceleration

3. Open the MIPAR Batch Processor
4. Load the developed recipe and images the recipe was built on
5. In the Results panel, choose Print Report

6. Open the report settings window (using the pencil icon next to Print Report)
7. Set the Report Settings -> Format to “PDF”, select Batch Settings -> Per Field Measurements and
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Batch Settings -> Aggregate Statistics, set Batch Settings -> Include Images to “All”
8. Make note of any operator requirements for User, Customer, and Materials Information
9. Select “OK” to close the Report Generator settings
10. Select Process to generate the expected measurement output
11. In the resulting Session folder, find the “report.pdf” file and “measurements” folder with output *.csv
files for use during Operator Qualification.

Deliverables
• Recipe
• Prescription for Report Generator User/Customer/Materials Information
• Preferences (for Operator Qualification)
• .csv and .pdf output files from the Batch Processor (for Operator Qualification)
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Typical Workflow
The typical workflow unit is the “project”. Projects consist of a batch of images, a recipe to analyze those
images, and a set of analysis results consisting of measurement files and a PDF report. Projects are created
at the MIPAR Checkpoint workstation. They proceed through the Analysis, Request Signoff, and Approved
phases, at which point the analysis results can be exported from the project.

• Required Elements
• Performing Analysis
• Quality Control Approval
• Requesting Signoff
• Completing Signoff
• Exporting Results
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Required Elements
• Recipe for analysis
• Prescribed Report Generator User, Customer, and Materials Information
• Prescribed Preferences settings (First time only, for the recipe’s Operator Qualification process)
• Images for analysis
• Login information
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Performing Analysis

Starting the application
1. Open the MIPAR Checkpoint Client application

2. If necessary, connect to the Server
3. Enter User Login Information

Opening project

(If your project doesn’t exist yet)
1. Click the Projects dropdown in the upper-left corner
2a. (If your workflow specifies adding the recipe and image files through MIPAR) Click the New Empty
Project button
2b. (If your workflow specifies adding the recipe and image files on project creation) Click New Project
and add the recipe and image files.
3. Choose a new project name and click “Create Project”

4. Select the project from the project list and click the Check Out button
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5. Click the MIPAR button

6. MIPAR’s Batch Processor should open
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Processing images

1. (First time only, when performing the recipe’s Operator Qualification process) Open the File menu,
select the Preferences item, enter any settings specified for the recipe, and click the Accept button.

2. (If necessary) Add the recipe and/or images to MIPAR
3. In the Results panel, click the settings (pencil) button
4. Enter the prescribed Report Information, and click “Ok”
5. Click the Process button
6. (If desired) Click the View Results button
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Finishing the analysis session

1. Close all MIPAR windows to return to MIPAR Checkpoint Client
2. Click the Commit button

It is possible to spread the analysis over multiple sessions. Simply re-Check Out the project,
open MIPAR and add more images, and click Process again. Then, you can check-in the
updated project.
*
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Quality Control Approval
The Quality Control step enables a supervisor with the Q/C permission to approve some intermediate state
of the project before continuing. If QC is to be used, it must be enabled in the MIPAR Checkpoint Server. An
analysis workflow can specify that Q/C should occur at any point after project creation, with one QC allowed
per revision. The process of requesting and granting QC approval is very similar to that of granting Signoff
approval.
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Requesting Signoff
1. (If necessary) Login to MIPAR Checkpoint Client with the instructions here
2. Select the project you wish to request Signoff for
3. Click the Request Signoff button
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Completing Signoff
1. Login to MIPAR Checkpoint Client as a user with Signoff permissions with the instructions here

2. Choose the project to view
3. Check-out the project in Read-Only mode using the “Check Out (non-editable)” button

4. Click the “MIPAR” button
5. Using the MIPAR Project Overview window, check that the proper recipe was used for analysis, that
all images have been analyzed and are present in the project, and that the Report and measurement
files contain the expected information.
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6. In the Session Processor, check that the images and layers are as expected
7. Close all MIPAR windows and return to the MIPAR Checkpoint Client

8. Choose either the “Sign Off”, “Reject”, or “Cancel Request” button, as appropriate
9. Enter Notes (if necessary) and user password, then click “Ok”
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Exporting Results
1. Obtain supervisor sign-off
2. Login to MIPAR Checkpoint Client with a user that has “Check-Out (non-editable)” permissions, using
the instructions in Performing Analysis

3. Select the project, then select “Check Out (non-editable)”

4. Select “MIPAR”
5. Once the Project Overview window appears, select the “Export Results” button and choose a save
location
6. Close all MIPAR windows to return to MIPAR Checkpoint Client
7. Select “Return”
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Python API
Welcome to MIPAR Python API documentation. This documentation will describe the library capabilities and
outline some example workflows.

Topics
• Introduction
• Install and Activate
• System Requirements
• Library
• Release Notes
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Introduction
MIPAR API is a powerful tool that packages the MIPAR engine into a Python library.

Scope
The MIPAR API was developed to meet the needs of customers who are already using MIPAR to do
powerful image analysis, but would like to setup “headless” workstations that execute algorithms with
minimal supervision. The library is in Python as it is extremely versatile and widely adopted.

Capabilities
At this time the MIPAR API is only able to execute pre-built MIPAR recipes, this means that you must have
an already developed MIPAR recipe to utilize the MIPAR API. The engine accepts images, recipes and
calibration factors and returns the resulting binary masks and global measurements. See Library for more
detail.
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Install and Activate
Standard Install Library

1. Download the installation package provided to you by the MIPAR support team.
2. Install python 3.7,3.8 or 3.9
3. Add python to Windows path
4. Run MIPAR-API_v.x.x.x_InstallPack_Win.exe. Follow extraction and installation wizard instructions.
5. The installer will install a miparAPI folder in Program Files and attempt to install the miparAPI

package into the default python environment
6. Add a new system environment variable: miparAPI with value: <Path to the miparAPI folde

r in your Python Environment>

Activate Trial License

1. Activate trial license.v2c file on the API system Link

Activate Local License

1. Activate local license: Link

Activate Network License

1. Install server side license manager Link
2. Configure client side license manager on machine that will be running the API Link

Custom Environment Install

1. Run MIPAR-API_v.x.x.x_InstallPack_Win.exe. Follow extraction and installation wizard instructions.
2. The installer will install a miparAPI folder in Program Files and attempt to install the miparAPI

package into the default python environment
3. Copy the miparAPI folder in the site-packages folder to the packages folder of the new environment
4. update the miparAPI environment variable with the location of the miparAPI folder in the new

environment

It might take some time for the server side license manager to see the client activation,
please be patient.*

If you run into any problems during installation, please contact support@mipar.us for
assistance*
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Troubleshooting
Error During Cause Possible Solution

API is not able to find
the MATLAB Runtime

Startup
MATLAB Runtime is
not installed or is not
added to the PATH

1. Check if MATLAB Runtime is installed
(default install directory: C:\Program Files\
MATLAB\MATLAB Runtime\v911

2. If installed go to step 3, if not installed,
download and install from here:
https://www.mathworks.com/products/
compiler/matlab-runtime.html

3. Check if the following directory was added to
the Environmental System Variable ‘Path’
directory: ‘C:\Program Files\MATLAB\
MATLAB Runtime\v911\runtime\win64’

API is not able to find
the preferences file

Startup

The preferences file
parent directory was
not added as an
environmental
variable

Add the environmental variable ‘miparAPI’ with value
site-packages folder in the Python install path.
Default: C:\Users\\AppData\Local\Programs\Python\
Python[VERSION]\Lib\site-packages\miparAPI

Python returns error:
module 'miparAP
I' has no attrib
ute 'initialize'

Startup

The python library
was not properly
installed into the
environment

1. navigate to the miparAPI library install
directory (default C:\Program Files\miparAPI)

2. Try executing the following command from a
terminal: python setup.py install

3. If 2 fails, navigate to the system install
directory (default: C:\Program Files\
miparAPI) # copy contents to your python
environment

4. Execute the following command from a
terminal: python setup.py install

activate or activa
tePK methods fail
and License Manager
page is not reachable

Runtime
The license manager
was not installed

1. Download the License Manager package for
Windows

2. Extract the downloaded
Install_License_Manager_Win.zip (Right-
click > Extract All)

3. Inside the extracted folder, double-click
Install License Manager.bat
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Update Instructions

Major Update (v _.x.x)
1. Download the install pack from provided link
2. Make sure the system is running a Python version that is compatible with the MIPAR Library
3. Run MIPAR-API_vx.x.x_InstallPack.Win.exe and follow the wizard

Minor Update (v x. _ . _) into Standard Environment
1. Download update pack from provided link
2. Make sure the system is running a Python version that is compatible with the MIPAR Library
3. Run miparAPI_v4.1.1.0_Updater_Win.exe and follow the wizard

Minor Update (v x. _ . _) into Custom Environment
1. Download update pack from provided link
2. Make sure the system is running a Python version that is compatible with the MIPAR Library
3. Run miparAPI_v4.1.1.0_Updater_Win.exe and follow the wizard
4. Copy contents of the site-packages/miparAPI folder in the Python install directory to the new

environment
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System Requirements

Supported Python Versions
• Only versions v3.9, 3.10, 3.11

Supported Operating Systems

Windows (64-bit only)

• Windows 11
• Windows 10 (version 21H2 or higher)
• Windows Server 2022

Minimum System Requirements
• CPU: Dual-core modern Intel / AMD
• GPU: Integrated graphics
• Storage: SSD (Solid State Drive)
• RAM: 8GB

Recommended System Specs
• CPU: 6+ core modern Intel / AMD
• GPU: NVIDIA GeForce/Quadro 2000 series or better
• Storage: SSD (Solid State Drive)
• RAM: 16+ GB

MIPAR API performance greatly depends on workstation hardware. Workstation that is
running the API should have similar specifications to the workstation where the recipe was
built in order to achieve similar performance.
*
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GPU Support
Enable

Only NVIDIA GPUs are supported for GPU computation at this time. Click here to learn more about the
technical aspects and benefits of GPU computation.

To enable GPU computation on the API Machine:

1. Enable GPU computation on the recipe building workstation Link
2. Copy miparPreferences.pref file in C:\Program Files\MIPAR directory of the recipe building machine
3. Paste file into C:\Program Files\MIPAR directory of the API machine

Supported Functions

See GPU Computation for detailed list.

If you are executing the API on the same machine as recipe building, both applications
share the same GPU acceleration settings*

MIPAR MIPAR User Manual - v5.0_en

Page 569 of 696

http://www.nvidia.com/object/what-is-gpu-computing.html
https://www.manula.com/manuals/mipar/user-manual/latest/en/topic/gpu-functions


Library
This is the current list of methods in the MIPAR API

Method Purpose Link

initialize Initialize miparAPI library Link

startLicenseMan Initialize license manager Link

activatePK Activate product key Link

exeRecipe Apply specified recipe to specified image Link

setPrefs Set preference value Link

getPrefs Get preference value Link

terminate Stop miparAPI and background engine Link
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activate()

The activate function is used to activate a MIPAR API license key using the command line.

Arguments

Args:
productKey: MIPAR API product key or path to a .v2c license file, formatted as a
string.

Returns:
errorStatus: dictionary that contains the errorFlag and errorMessage
flag: 0 - no error, 1 - an error occurred
message: error string of error that occurred during activation

Syntax

errorStatus = mipar.activate(productKey)

Example

# initialize engine and licence manager
import miparAPI
mipar = miparAPI.initialize()
productKey = r'12345678-abcd-1234-abcd-123456789101'
errorStatus = mipar.activate(productKey)
# or
productKey = r'directory/apiKey.v2c'
errorStatus = mipar.activate(productKey)

This function is available in versions 3.2.3 and later. In versions 3.2.2 and earlier, use
activatePK() instead.

!
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aboutAPI
The aboutAPI function is used get information about the API version and license status

Arguments

Args:
no inputs

Returns:
aboutDictionary with the following keys:
version: API version as a string
active: returns 1 if the machine has an active license
res: returns status from the license manager

Syntax

aboutDictionary = mipar.aboutAPI()

Example

# initialize engine and licence manager
import miparAPI
mipar = miparAPI.initialize()
aboutDictionary = mipar.aboutAPI()
mipar.terminate()
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activatePK()

The activatePK function is used to activate a MIPAR API license key using the command line.

Arguments

Args:
productKey: MIPAR API product key formatted as raw string.

Returns:
errorStatus: dictionary that contains the errorFlag and errorMessage
errorFlag: 0 - no error, 1 - an error occurred
errorMessage: error string of error that occurred during activation

Syntax

errorStatus = mipar.activatePK(productKey)

Example

# initialize engine and licence manager
import miparAPI
mipar = miparAPI.initialize()
productKey = r'12345678-abcd-1234-abcd-123456789101'
errorStatus = mipar.activatePK(productKey)

This function is available through version 3.2.2. In versions 3.2.3 and later, use activate()
instead.

!
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exeRecipe()
The exeRecipe function is used to execute a given recipe on a given image and return the binary mask
data and their corresponding measurements.

Arguments

Args:
image: file path to image as a raw string or image matrix. For companion images i
nput a list of raw strings or image matrices. numpy.ndarray image support: numpy
arrays must be converted to a list, see example below.
recipePath: file path to recipe as raw string
cal: calibration factor in units of micrometer per pixel as a float (optional as
of 3.2.3)

Returns:
recOutput: dictionary variable that contains the binary masks of segmentation an
d measurements. Binaries can be retrieved by calling the layer and 'binary' key a
nd measurements are retrieved by calling the layer name and the measurement key.

Syntax

X = mipar.exeRecipe(imagePath, recipePath) #to keep existing calibration factor s
aved with the recipe
X = mipar.exeRecipe(imagePath, recipePath, cal) #to override the existing calibra
tion factor

Examples

# initialize engine and license manager
import miparAPI
import cv2
mipar = miparAPI.initialize()
mipar.startLicenseMan(nargout = 0)

# image and recipe paths

As of 3.4.0, exeRecipe() will no longer call startLicenseMan() before recipe execution, it
must be called before exeRecipe. Also, exeRecipe’s return dict also contains any
messages, warnings, and errors encountered during recipe execution.
*
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recipePath = r'C:\Users\USER\Documents\Python\ExampleRecipe.rcp'
imagePath = r'C:\Users\USER\Documents\Python\\ExampleImage.png'

# numpy image (alternative to using an image path)
img = cv2.imread(r'C:\Users\USER\Documents\Python\ExampleImage.png)
imagePath = img.tolist()

# setting up python list for passing in companion images (only if your recipe use
s dynamic load companion steps)
originalImage = r'C:\Users\USER\Documents\Python\\ExampleImage.png'
companion1 = r'C:\Users\USER\Documents\Python\\Companion1.png'
companion2 = r'C:\Users\USER\Documents\Python\\Companion2.png'
imagePath  = [originalImage, companion1, companion2]

# execute Recipe
recOutput = mipar.exeRecipe(imagePath, recipePath, 0)

# retrieve dictionary keys
print(list(recOutput.keys())) #layer names
print(list(recOutput['LayerName'].keys())) #measurement names
print(list(recOutput['LayerName']['featMeas'].keys())) #retrieve feature measurem
ent keys

# retrieve data
binaryOutput = recOutput['LayerName']['binary'] #retrieve binary segmentation
measurementOutput = recOutput['LayerName']['MeasName'] #retrieve global measureme
nt
featureMeasurementOutput = recOutput['LayerName']['featMeas']['MeasName']._data
#retrieve feature measurement raw data
calibrationOutput = recOutput['cal']['value'] #retrieve calibration value in unit
s of micrometers per pixel
measurementUnits = recOutput['cal']['units'] #retrieve the measurement units
messages = recOutput['Messages'] #retrieve messages, warnings, and errors from re
cipe execution.  Present in v3.2.3 and later

# MeasNames can be Global Measurements such as: Area, Area Fraction and Number De
nsity.
# It can also be Feature Measurements statistics such as: Mean Caliper Diameter,
Min Roughness, Max Equivalent Diameter or StdDev Area Fraction.
# The notation is concatenated, for example the key for Global Number Density is
NumberDensity and the key for Mean Feature Caliper Diameter is MeanCaliperDiamete
r.
# It is recommended to pull the keys of measurements to get a complete list of me
asurements in the recipe.
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# terminate engine
mipar.terminate()

Measurements Units

Image
Measurement

Examples Units

Counts,
Intensities,
Similarity

Count, Estimate Count, Intensity, Mutual Information,
Correlation Coefficient

unitless

Areas Area
pixels (px) or unit^2 (um^2,
in^2, ft^2)

Lengths Perimeter, Intercepts, Image Dim pixels (px) or unit (um, in, ft)

Inverse Lengths Perimeter Fraction, Inverse Intercepts 1/px or 1/unit (um, in, ft)

Densities Number Density
features/px or features/unit^2
(um^2, in^2, ft^2)

Fractions Area Fraction, Count Fraction percent (%)

Feature
Measurement

Examples Units

Counts,
Intensities, Shape

Companion ID, Companion Features Intensity,
Roughness, Eccentricity, Aspect Ratio

unitless

Areas Area, Companion Area
pixels (px) or unit^2 (um^2,
in^2, ft^2)

Lengths Diameters, Lengths, Neighbor Distance px or unit (um, in, ft)

Combination Perimeter/Area 1/px or 1/unit (um, in, ft)

Location Centroid pixels (px) or unit (um, in, ft)

Orientation Orientation, Tilt degrees (deg)

Local
Measurement

Examples Units

Counts,
Intensities, Shape

Count, Anisotropy unitless

Fractions Area Fraction percent (%)

Shape Curvature 1/px or 1/unit
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Densities Number Density
features/px or features/unit^2
(um^2, in^2, ft^2)

Lengths Thickness, Nearest Distance pixels (px) or unit (um, in, ft)
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getPref()
The getPref function is used to retrieve the value of a preference in the preference configuration file.

Arguments

Args:
key: list of preference keys.

Valid keys:
units

Returns:
value: list of values at keys.

Syntax

values = mipar.getPref(keys)

Examples

# initialize engine and licence manager
import miparAPI
mipar = miparAPI.initialize()
mipar.startLicenseMan(nargout = 0)
key_list = ['units']

# get preference values
values = mipar.getPref(key_list)

# terminate engine
mipar.terminate()
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initialize()
The initialize method is used to launch the miparAPI engine and return the engine object. This method
must be executed before any other command.

Arguments

Args:
None

Returns:
engine object

Syntax

X = miparAPI.initialize()

Examples

import miparAPI
mipar = miparAPI.initialize()
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recipeMeta()
The recipeMeta function is used to retrieve meta data from a recipe file.
Currently returns: MIPAR version, calibration factor, units, date and time last modified, layers, layer colors
and measurements.

Arguments

Args:
recipePath: file path to recipe as raw string

Returns:
recOutput: dictionary variable that contains the metadata of the recipe

Syntax

X = mipar.recipeMeta(recipePath)

Examples

recipePath = r'C:\Users\PaulS\Documents\Python\Test_Folder\Training.rcp'
recipeMetadata = mipar.recipeMeta(recipePath)

lastModified = recipeMetadata.get('last_modified') #date last modified
MIPARVersion = recipeMetadata.get('version')       #MIPAR version
calibration =  recipeMetadata.get('cal')           #calibration
units =  recipeMetadata.get('units')               #units
layers = recipeMetadata.get('layers')              #layers
colors = recipeMetadata.get('colors')              #colors that correspond to th
e layers in order
measurements =  recipeMetadata.get('meas)          #measurements
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setPref()
The setPref function is used to set the value of a preference in the preference configuration file.

Arguments

Args:
key: list of preference keys.
value: list of values corresponding to the keys.

Valid keys:
units

Returns:
None

Syntax

mipar.setPref(keys,values, nargout = 0)

Examples

# initialize engine and licence manager
import miparAPI
mipar = miparAPI.initialize()
mipar.startLicenseMan(nargout = 0)
key_list = ['units']
value_list = ['um']

# get preference values
values = mipar.setPref(key_list. value_list)

# terminate engine
mipar.terminate()
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setPyEnv()
The setPyEnv function is used to create the preferences file in the miparAPI folder in Python install
directory

Arguments

Args:
python system path

Valid Path
output of sys.path

Returns:
None

Syntax

mipar.setPyEnv(sysPath)

Examples

# initialize engine and licence manager
import miparAPI
import sys
mipar = miparAPI.initialize()

libPath = sys.path
mipar.setPyEnv(libPath, nargout = 0)

# terminate engine
mipar.terminate()
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startLicenseMan()
The startLicenseMan method is used to initialize the license manager. You cannot execute recipes
before initializing the licence manager, and it only needs to be executed once per instance of the
application.

Arguments

Args:
nargout = 0 to specify that the method is not returning anything

Returns:
None

Syntax

mipar.startLicenseMan(nargout = 0)

Examples

import miparAPI
mipar = miparAPI.initialize()
mipar.startLicenseMan(nargout = 0)

As of 3.2.3, it is not necessary to call this method directly, as exeRecipe will do so at the
start of recipe execution if necessary. Also, this method will now install the license manager
if it is not already present on the system and will restart the license manager service if it is
stopped.

*
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terminate()
The terminate method is used to exit the engine

Arguments

Args:
None

Returns:
None

Syntax

miparAPI.terminate()

Examples

import miparAPI
mipar = miparAPI.initialize()
mipar.terminate()
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Release Notes
• v3.3.1 API Release Notes
• v3.3.4 API Release Notes
• v3.4.0 API Release Notes
• v3.4.1 API Release Notes
• v3.4.2 API Release Notes
• v3.4.4 API Release Notes
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v3.3.1 API Release Notes

Functionality
• All engine changes have been brought over from: v3.3.0
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v3.3.4 API Release Notes

Functionality
• All engine changes have been brought over from: v3.3.4, v3.3.3, and v3.3.2
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v3.4.0 API Release Notes

Functionality
• All engine changes have been brought over from: v3.4.0
• exeRecipe now accepts a python numpy array as an input: exeRecipe
• added aboutAPI method which returns the API version, and license status: aboutAPI

Hotfixes

3.4.0.2

• Summary stats of some local measurements would not report correctly
• For some local measurements, CSV files from a batch process would contain the identical data for all

images
• Headers in CSV files of batch local measurements had issue with units formatting

3.4.0.1

No changes. Version change done only to keep up with Base product.
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v3.4.1 API Release Notes

Functionality
• All engine changes have been brought over from: v3.4.1
• Measurement keys no longer contain the units and the spelling was corrected.
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v3.4.2 API Release Notes

Functionality
• All engine changes have been brought over from: v3.4.2
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v3.4.4 API Release Notes

Functionality
• setPref: this method can now be used to update the GPU device selection by passing in the

‘gpuDeviceChoice’ key with an integer starting with 1 for the first GPU device on the system.
• All engine changes have been brought over from: v3.4.4

MIPAR MIPAR User Manual - v5.0_en

Page 591 of 696



v4.0.0 API Release Notes

Notes
• All engine changes have been brought over from: v4.0.0
• Support for Windows 11 systems
• Support for Python 3.7, 3.8 and 3.9. Note API no longer supports Python 3.6

MIPAR MIPAR User Manual - v5.0_en

Page 592 of 696



v4.0.1 API Release Notes

Notes
• All engine changes have been brought over from: v4.0.1
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v4.1.0 API Release Notes

Notes
• All engine changes have been brought over from: v4.1.0
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v4.1.1 API Release Notes

Notes
• All engine changes have been brought over from: v4.1.1
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v4.1.2 API Release Notes

Notes
• All engine changes have been brought over from: v4.1.2
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v4.2.0 API Release Notes

Notes
• All engine changes have been brought over from: v4.2.0
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v4.2.1 API Release Notes

Notes
• All engine changes have been brought over from: v4.2.1

MIPAR MIPAR User Manual - v5.0_en

Page 598 of 696



v4.2.2 API Release Notes

Notes
• All engine changes have been brought over from: v4.2.2
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v4.3.0 API Release Notes

Notes
• All engine changes have been brought over from: v4.3.0
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v4.3.1 API Release Notes

Notes
• All engine changes have been brought over from: v4.3.1
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v4.4.0 API Release Notes

Notes
• All engine changes have been brought over from: v4.4.0

MIPAR MIPAR User Manual - v5.0_en

Page 602 of 696



REST API
Welcome to MIPAR REST API documentation. This documentation will describe the library capabilities and
outline some example workflows.

Topics
• Introduction
• System Requirements
• Install and Activate
• HTTP Input
• JSON Output
• Release Notes

The REST API is still in Beta and under active development. Updates will be posted in the
Release Notes

!
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Introduction
MIPAR REST API is a powerful tool that packages the MIPAR engine into a Docker Image

Scope
The MIPAR REST API was developed to meet the needs of customers who are already using MIPAR to do
powerful image analysis, but would like to setup “headless” workstations that execute algorithms with
minimal supervision. The REST API is deployed using Docker as it is extremely versatile and widely
adopted.

Capabilities
At this time the MIPAR REST API is only able to execute pre-built MIPAR recipes, this means that you must
have an already developed MIPAR recipe to utilize the MIPAR REST API. The Docker image accepts
images, recipes and returns the resulting binary masks and global measurements.
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System Requirements

Minimum System Requirements (Docker)
Docker for Windows

Recommended System Requirements
• CPU: 8+ core modern Intel / AMD
• GPU: Nvidia Quadro 600 or greater
• Storage: SSD SATA 3.0 or greater
• RAM: 16+ GB DDR3 1600 MHz
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Install and Activate

Standard Image Install
1. Docker is a prerequisite to install the REST API, you can download docker here: LINK
2. MIPAR support team will request the workstation Windows Edition and Version to ensure the Docker

Image is compatible
3. Make sure Docker is running
4. Run the following command to log into the repository: docker login --username AWS --passw

ord <TOKEN> 406796911473.dkr.ecr.us-east-1.amazonaws.com
5. The <TOKEM> will be provided by the MIPAR support team. Note the token is only valid for 12 hours.
6. Next run docker pull <AWS RESOURCE NAME> to pull the Docker image to the system
7. The <AWS RESOURCE NAME> is specific to the user’s Windows Version and will be provided by the

MIPAR support team.

Install License Manager
1. Download the License Manager package for Windows
2. Extract the downloaded Install_License_Manager_Win.zip (Right-click > Extract All)
3. Inside the extracted folder, double-click Install License Manager.bat

Add Exception to Windows Firewall
This allows the Docker image to communicate with the license manager on the host machine

1. Windows Defender Firewall>Advanced Settings
2. Inbound Rules>New Rule
3. Program: C:\Program Files (x86)\Common Files\Aladdin Shared\HASP\halplms.exe
4. Allow the Connection
5. Rule should apply based on internal security settings

Activate Trial License
1. Activate trial license.v2c file on the API system Link

Activate License
See Activate POST command: Link
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POST Method
There are two commands that can be sent to the REST API using a POST call: process and activate

Start the MIPAR REST API Docker image
• With docker hub running, execute the command docker run -it -p <PORT> <IMAGE>
• The <PORT> can be set by the user, for example 8000:8000 and the <IMAGE> is specific to the API

version and Windows Edition, for example mipar-api:1.0.4.w.2004

Activate command
The activate command is used to activate a product key, note: trial key file (.V2C) can be applied using
instructions here: LINK
Format the HTTP activate command:

POST /activation HTTP/1.1
Host: localhost:8000
Content-Type: application/json
Content-Length: 71
{ "ip":<HOST IP>, "pk": <PRODUCT KEY>}

Format HTTP CURL activate command:

curl --location --request POST 'http://<HOST IP>:8000/activation' \
--header 'Content-Type: application/json' \
--data-raw '{ "ip":<HOST IP>, "pk": <PRODUCT KEY> }'

Activate command output
Returns the following JSON structure:

{
"flag": <STATUS>,
"message": [<MESSAGE>]

}

<STATUS> is 0 when the license was activated successfully and 1 when it failed
<MESSAGE> is empty when the license was activated successfully and an error string when activation failed
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Process command
The process command is used to apply a specified recipe to a specified image.
binary key can be set with a value of true or false to enable or disable the binary image output
Format HTTP CURL process command:

curl --location --request POST 'http://localhost:8000/process' \
--form 'image=@"/path/to/file"' \
--form 'recipe=@"/path/to/file"'
--form 'binary = "true"'

Process command output
See JSON Output: LINK
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JSON Output

Process JSON Structure Output
The process call returns a JSON structure that represents the recipe output. Field explanation:

<LAYER NAME>: any layers that were added to the recipe
binary: the logical image that shows what was detected
<MEASUREMENT STAT>: statistic of any measurement that was added to the recipe. Ex
ample: "MeanCaliperDiameter" or "StdDevCaliperDiameter"
<MEASUREMENT_1 FEATURE MEASUREMENTS>: measurement of individual features in the d
etected image Example: "CaliperDiameter" or "MinimumDiameter"
scaleFactor: returns the scale factor in units micrometers/pixel
measurementUnits: returns the base unit of the measurement. Example: base unit: m
m, diameters: mm. areas: mm^2, number density: features/mm^2.
Messages: contains errors, warning and messages that the recipe returned during e
xecution

For complete table of measurement units see: LINK

Example Output

{
<LAYER NAME>: {

"binary": [
[

<LOGICAL ARRAY OF ARRAYS>
]

],
<MEASUREMENT STAT_1>: double
<MEASUREMENT STAT_2>: double
"featMeas": {

<MEASUREMENT_1 FEATURE MEASUREMENTS>: [
[

<DOUBLE ARRAY>
]

]
}

},
"scaleFactor": double
"measurementUnits": string
"Messages": {
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"errors": [],
"warnings": [],
"messages": []

}
}
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Error Code Troubleshooting
Error Cause Possible Solution

STATUS 500

• Docker container is not
running

• Docker container is not
reachable

• Check if the Docker container is running
• Check if the Docker is reachable by making a

call on the host machine using a too like
Postman

• Check if the port is open in the firewall

STATUS 200
with a non
empty error
key

Something went wrong with recipe
execution

Test recipe execution using the MIPAR GUI application

STATUS 400
with a license
error

• API was not activated on
this machine

• Docker container is not
able to reach the license
manager on the host
machine

• Check if the API was activated on the host
machine by checking this page:
http://localhost:1947/_int_/features.html for API
feature

• Add hasplms.exe to the Windows Firewall
inbound Rule
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Release Notes
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v1.1.0 Release Notes

Bug Fixes
• Improved error handling when API failed to communicate with the license manager
• Improved warning handling when MIPAR recipe is out of sync with MIPAR version
• JSON output follows standard protocol for ‘NAN’ and ‘inf’ values
• Interruptible recipe steps and out of range crop steps are now properly handled and no longer stop

recipe execution
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Release Notes
• v1.x.x Release Notes
• v2.x.x Release Notes
• v3.0.0 Release Notes
• v3.0.1 Release Notes
• v3.0.2 Release Notes
• v3.0.3 Release Notes
• v3.0.4 Release Notes
• v3.0.5 Release Notes
• v3.1.0 Release Notes
• v3.1.1 Release Notes
• v3.1.2 Release Notes
• v3.2.0 Release Notes
• v3.2.1 Release Notes
• v3.2.2 Release Notes
• v3.2.3 Release Notes
• v3.2.4 Release Notes
• v3.3.0 Release Notes
• v3.3.1 Release Notes
• v3.3.2 Release Notes
• v3.3.3 Release Notes
• v3.3.4 Release Notes
• v3.4.0 Release Notes
• v3.4.1 Release Notes
• v3.4.2 Release Notes
• v3.4.3 Release Notes
• v3.4.4 Release Notes
• v4.0.0 Release Notes
• v4.0.1 Release Notes
• v4.1.0 Release Notes
• v4.1.1 Release Notes
• v4.1.2 Release Notes
• v4.2.0 Release Notes
• v4.2.1 Release Notes
• v4.2.2 Release Notes
• v4.3.0 Release Notes
• v4.3.1 Release Notes
• v4.4.0 Release Notes
• v4.5.0 Release Notes
• v5.0.0 Release Notes
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v1.x.x Release Notes
1.6.3
1.5.6
1.5.4
1.5.1
1.5.0
1.4.1
1.4.0
1.3.2
1.3.1
1.3.0
1.2.0
1.1.2
1.1.1
1.1.0
1.0.2
1.0.1
1.0.0
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v2.x.x Release Notes
2.2.0
2.1.6
2.1.5
2.1.4
2.1.0
2.0.0
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v3.0.0 Release Notes

Major New Features

Deep Learning

The most significant new technology to come to MIPAR yet. Teach MIPAR to detect even the most complex
features simply by tracing. Models are trained in the new Deep Learning Trainer. Trained models can be applied
to images as part of a Recipe in the Image Processor.

The ability to apply models as part of a Recipe is included with the Base Package. Access to the Deep
Learning Trainer to train your own models requires the Deep Learning Extension.

Learn more about tracing features.
Learn more about training models.
Learn more about applying models

See examples of some of the breakthrough solutions Deep Learning has enabled.

Report Generator

Generate formal Word Doc and PDF reports which include measurements, reference and segmented images,
and experiment data. Available report types are below. Learn more here.

Report Type Generated From

Single Image Global Global measurement table in Image Processor

Single Image Feature Color by Measurements

Single Image Local Local Measurements

Batch Image Global Global measurement table in Post Processor

Batch Image Feature Histogram of Measurements opened by Post Processor

Portable Sessions

Save Session files that can be opened from other locations or computers. SSN2 file extension indicates portable
Session file. Checkbox in BP and RTP will toggle portability. SSN2 files can also be saved from PP and DLT.

Quality-of-Life Improvements
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Keyboard Shortcuts

Many added keyboard shortcuts, especially in windows with manual editing tools. Several shortcuts made
universal across all windows. Learn more here.

Sortable Tables

Click on column headings in any table to sort by that column. Click again to toggle ascending vs. descending
order. Sorting caries over to reports made with the Report Generator.

Go-to-Image in PP

Generate a measurement table in the Post Processor, and double-click on a cell to show the corresponding
image. Useful for finding an image with features at measurement extremes.

Save in More Formats

Save images in formats including PNG, JPG, BMP, GIF, and HDF4 across all apps.

Open Pyramid TIFs

Pyramid TIF files now supported. The highest resolution plane will open.

Move Layer

Move a Layer from one step to another without removing and re-adding the Layer. Select both steps and the “Set
Layer” button changes to “Move Layer”.

CSV Default Output

All spreadsheets now export in CSV format by default, allowing for easier 1-click opening in Excel..

Fewer Save Dialogs

“Save Complete” dialogs have been moved to transient status bar messages.

Cleaner Batch Output

All outputs from a batch process are now placed in a folder with the same name as the Session file.

3D Toolbox Improvements

Cleaner axes tick marks. Improved surface and volume exporting. More consistent perspectives between 2D and
3D viewers. More precision in principal axes output by Aspect Ratio feature measurement.

Functions
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Enter Dimensions in Crop Image

Manually enter or adjust crop dimensions directly from Edit > Crop Image.

Replace with Local Normal

New Clean-Up > Replace With > Local Normal function to replace each pixel in a sparse line with a short line
perpendicular to the line. Useful for draw thickness measurement line probes to allow for batch measurement of
local thickness.

Pixel Lines

New Morphology > Pixel Lines function for ensuring all pixels in 1-pixel thick lines are connected at their faces.

Percentage Mode in Basic Threshold

New mode in Segmentation > Basic Threshold for selecting pixels which are above or below a certain percentage
of the grayscale space. Useful for selecting features from probability maps produced by Deep Learning > Apply
Model (e.g., set “Percentage” to 90 in “Bright” mode to select pixels which are at least 90% likely to belong to
features of interest).

Choose Color in Manual Edit

Change the overlay or outline color in Segmentation > Manual Edit. Selected color is saved into the Recipe step.

Measurements

Measure Tool in PP

Interactive point-and-click Measure Tool (ruler icon) now available in the Post Processor.

First Moment of Area

The feature measurement First Moment of Inertia has been replaced by First Moment of Area (First Moment of
Volume in 3D Toolbox), which is a scale invariant metric of how much feature area (or volume) extends away
from its centroid. See the description here for more details.
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v3.0.1 Release Notes

Bug Fixes

Deep Learning Training

Fixed an issue where some deep learning models would not train based on their layer names.

Fixed an issue where some deep learning models would not train from a Session output from a batch process.

Portable Session Saving

Fixed an issue where portable Sessions would save as a .ssn file during overwriting.

Replace Image Sorting

Fixed an issue where “Sort on Load” setting in PP and DLT was not respected when bulk replacing images.
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v3.0.2 Release Notes

Improvements

Deep Learning Training

Tiles without any labeled pixels will be ignored during training. This can dramatically speed-up training of some
models.

All error dialogs during training now contain more descriptive messages.

Bug Fixes

Deep Learning Training

Fixed an issue where tiling was not respected if one of the tiles was set to 1.

Fixed an issue where some errors did not properly print to the log file.

Fixed an issue where GPU memory overload during application was not handled properly.

First Moment of Area Units

Fixed an issue where First Moment of Area units were printed incorrectly.
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v3.0.3 Release Notes

Bug Fixes

Manual Edit

Fixed an issue where Manual Edit step failed to open during edit if “Labels” was the default viewing mode.

Recipe Saving

Fixed an issue where if you had a Recipe with only measurement steps you would not one prompted to save the
Recipe upon opening a new image.

Erase All Layers

Fixed an issue where “Erase All Layers” option would not work properly in the Post Processor under certain
conditions.
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v3.0.4 Release Notes

Bug Fixes
• Fixed bug where MIPAR loads a color image as grayscale due to small thumbnail in second TIF page
• Fixed bug where error tone is given when entering a factor in Resize Image
• Fixed bug where table from “Ruler Tool” is not shown properly in Post Processor
• Fixed bug where “Save All Images” would occasionally fail in Post Processor and Deep Learning

Trainer
• Fixed bug where “Number Density” measurement wouldn’t clear after reloading session in Post

Processor
• Fixed bug where Layer legend in batch feature measurement reports wouldn’t respect the Session

layer colors
• Fixed bug where Save All Layers would occasionally set Recipe Panel invisible in Simple Mode
• Fixed bug with comma delimiting when saving all intercepts from an Intercepts measurement
• Fixed bug where Apply Model would occasionally improperly trigger an error about wrong image type
• Fixed bug where Recipe loading would not cancel properly when choosing not to resize mismatched

Companion Images
• Fixed bug where some measurements could be left out of a batch global measurement report

Improvements
• Fixed issue where error message windows can move behind Post Processor and Deep Learning

Trainer
• Fixed issue where close confirmation box would appear behind Pattern Mapping window
• Fixed issue where clicking “Open” in Deep Learning Trainer would not ask to clear or reload active

Recipe
• Image Processor will now warn you when saving Recipes with disabled steps
• File picker now uses default .CSV format for loading measurements in Color By Measure, Histogram

of Measurements, and Local Measurements
• Clarified message regarding expired Maintenance Plan
• Streamlined tips shown in Image Processor
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v3.0.5 Release Notes

Bug Fixes
• Addressed bug where resizing Manual Edit windows can cause editing tools to crash
• Fixed bug where Manual Edit would crash when “interruptible” while running a batch which contained

a Crop Image step
• Fixed bug where white background would not show when hiding the first layer in Layers View with

100% opacity
• Fixed bug with opening images in Post Processor by double-clicking a cell in a global measurements

table
• Fixed bug with removing multiple slices from an Image Stack in 3D Toolbox

Improvements
• Recipes now always load in Simple Mode if they contain Layers
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v3.1.0 Release Notes

New Features

Copy & Paste

It’s finally here. Now you can copy and paste an unlimited number of Recipe steps.

To copy: click and drag, Shift-click, or Ctrl-click to select multiple steps and right-click > “Copy”, or “Ctrl+C”
(“Cmd+C” on Mac). To paste: select where in the Recipe to paste and right-click > “Paste”, or “Ctrl+V” (“Cmd+V”
on Mac).

The clipboard is persistent across your system, so you may copy & paste in the following workflows:

• In Same Recipe: Copy from Recipe > Paste in same Recipe

• Between Recipes: Copy from Recipe > clear Recipe > load new Recipe > Paste

• Between Two Open Recipes: Copy from Recipe in one MIPAR instance > Paste in Recipe in second
MIPAR instance

Your last copied steps will even be available to paste after a system restart.

Batch Feature Measurements

With a checkbox in BP and RTP, you can now choose to output all individual feature measurements during a
batch process.

Feature measurement spreadsheets for each image will appear in folders organized by Layer in “[Session Name]
> measurements > [Layer Name]”.

Merge Sessions

Now you can combine multiple Sessions into a single file. Useful especially for adding new batch process results
to an existing deep learning Session, in order to re-train an improved model.

Any Session type (Portable or Regular) can be merged into any other Session type. Both Sessions must have the
same number of Layers.

To merge, open a Session in PP or DLT, choose “Merge Session” from the shortcut bar, and choose the Session
to merge into the current.
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Edit Other Layers

A new dropdown in the lower left corner of the manual editing panel in PP and DLT allows more flexibility to
perform edits in other Layers.

In Fill Mode, choose between “Fill This Layer” “Fill All Layers”, and “Erase Other Layers”.

In Erase Mode, choose between “Erase This Layer” “Erase All Layers”, and “Fill Other Layers”.

New Measurements

The following feature measurements have been added:

• Minimum Diameter: Smallest line length that fits between two parallel lines tangential to each
feature.

• Tilt: Angle of the caliper diameter of each feature with respect to the positive X-axis. Positive angles
are clockwise rotations and negative counterclockwise.

Improvements
• Bio-Format images can now be used to train deep learning models in the DLT
• Bio-Format images can now be batch processed into 3D Reconstructions in the BP and RTP
• Layer folders are now renamed in portable Sessions when Layers are renamed and the Session is

saved
• Deep learning models can be dragged directly into the IP to auto-launch Apply Model and auto-apply

the model
• Deep learning models can be dragged into Apply Model to load the model

Bug Fixes
• Fixed bug with Overlay and Labels viewing mode of blank images in PP and DLT
• Fixed bug with color picker in Manual Edit
• Fixed bug where editing a hidden Layer in the IP would cause it to un-hide
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v3.1.1 Release Notes

Bug Fixes
• Fixed bug where Feature Measurement steps would fail for Layers with no features

See new features released in v3.1.0
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v3.1.2 Release Notes

Bug Fixes
• Fixed bug where training settings panel in DLT could not be visible
• Fixed bug where “Remove Chapter” option in IP could not enable
• Fixed bug with “Undo” in PP and DLT

Improvements
• Progress indicator now appears in 3DTB when counting features when labels were not up-to-date

See new features released in v3.1.0
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v3.2.0 Release Notes

New Features

Choose Format When Saving Multiple Images

You can now choose between the following formats when using “Save All Images” from the Post Processor and
Deep Learning Trainer:

• TIFF
• PNG
• JPEG
• BMP
• HDF4

Re-designed Pattern Mapping

Pattern Mapping has been re-designed and dramatically simplified to output a grayscale map, which can then be
further processed to the final segmentation.

Integrated Product Key Activation

If your system is online, you can now activate your Product Key for a local license with a single click.

Streamlined Installation

For Windows installations, the MIPAR Installer and Setup Assistant are now executed automatically after
doubling clicking the InstallPack.

Improvements
• Gaussian Blur can use sigma values under 3
• Gradient Filter can use sigma values under 3
• Find Texture uses faster hessian matrix calculation
• Perimeter Pixels now produces an inverted, more intuitive result. Recipes with this step will still

perform under the old operation until resaved in v3.2.0.
• A new chapter point will no longer be automatically set when calling a selection (binary) Memory

Image
• When calibrating the scale factor in the Post Processor, you may now choose from any of the loaded

reference images
• You will now be warned in the 3D Toolbox when generating feature measurements from labels which
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are not up-to-date

Bug Fixes
• Fixed bug in the Post Processor where opening a reference image did not trigger a “Clear or Reload”

prompt in the Image Processor
• Fixed bug where features that exist only on the perimeter of the image would have their caliper

diameters measured as 1
• Fixed bug in the Image Processor where copy/paste of text would not work in the help/notes or scale

factor boxes
• Fixed bug in 3D Toolbox where tick labels in the 3D Viewer would not appear properly when

measurement units were switched from microns
• Fixed bug in 3D Toolbox where the bright/dark selection was not respected in Basic Threshold > 3D
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v3.2.1 Release Notes

Bug Fixes
• Fixed bug where recipes would not run properly when making Minimum Diameter feature

measurements on layers without features
• Fixed bug with launching Save All Images when reference images had .jpeg or .tiff extensions
• Fixed bug where Report Generator settings were at times not saved

See new features released in v3.2.0
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v3.2.2 Release Notes

New Functions
• Replace With > Nearest Distance replaces each feature with a line between it and its nearest

neighbor.

Bug Fixes
• Fixed bug where inserting an Apply Model step below another doesn’t update the dependencies of

later Call Output steps
• Fixed bug where pasting several steps above step 1
• Fixed bug in Pattern Mapping when using FFT Matching mode
• Fixed bug with removing a step above Register Image
• Fixed bug with running Replace With > Caliper Diameter and Replace With > Minimum Diameter

steps
• Fixed bug with Post Processor remembering the “Fill/Erase in Other/All” dropdown when switching

between Fill and Erase modes
• Fixed bug with training deep learning models with periods in Layer names

Improvements
• Turning off Hardware Acceleration in Preferences now disables additional acceleration to workaround

potential issues in Windows 7
• Pixel units for area measurements now px^2, and Perimeter Fraction now 1/px

See new features released in v3.2.0
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v3.2.3 Release Notes

New Functions
• Crop Image > Apply Last crops the image using the area defined in the last Crop Image step in the

recipe.

Bug Fixes
• Fixed bug with global measurement report printing
• Fixed bug with applying pre-loaded model from Deep Learning Trainer
• Fixed bug where Deep Learning Trainer did not respect GPU selection preference
• Fixed bug with certain workflows for flagging recipe steps and setting notes
• Fixed bug where setting scale factor could cause errors during recipe update when first step was Crop

Image
• Fixed bug with adding new layers after previous layers were cleared
• Fixed bug where error messages could appear behind Apply Model window
• Fixed bug where Pattern Mapping would not run on a binary image during recipe update

Improvements
• In Reject Features “Proximity Awareness”, Local Window settings now include the feature potentially

being rejected
• Faster preference reading
• Removing all recipe steps now behaves identical to pressing “Clear” (trash can)
• Future auto-updates will now use AWS-hosted links
• Posted workaround for adding custom logos into report templates

API
• Individual feature measurements are now output
• Images can now be input as numpy arrays in addition to filenames
• Load Companion images can now be input separately, allowing for more powerful batch processing

solutions
• Installer has been streamlined
• Error and warning reporting has been improved
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v3.2.4 Release Notes

Bug Fixes
• Fixed bug with deleting some steps which depend on others
• Fixed bug where layers could all become temporarily identical when making “Outline” edits in PP and

DLT
• Fixed bug where feature measurement stats CSV files were not properly comma separated
• Fixed bug where “Add Layer” button disables after removing all layers in DLT
• Fixed bug where toggling “Show/Hide” in Labels view causes distorted axes in PP and DLT
• Fixed bug in AOI Tracking where “Enter Crop” dialog is hidden behind window
• Fixed bug with removing some Register Image steps
• Fixed bug in Preferences with turning off GPU Computation
• Fixed bug where “Show Scalebar” panel would sometimes appear behind others in PP
• Fixed bug with switching from “Manual” to “Memory Image” in Auto Segmentation

Improvements
• Sessions can be drag-and-dropped to load in PP and DLT even if one is already open
• Improved performance in all preview windows with continuous sliders
• Standardized number of significant figures in global and feature measurement reports
• Improved filename sorting
• Feature measurements now return NaN (not-a-number) when no features are present
• Icon appears next to “Help” menu when update is available
• Improved error messages when loading non-B/W images into B/W panel in PP and DLT
• Replace With > Triangulation now works with only two features present
• DLT will now check for minimum number of layers before saving training layers and tiling

See new features released in v3.2.0
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v3.3.0 Release Notes

New Features

Express Licenses

Express Licenses are now available. These “runner licenses” are available at reduced rates and only allow recipe
running (not building). Express Licenses provide all other Base License functionality.

They are an ideal fit for organizations with R&D and production facilities, letting them build/optimize recipes with
MIPAR Base, and deploy recipes to production with MIPAR Express. Please contact sales@mipar.us if
interested.

Dark Mode

Dark Mode has come to MIPAR! Upon launching the Image Processor after updating, you’ll be prompted to test
and choose a theme. Theme can always be changed in File > Preferences from any app.

All-new GPU Acceleration

We’ve rewritten the GPU Computation engine from the ground up. Most recipes will now see significant
acceleration when run on compatible GPUs. Nearly all functions now support GPU Computation. See here for
more information.

Improved Editing Performance in PP and DLT

Overall image display performance has been improved in the Post Processor and Deep Learning Trainer, which
results in a more responsive manual editing experience.

Higher Resolution Saving

Graphics saved from tools such as Color by Measurements are now saved at higher resolutions. These include
graphics such as histograms and images with colorbars.

Powerful FFT Processing

A pair of new functions now allows for custom FFT filters to be crafted through a limitless number of recipe step
combinations.

Some functions may produce slightly different results when run on the GPU vs. the CPU.!
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Use Make FFT to produce an FFT of the Current Image to use as a canvas for developing your filter. Treat this
FFT as you would any other grayscale image and use steps like Basic Threshold, Reject Features, etc. to
automate the creation of powerful custom filters.

Set the filter as Companion Image and use Apply Stored FFT Filter to apply this filter to an image.

New Reject Features Measurements

“Number of Features” rejects based on the number of features in the companion image contained within the
feature.

“Number of Holes” rejects based on the number of holes contained within the feature.

New Load Companion Setup

Load Companion Image uses a new setup window, which allows for a more streamlined adding and editing
experience.

New Measurements

Count Fraction measures the count of features in the Current Image as a percentage relative to the count of
features in a chosen Memory Image.

“Intensity Sum” has been added as a new Feature Measurement and measures the sum grayscale intensity in
the latest Companion Image within each feature in the Current Image.

“Median” is now an available summary statistic for all Feature Measurements.

Show/Hide in Image Processor

A “Show/Hide” button has been added next to the Viewing Mode dropdown in the Image Processor. This allows
for one-click toggling between the current segmentation and the Reference Image.

Improvements & Minor Changes
• Smooth Features can now use “Window Size” values greater than 15
• Local Threshold now has a progress indicator
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• Export 3D stacks to movies has been optimized to eliminate out-of-memory errors when working with
large image stacks

Bug Fixes

• Fixed bug in Color Cluster when interacting with image during computation
• Fixed bug in Manual Edit when editing the step on a larger reference image than it was developed for
• Fixed bug in Uniform Dilation and Uniform Erosion where values above the slider max could not be

entered
• Fixed bug that caused Replace with Caliper Diameter and Replace with Minimum Diameter to

occasionally fail for very small features
• Fixed display bug in Highlight Lines when operating on a B/W image
• Fixed bug where some feature measurement files output during batch would overwrite each other
• Fixed bug with some stats outputs in formal local measurement reports
• Fixed bug with appearance of formal batch feature measurement reports
• Fixed bug when generating measurements in PP where the layer matrix would reset after each

generation
• Fixed bug where viewing modes were not properly listed after clearing a PP session and loading B/W

images

Critical Fix: Fixed bug which could cause occasional MIPAR hang-ups, where a force
restart was the only solution. On Windows systems, Setup Assistant now sets a system
environment variable which changes where some cache files are stored. If you have
experienced this bug on Windows, we recommend you perform a fresh install here.

!
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v3.3.1 Release Notes

Bug Fixes
• [All Apps] Would not be properly informed of unsupported image formats when trying to open
• [Color by Measurements] Changing the format of feature ID labels would duplicate the labels
• [Deep Learning Trainer] Image would not display properly after edits when in a viewing mode other

than “Layers”
• [Feature Measurements] Intensity measurements did not report properly
• [Image Processor] Could experience a lag on Mac systems when showing/hiding Measurements

Panel and switching recipe modes
• [Post Processor] Could not change the the labels colormap

See new features released in v3.3.0
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v3.3.2 Release Notes

New Features

Slice-by-Slice Measurements in 3D

Slice-by-Slice Measurements can now be made in the 3D Toolbox. This enables any of the Feature
Measurements to be made from all X-Y slices, where each slice’s feature labeling is based on the full 3D
labeling. This is useful for monitors features’ parameters over the Z-dimension, such as in particle tracking.

Clean Boundaries in 3D

Apply Clean Boundaries both slice-by-slice and in 3D in the 3D Toolbox to help remove artifacts between
neighboring features.

Improvements
• Significantly improved performance for “Based on Companion” measurements in 2D and 3D. Users

can expect 10×-300x acceleration when making measurements such as “count features within other
features”, “measure grayscale intensity within features”, etc.

• Feature IDs stay under scalebar in Color by Measurements
• Layer name now appears next to image name if shown in Color by Measurements and Histogram of

Measurements
• Viewing mode controls now disabled when “Hide” is toggled in IP, PP, and DLT
• Removed ‘Shift’ shortcut for “Show/Hide” in IP
• Tools menu with Histogram of Measurements added to BP, RTP, and DLT
• Feature IDs now save into “Low-Res with Colorbar” image if shown in Color By Measurements

Bug Fixes
• Fixed bug where unsupported file would still appear in list after attempting to add in PP and DLT
• Fixed bug where shift+clicking to zoom out in IP would toggle “Show/Hide”
• Fixed bug with displaying 3D slices in some cases after reconstruction on the GPU
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See new features released in v3.3.1

See new features released in v3.3.0
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v3.3.3 Release Notes

Bug Fixes
• Fixed bug where feature measurements in PP could in some cases be formatted with incorrect units
• Fixed bug where scale factor would not display correctly in PP when reading a Bio-Formats image

with embedded scale factor
• Fixed bug where mouse movement in the image axis could interrupt Preferences launching from PP

and DLT
• Fixed bug with dropdown next to “Add Layer” in DLT
• Fixed bug with saving portable Sessions out of DLT
• Fixed bug with removing top image from list in DLT

See new features released in v3.3.2

See new features released in v3.3.1

See new features released in v3.3.0
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v3.3.4 Release Notes

Improvements
• Translate Image now supports either black or white image padding
• API product will now appear in list after activation if on user’s license

Bug Fixes
• Fixed bug which could cause Local Measurements to not launch properly
• Fixed bug where nonexistent directory would not be properly caught when trying to open a recent

image

See new features released in v3.3.3

See new features released in v3.3.2

See new features released in v3.3.1

See new features released in v3.3.0
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v3.4.0 Release Notes

New Features

Local Measurements in Recipe

Add local measurements as a step in the recipe! They can be displayed with a simple click after recipe loading
and summary stats (e.g., mean, min, max, etc.) of the local measurement will appear in the global
measurement report.

To add to the recipe, open Local Measure > setup and generate > customize formatting as desired > click
“Add to Recipe” in upper-right corner. Full data tables of all local measurements can be exported per image as
CSVs during a batch process, just as feature measurements can be today.

Dynamic Scale Factor

Setup your recipe to dynamically determine the scale factor based on the size of a recognized feature.

In Calibrate Scale, you can now setup a third mode which accepts a “sub-recipe” for detection and a defined
dimension to measure. When the main recipe is run, this sub-recipe first detects the scale-determining feature
and sets the scale factor according to the feature’s measured pixel and defined physical dimensions.

Dilation and Erosion in Physical Units

Uniform Dilation and Uniform Erosion depths can now be defined in physical units such as microns, rather
than just pixels. Useful when defining custom regions-of-interest (e.g., border thickness) in physical units,
expecially when the recipe needs to accomodate various magnifications.

Companion Area Fraction Measurements

Area fraction of “child” features, relative to their “parents” can now be made automatically as part of the
“Companion Area” measurement under Measure Features.

To setup, store the “child” features in the Companion Image, and set the “parent” features as the layer to
measure. Choose Measure Features > select layer > check “Companion Area” > add to recipe.
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Improvements & Minor Changes
• Load large session from Batch Processor has more responsive loading spinner
• Improved file sorting in Batch Processor, Post Processor, and Deep Learning Trainer
• Up/down arrows in Post Processor and Deep Learning trainer can no longer produce mismatched

reference and selection image sizes
• Load Companion Image now offers an option to force resize if necessary
• Local Measure will now open immediately when only one layer in the recipe
• Improved dark mode appearance in some preview windows

Bug Fixes
• Reject Features – Area Fraction (CRITICAL)

Features to be rejected using Area Fraction would measure incorrectly. The bug fix corrects the
value in the Reject Features step to maintain detection prior to version 3.4.0.

Recommended protocol:
1. Load Recipe
2. Edit the Reject Features step that uses Area Fraction
3. Change the value to the appropriate value to meet detection
4. Select ‘Accept’
5. Save Recipe

• Removing layers could cause an improper layer assignment to Feature Measurement steps
• MIPAR could fail to launch with certain outdated GPU drivers
• View > Manage Layers would cause Feature Measurement steps to reset to “All”
• GPU acceleration could cause freezing
• Load Companion Image would fail with a certain image type
• Intermittent issue with replacing reference images in Deep Learning Trainer
• Displayed scale factor units in some generated reports would not match the displayed numerical value
• Detection results from some deep learning model applications could appear offset from the reference

image
• “Out of GPU memory” errors now caught in Adaptive Threshold
• Orthogonal Correlate would produce anomalous results in some cases
• Erroneous reference image replacement in Deep Learning Trainer and Post Processor will no longer

break the Session file
• Reference image order could reset after first up/down move in Deep Learning Trainer
• Adding an inverse layer in Deep Learning Trainer would not always appear until the active image was
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changed
• In Post Processor an error could occur when opening a batch of results over the top of a previous

batch
• Bug with Shift+clicking multiple images in Batch Processor
• Deleting a layer in Deep Learning Trainer or Post Processor would not enable the “Save Session”

button
• Crop Image would not be applied to reference image in some cases upon loading recipe
• In Local Measure “Save with Colorbar” could fail
• In Local Measure “Intensity StdDev” measurement could fail
• Viewing mode dropdown no longer active in Simple Mode
• Global intensity measurements in Image Processor would be disabled for selection images that were

converted to grayscale

Hotfixes

3.4.0.2

• Summary stats of some local measurements would not report correctly from the IP and BP
• For some local measurements, CSV files from a batch process would contain the identical data for all

images
• RTP did not output batch local measurements properly
• RTP could experience an issue and fail to run
• Headers in CSV files of batch local measurements had issue with units formatting
• “Output Local/Feature Meas” checkbox in BP and RTP would not re-enable after batch process

finished
• “Auto” mode in Calibrate Scale could fail when search area extended beyond image frame
• DL models saved out of Apply Model could have issues being applied in future recipes

3.4.0.1

• Manual distance tool did not disable when using “Auto” mode
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v3.4.1 Release Notes

Improvements
• Added a preference to increase the amount of memory available for opening specialty file formats with

Bio-Formats
• Removed “Enter Dimensions” entry from Crop menu in 3D Toolbox since functionality is present in

Crop > Draw

Bug Fixes
• More specialty file formats now accepted if Bio-Formats library is present
• Proper validation of image files of specialty types
• Anisotropy local measurement raw data would not output properly during a batch process if “Output

Local Meas” is checked
• When adding both rotating intercepts and random intercepts measurement, only the last measurement

would be printed
• Feature Measurement layer assignment would switch to “All” after deleting a layer step
• Animation tool in 3D Toolbox did not function properly
• 3D Toolbox slice by slice dilation and erosion errored with GPU Acceleration turned on
• 3D Toolbox uniform 3D dilation would error on some Windows machines
• Local Measurements in recipe would appear as columns from Choose Layers in IP
• Line Tool in Image Processor would occasionally not produce a line profile visualization
• Local Measure histogram coloring did not change with changing limits on the colormap
• CSV file headings of Local Measurements were not spelled properly

See new features released in v3.4.0
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v3.4.2 Release Notes

Improvements
• BP and RTP will now save intermediate session files during batch, such that sessions can be

reviewed and/or merged followed a batch cancellation
• In Simple Mode in the IP, “Measurements” is now written beside the Measurements Panel expansion

arrow to clarify its function
• Added Feature Number column to Local Measurements that assigns feature numbers to each pixel

based on the feature numbering in the layer.
• Added preference to link the default output folder of user saved files to the last opened image.
• When replacing a model in a recipe, calls to the previous model’s output will now track the class

names of the new model
• Description text above progress bar now consistently centered
• Error dialogs are now also printed to the log file and the log file no longer gets cleared when MIPAR

opens
• Enabled application of recipes designed on RGB images to 3-channel grayscale images (affects

Channel Operation, Color Cluster, Color Select, and Apply Model on color original)
• Channel Operation now uses floating point arithmetic
• Improved handling of GPU out of memory condition with Pre-Processing steps
• Added tooltip text to buttons that can be activated by keyboard shortcuts

Bug Fixes
• File > Save All Layers in PP and DLT errored when using GPU Acceleration
• File > Print Current Image in IP would print the Reference image instead
• Clearing unsaved session in DLT and choosing “Save”, would then asked whether to overwrite,

despite never having saved
• Trim parameter was not stored properly in Local Measure > Thickness recipe step
• When using Resize Image in IP that with dynamic scale calibration, the dynamic scale will now resize

to match
• Color Deconvolution no longer prevented with two classes
• Line Profile tool would become non-responsive in Local Measurements
• Multispectral images could fail to be calibrated properly
• Animate 3D Visualization > View Stereo would fail
• 3D Measure Tool would not work properly in labels view
• 3D surface rendering prevented with GPU computation enabled
• In IP Measure Tool would not work properly in some viewing modes
• Display issue in the PP when editing multiple layers at once
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• Out-of-sync undo in the PP and DLT when following a multi-layer edit with a single-layer edit

Hotfixes

3.4.2.1

• Scale factor would not accept properly when entering manually in IP
• Recipe would not fully clear when individually removing all steps and measurements

3.4.2.2

• Models could fail to train in DLT

3.4.2.3

• In manual edit tools, Select > Fill/Erase now works properly.

See new features released in v3.4.0
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v3.4.3 Release Notes

Bug Fixes
• Using Replace with Triangulation on a segmentation with one feature will no longer cause a recipe

failure
• Generating a summary report out of the Post Processor will no longer produce an error
• Generating Rotating Intercepts measurement on an empty image will no longer produce an error
• Launching with expired maintenance will now show the Activation Window, rather than simply exiting

after the notification
• Recipes that include Adjust Contrast developed on a workstation with a GPU will now run on a

workstation without a GPU

Hotfixes

3.4.3.1

• Auto-update engine now pulls from a new source behind the scenes

See new features released in v3.4.0
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v3.4.4 Release Notes

Improvements
• Added preference to normalize images before scaling to 8-bit. Preference is on by default and will

continue normalizing 16-bit and 32-bit images based on their min and max when scaling to 8-bit. With
preference off, 16-bit and 32-bit images will not be normalized prior to scaling to 8-bit. (See tip on
Supported Formats page for added clarification.)

• Optimized performance for generation of feature measurements in the IP and PP

Bug Fixes
• All loading spinners now centered on high resolution displays

See new features released in v3.4.0

Hotfixes

3.4.4.1

• GPU Computation = Off preference now properly respected
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v4.0.0 Release Notes

New Features

Curve Fitting

Added curve fitting to the Color by Measure, Local Measurements and Histogram of Measurements windows.
Users are now able to add normal, log normal and bimodal fits to their data, as well as display fit parameters.
These are automatically added to the Report Generator.

Make Any Step Interruptible

All user editable MIPAR steps can be set to interrupt recipe execution in both the image processor and batch
processor. To set a step as interruptible, select the recipe step and click the ‘Lightning Bolt’ button above the
recipe panel.

Session Processor

Post Processor and Deep Learning Trainer have been combined into a single application called Session
Processor. See new general layout.

If you have the Deep Learning Extension, you will only see an orange app named AI Session Processor in the
launch bar. Changing between DL training and measurement modes is done through the switch above the
“Training” panel. See new AI layout.

If you do not have the Deep Learning Extension, you will see a purple app named Session Processor in the
launch bar. Layer selection editing and measurement UI has been improved. See new measurement layout..

Performance

Support for the latest RTX 3000s NVIDIA GPUs now allows for even greater acceleration of deep learning AI
training and GPU computation.

Significantly improved the performance of processing large number of feature measurements, in many cases
by orders of magnitude.
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General UX performance on Mac has been improved, especially for systems running Apple Silicon
processors.

Support Changes
• Official support for Windows 11 and macOS Monterey (12.0)
• Official support for NVIDIA GPU architecture Ampere (cc8.x) and CUDA Toolkit 11. CUDA Compute

Capability 3.5 or higher now required. See GPU Computation for full support details and driver
upgrade procedures.

Improvements
• MIPAR will now download a newer version of the Bio-Formats library which patches the log4j

vulnerability. This library is only used by those needing to open specialty file formats. Users currently
running the older version will be prompted to update on launch. We strongly recommend updating. To
update manually, download the new library version, place the .jar file in [Install Directory]/plugins and
restart MIPAR.

• Significantly improved the performance of processing large number of feature measurements.

Bug Fixes
• Fixed bug where the recipe directory would not update after selecting a dynamic calibration recipe.
• 2D Roundness measurement no longer improperly changes with scale factor.
• Recipes with dynamic scale factors now load properly with GPU Acceleration on.
• File>Close now properly closes the window.
• Measurement dropdown now properly populates when editing a dynamic scale calibration
• Session Processor now prints companion area column title property .
• Fixed bug in the 3D Toolbox when measuring features in 2D slices that are disjoint in that slice.
• Fixed column header for Companion Perimeter measurement in the Image Processor when a

v4.0.0 uses a new version of the license manager under the hood. If after installation you
face any issues with activation or software launch, please do the following:
- Go to your license manager and look for a key marked with a red “Cloned” or “Secure
Storage ID Mismatch”
- Click the C2V button in that row
- Email that file to support@mipar.us and let us know you need to clear clone protection
after upgrading

!
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calibration is present.
• Fixed NaN output when exporting some surfaces to VTK.
• Fixed bug with Smart Cluster erroring when the execution speed was set to 1.
• Replace with Local Normal no longer errors when a feature has no pixels within the specified radius of

the feature’s centroid.
• Clearing unsaved session in Session Processor and choosing “Save”, would then asked whether to

overwrite, despite never having saved.

Detection Changes
• Find Circles has changed, check parameters to ensure consistent behavior between v4.0.0 and

previous versions.
• Local Orientation measurements may have changed for some configurations, check for consistent

behavior between v4.0.0 and previous versions.
• Apply Deep Learning models may have changed for some configurations, check for consistent

behavior between v4.0.0 and previous versions.

Measurement Changes
• 2D Roundness measurement no longer improperly changes with scale factor
• Updated calculation of Caliper Diameter (and by extension Roundness) measurements. Previously,

Caliper Diameter was measured from the center of the two pixels farthest apart in the feature. Now,
Caliper Diameter considers the entire pixel area, measuring from outside pixel corners around the
feature. This will increase the Caliper Diameter measurement between 1 and 1.41 pixels (for 2D
measurements) or between 1 and 1.73 pixels (for 3D measurements), depending on the orientation of
each feature’s Caliper Diameter axis.
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v4.0.1 Release Notes

Improvements
• Included new Report Generator templates with fields for curve fit outputs. You will be prompted to

replace current templates on first launch of v4.0.1.0.
• Apply Model will no longer force a minimum size factor.
• Measure Feature tool added to Session Processor
• Uniform Erosion and Uniform Dilation can now be performed by non-integer amounts.
• Curve fitting now reports Mode.
• In the Session Processor, added arrow key shortcuts to change the current image (left/right) and

active layer (up/down).

Bug Fixes
• Fixed occasional bug in Local Measurements that would prevent re-generating a measurement after

changing the X-axis limits.
• Clearing a session now properly cleared the selected measurements.
• Displayed calibration properties panel now positioned properly in the Session Processor.
• When editing feature measurements from the Session Processor, changing the companion image will

no longer undo changes in measurement selection.
• Removed error tone when clicking on the background of the Measurement > Select Layers window.
• Fixed bug where multiple copies of reference images would get saved in [Session Folder] > ref during

portable session creation from a batch process.
• Fixed bug with displaying the reference image when crop steps are included in the recipe.
• Fixed bug with running Grayscale Reconstruction > Inpainting with GPU Computation on.
• Show on histogram now properly tracks with a sorted measurement table.
• Feature measurements generated in the Session Processor now respect layer selection.
• The Session Processor distance tool now displays in physical units if there is a scale factor present.
• Fixed bug with changing bin size would remove curve fit without unchecking the Fit Curve checkbox.
• In the Session Processor, removed bug when cancelling a draw operation with the Escape key.

See new features released in v4.0.0
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v4.1.0 Release Notes

New Features

Load Multiple Images into Image Processor

Image Processor can now open multiple images to combine into channels. Use File > Open Images to
Channels.

Batch Process Multichannel Data Using Alternative Data Structure

Batch Processor can now combine multiple images into channels. The individual channels can be accessed
using the Color > Channel Operation recipe step.

Generate Intensity Measurements from 16-bit Images

Image Processor can now generate pixel intensity mean, standard deviation and sum from the original bit
depth image.

Improvements
• Added options to Channel Operation to control data normalization and divide-by-zero handling.
• Zoom is now default interactive tool in Session Processor upon opening session, and in Manual Edit

in the Image Processor when adding as a new step.
• Layers will now properly align during a session merge in Session Processor as long as both sessions

use the same layer names, even if they are in different orders.

Bug Fixes
• Reference Image now properly adjusted in Image Processor during Edit > Auto Crop.
• Global intensity measurements in Image Processor now properly respect their dependency on

Companion Image.
• Fixed incorrect sharpen output when using GPU computation.
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• Fixed bug with copy/paste of recipe steps in Image Processor.
• Fixed bug where Pre-Processing > FFT Filter step could be accepted with partial settings and would

then not be editable
• Auto Segmentation memory image dependencies are now respected.
• Fixed bug where Feature Measurements set to “All” would not measure proper layers after recipe

steps removed.
• Fixed bug where cancelling adding a new layer in Session Processor would incorrectly increment the

default layer name.
• Fixed bug where canceling an Edit > Sparsely Sample Image step would rebuild the recipe.
• Fixed bug with running optimization of Clean-up > Reject Features.
• Fixed bug when opening pyramid Tiff with DigitalCamera and Make info fields.
• Fixed bug with cancelling a Segmentation > Manual Edit step.
• Fixed bug with cancelling a Feature Measurement step after editing.
• Fixed bug preventing the opening of images from certain camera manufacturers when pyramid or

thumbnail images are present.

Hotfixes

4.1.0.1

• Added checks for starting a training with unsaved tracings and with empty layers.
• Fixed bug with “Optimize” in Image Processor when using a sub-region
• Fixed bug where original zoom limits in Image Processor would reset when changing recipe steps

while zoomed

4.1.0.2

• Fixed bug where occasionally “Save Model” would not enable after a DL training in AI Session
Processor.

4.1.0.3

• Memory > Call Original now interacts properly with Crop Image steps in Image Processor.
• Interactive measure tool in Image Processor now functions properly.
• Fixed bug where image stack would fail to create during batch process.

4.1.0.4

• Fixed bug where some steps would execute in 3D Toolbox even if preview window was cancelled.
• Fixed bug where original zoom limits in Image Processor would reset when changing viewing mode

while zoomed.
• Fixed bug where AI training would occasionally error due to input image size not matching expected

model size.
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4.1.0.5

• Fixed bug where Register Image did not work properly on occasion.
• Fixed bug where Crop Image did not work properly on B/W images.

4.1.0.6

• Fixed bug where File > Open Recent Image would then cause File > Open Image issues.
• Fixed bug where Load Companion Image would fail when set as interruptible.
• Fixed bug where Color Deconvolution would fail on certain .CR2 images.
• Fixed open image error when loading a session with multipage TIF images.
• Fixed a bug where in the Session Processor, when an error occurs during reference replacing, the

session is no longer unloadable.

4.1.0.7

• Fixed bug that caused false reports of activation failure.
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v4.1.1 Release Notes

Bug Fixes
• Viewing mode stays in “Layers” after switching from Simple to Detail after loading recipe in Image

Processor.
• Average neighbor distance is now properly reported for only 2 features.
• Fixed bug when loading out-of-date recipes that apply deep learning.
• Fixed bug when adding a Call Original step to a recipe while viewing Layers or Labels mode.
• Fixed bug when loading out-of-date recipes that apply deep learning.
• Fixed bug when adding a Call Original step to a recipe while viewing Layers or Labels mode.
• Fixed bug when pasting steps above a layer where the layer would no longer point to the correct step.
• Measurements no longer check for companion image size mismatch of unassigned layers.
• Resizing an image with GPU acceleration no longer turns logical images to grayscale.
• Open Images as Channels now supports logical images in Image Processor.
• Fixed bug where alternate reference images would not persist when switching recipe steps in Image

Processor.
• Alternate reference images now load properly in Image Processor.

See new features released in v4.1.0

Hotfixes

4.1.1.1

• Fixed bug where displayed scale factor on load could be inaccurate. Actual scale factor used for
measurements was unaffected.

• Fixed bug where first DCM file in folder would open regardless of which one was chosen.
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v4.1.2 Release Notes

Bug Fixes
• Fixed error when optimizing a step compared to the companion image.
• V2C files could display as failed despite activating successfully.
• Preferences window would fail to close under some conditions.
• Undo no longer resets a layer color change if an edit was made after the color change.
• Undo now properly reverts the current image when undoing a change in a recipe with only one step.

See new features released in v4.1.0
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v4.2.0 Release Notes

New Features

Recipe Templates

MIPAR now ships with a fully interactive environment to browse and try over 80 pre-built recipe templates.
Sort by category, search, and even watch videos on the available templates. Each recipe also offers an
example image to help evaluate and better understand the algorithm. See the Recipe Templates page to learn
more.

Auto Reject Features

The new “Auto Mode” in Reject Features lets MIPAR calculate and suggest a threshold to filter features based
on any of the available metrics.

Edge Feature Boolean Measurement

A popular request from customers, the new “Edge Feature” Feature Measurement outputs a boolean (true,
false) value per feature based on whether it touches the image edge. Adding this measurement alongside
others allows for powerful filtering and other post-processing in the spreadsheet environment of your choice.

Improvements
• Labels view is now available in Separate Features and Watershed recipe step preview windows.
• Separate Features line length can now be set in physical units when the recipe has a scale factor.

The measurement tool will report the distance in physical units when the units dropdown is set to
physical units.

• Warning now appears when trying to save recipe with disabled steps.

Bug Fixes
• Title of reference image now always shows when opening image in Image Processor.
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• Fixed bug preventing measuring grayscale intensity of an image with GPU computation.

Hotfixes

4.2.0.1

• Fixed bug where edge feature measurement would be reported inaccurately for non-square images.

4.2.0.2

• Fixed bug with Separate Features Slice-by-Slice in 3D Toolbox using the new minimum line length
units.

• Fixed issue where Current Image could occasionally “flicker” toward the end of recipe loading.
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v4.2.1 Release Notes

Improvements
• Flatten background can now accept an empty value.

Bug Fixes
• Improved MIPAR error handling when loading a broken recipe.
• Improved Report Generator handling of vector elements in the current panel.
• Scale factor stays accurate after the last recipe step is removed during recipe building.
• When running a recipe with no calibration on an image with built-in calibration, saving the recipe will

no longer save the image calibration into the recipe.
• Fixed bug where Measure Distance tool would occasionally report an incorrect value when switching

between a Resize Image step and a step before it.
• Combine channels no longer enables itself after a batch process was ran.
• Pasting recipe steps prevented in Live Mode.
• Adjusted scale factor from Resize Image steps now properly carryover to 3D reconstruction files

during a batch process.
• Double-clicking on cell in Histogram of Measurements now properly shows the associated image in

the Session Processor.
• Improved error and input handling in channel operations.

Hotfixes

4.2.1.1

• Images saved in Capture Mode now store scale factor as metadata.
• Export feature means/mins/etc using local window now function properly from Color by Measure.
• Fixed bug that affected some Recipes loading in Express edition.
• Improved layer handling of in local measurements.
• Improved handling of multipage TIFs in Load Companion Image.

4.2.1.2

• Fixed bug that prevented certain multi-page TIFs from opening properly.
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See new features released in v4.2.0
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v4.2.2 Release Notes

Improvements
• Added dedicated Path Length image and feature measurements
• Added ability to measure the exact floating-point Euclidean distance map as a Feature Image

Intensity measurement
• Feature Measurements > Intercepts options have been changed from radiobuttons to checkboxes,

such that “Along Vector” and “Through Centroid” can both be selected. (Example Use Case: Measure
horizontal dimension through feature centroid.)

• Expanded the “Circle Click” drawing tool to accept multiple reference points as input. A single point
produces a circle with diameter equal to the current pen size. Two points produces a circle with
diameter spanning between these two points. Three points produces the exact circle corresponding to
these three points. Four or more points produces the circle which best matches these points (least-
squared-error method).

• Can now merge multiple sessions at once.
• Image tools (zoom, pan, distance, etc) no longer toggle off when activating them a second time. For

windows which require the ability to turn these off, a new “pointer” tool has been added which does
this.

• Guided manual measurement recipes have been added to the Recipe Templates. If auto-updating to
v4.2.2.x, you will receive a notice to download and install the new templates after first launch.

Bug Fixes
• Fixed bug with replacing referencing images in non-portable sessions.
• Fixed bug which could allow for adding a local measurement dependent on Companion Image to a

Layer above the Companion Image.
• Fixed issue with merging multiple sessions one after the other.

Hotfixes

4.2.2.1

• Fixed bug where Pen would draw closed curves in Manual Edit.
• Fixed bug where ID tool in Image Processor would leave behind outlines when clicked while active.
• Fixed bug where IP would launch off-center.
• Fixed warning in log file about “MATLAB Connector not started” when zooming or panning.
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• Dynamic scale factors now properly calculate on recipe load in Image Processor.
• Recipes with dynamic scale factor calibration now load properly in Batch Processor and Real-Time

Processor.
• Channel Operations generated by Color Deconvolution now use “Normalize Top” overflow prevention.
• Improved error handling when a camera becomes unplugged.

See new features released in v4.2.0
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v4.3.0 Release Notes

New Features

Custom Measurements

MIPAR now supports user defined measurements using formulas and mapping. Define new measurements
using algebraic expressions, using existing measurements and other custom measurements as arguments.
Map any measurement output to a new value including text and boolean.

Note: To support custom measurements, the backend measurement engine has been
redesigned. Therefore, recipes built in v4.3.x or later which contain any measurements
will not load in earlier versions. To load a recipe version post v4.3 into MIPAR pre v4.3,
remove all measurements from recipe.

*
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Zoom and Pan Shortcuts

Added the ability to zoom and pan while performing a draw operation. Use the mouse wheel to zoom, and the
middle-mouse-button or shift+left-mouse-button to pan.

TIF Compression Preference

Introduced a preference for tiff compression type. Preference can be set for binary and non-binary images.

Recipe Templates
• New manual recipe template “Distance from Reference” which prompts for reference and points and

https://www.youtube.com/embed/7LOS7q4ZQ5g?rel=0

https://www.youtube.com/embed/7LOS7q4ZQ5g?rel=0
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reports distance from each point to reference. (Requires v4.3.0.0 or later)

Bug Fixes and Improvements
• Fixed bug when editing a local measurement which caused the incorrect layer to be specified.
• Fixed bug which caused the Local Measurements window to re-open after a local measurement has

been edited and saved.
• Fixed bug when adding local measurements to a recipe on a layer with “All” in its name.
• Updated Dilate and Erode Retain functions to properly operate with the specified depth. Recipes

depending on old behavior will be adjusted automatically to preserve functionality.
• Fixed misalignment between exported 3D reconstructions and rendered surfaces.
• Fixed bugs preventing the use of 3D Gaussian Blur, Sum Filter, Grayscale Dilate and Erode,

Orthogonal Correlation, Adaptive Threshold, and Clean Boundaries with thickness greater than 1;
Volume Fraction, Surface Area Fraction, Number Density, and Slice-by-Slice measurements with
more than one layer; Intercepts measurements; and Fit Centroid Paths and Reconstruct Centroid
Paths.

• Fixed bug preventing the removal of slices from a reconstruction that was built in the Batch Processor
or Real-Time using the Alignment option.

• Surface measurements output files will now consistently use the comma delimiter for .csv files and the
tab delimiter for .txt files.

• Fixed bug preventing using the menu to render the surface of specific features without extracting
while the “Extract” checkbox is checked.

• Fixed bug that would cause save and open operations to fail if the previously-used directory had been
deleted.

• Fixed bug with with outputting batch feature measurement CSVs for images with periods in name and
same name pre-periods.

• Generated reports now better handle significant figures, so measurements with more than 4
necessary decimal places will print properly.

• Save Image shortcut documentation in button tooltips and the manual have been updated.
• In Color by Measure window, saving Image > High Resolution properly saves image with a 0

measurement value.
• Fixed bug with accepting Manage Layers in Image Processor.
• Prevented “dancing” that occurs when using circle or outline tool and moving pointer on and off the

image.
• Fixed bug where trying to edit a step immediately after editing measurements in Simple Mode could

cause an error.
• Recipe Templates now hide after running recipe.
• Fixed bug where open image dialog was suppressed after certain opening and recipe reloading

sequence.
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Hotfixes

4.3.0.1

• Fixed bug where Optimize would error when using a sub-region under certain memory step
configurations.

4.3.0.2

• Fixed bug with measurements relative to memory images not loading properly.
• Fixed bugs in the generation of per-feature intercepts measurements.
• Session Processor, adding reference images after a failed session load no longer locks the UI.
• Fixed bug which would result in Color By Measure failing to load when displaying a calibration bar.
• Improved the visibility of Recipe loading notification when launching the Batch Processor from the

Image Processor.
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v4.3.1 Release Notes

Improvements
• Added the ability to save the current view from the Image Processor into a recipe, so that the view is

restored when the recipe is restored. Remembered settings include Simple Mode, showing or hiding
measurements, overlay vs. outline and their various settings, and the showing and formatting of a
scale bar on the image.

• Measurement tables not longer obscure generated reports.
• When generating sessions with scale factors which require “refMod” images, Batch Processor will now

store the appropriate scale factor into each saved refMod image. This allows sessions which are
generated from a recipe with a Resize Image step to use the proper adjusted scale factor on a per-
image basis.

• Scale factor box now disabled when recipe locked with password protection.
• Generated FFT filter masks are no longer unnecessarily saved in the recipe. Also, speed of FFT filter

mask generation has been improved.
• Added feature measurements: Intensity Min, Max, Median as feature_intensity_min,

feature_intensity_max, feature_intensity_median variables for custom measurement use.
• Added log, sin, cos and tan functions to custom measurements and ~(NOT) operator
• Added a warning when custom measurements with identical Measurement Names are added.
• When editing a custom measurement with a missing dependency, MIPAR will now notify the user of

the missing dependency.
• Added a ‘Duplicate’ button to the Custom Measurement Manager to allows for easy copying of an

available measurement.
• In GUIs with drawing tools, re-activating the zoom, pan, or a drawing tool if it’s already active will no

longer toggle that tool off.

Bug Fixes
• Fixed bug with reports not generating properly from Session Processor using text-based custom

measurements.
• Fixed bug which allows memory step selection during Optimize Process even if steps not defined

earlier in recipe.
• Fixed bug that prevented formal reports from generating from recipe templates if never saved.
• In Image Processor and Color By Measure, when using the ID tool, middle-click-to-pan will no longer

also pick a feature.
• Fixed bug with some recipe steps failing with GPU Acceleration turned on.
• Fixed bug where attempts to replace images in sessions would generate numerous file copy error

dialogs.
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• Fixed bug in MIPAR Live preventing the use of scale factors present in recipes that are pre-loaded.
• Fixed bug which could cause custom measurements using feature_mean_intercept to throw an error

dialog.
• Rejecting features based on intensity mean no longer errors.
• Replace with triangulation works properly with features that are strictly co-linear.
• Session Processor feature measurement view table now displays all layer measurements selected

instead of just first.
• Fixed bug which could cause path length measurement to fail with GPU Computation on.
• Fixed issue where measurements panel in Session Processor was out of position.
• Fixed bug affecting users running version 4.3.0.x, which could cause “relative to” measurements to be

generated improperly out of the Session Processor.
Only measurements whose “relative to” was set to something other than “Entire Image” in the Session
Processor could be affected.
Our automated testing framework has been expanded to extensively test measurement output across
all applications to prevent such issues going forward.
No other applications or measurement configurations were affected.

Hotfixes

4.3.1.1

• Fixed bug preventing the use of the Image Processor with the Express or Live (Manual) licenses
• Scale factor writing into refMod images from batch processor sessions now working properly.

4.3.1.2

• Per-feature measurements now compute with the proper units from the Session Processor for
sessions with refMod images.

• Fixed bug causing incorrect variable error messages for certain custom measurement formulas.
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v4.4.0 Release Notes

New Features

Pause/Resume Batch Processing

• We are pleased to introduce a new Save/Resume feature to our Batch Processor and Real-Time
Processor, which allows users to pause active batch or real-time processing, and resume at a later
time.

• Previous sessions can be loaded, resumed, and even appended to, thus eliminating the need to
constantly merge sessions.

• Even in the event of a power failure or computer crash, sessions can be resumed, since active
sessions save automatically after each image in a batch or real-time process.

Direct-to-PDF Report Generation

• The second generation of our Report Generator now supports direct-to-PDF report generation, along
with improved performance.

• Individual report templates have been replaced with a single report template in “reports” folder of the
install directory, which can be edited to customize the headers and footers.

• Status updates are now reported during report generation.
• Reporting of metadata, legend, and measurements tables has been improved, and all report images

reflect the user interface settings.
• The backend of the Report Generator has been entirely rewritten in preparation for the upcoming 3rd

generation, which is set to provide automated batch reporting and further customization capabilities.

Improvements
• Improved speed of image opening.
• Improved handling of out-of-memory errors when opening images larger than available memory.
• Dark Mode is now the default theme for new users. Switch themes any time from File > Preferences in

any app.
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Fixes
• Fixed bug which caused some recipes to not load.
• Fixed bug when resizing an image, recalling the original and placing it in a memory image, and then

using that memory image.
• Enabled the opening of certain non-standard png files.
• Fixed bug in the Image Processor when setting false color display limits and the lower limit is equal to

or greater than the upper limit. In the Image Processor, clearing the opacity, thickness, false color
limits, scale bar thickness, and scale bar font size will now reset to default rather than restore
previous value.

• Fixed error when using a grayscale image as a reference to generate Text Feature measurement.
• Fixed bug preventing the use of Histogram Unfolding with measurement units other than pixels and

microns.
• Fixed bug in the Session Processor where certain sessions would break grayscale measurements.

When clearing a session from the Session Processor, the reference image grayscale channel
operation will now be reset to ‘Auto’.

• Added a ‘Checking Images’ indicator when the Batch Processor is checking added images.
• 3D Toolbox will now automatically attempt to render a reconstruction using the CPU if the GPU runs

out of memory.
• Fixed bug in the Batch and Real Time Processors preventing the use of rigid, similarity, and affine

alignments between images.

Hotfixes

4.4.0.1

• Fit tables on single page in generated reports and adjusted location of report metadata.
• In FFT Filter, the Mirror x/y/origin buttons will now mirror either Keep or Erase areas of the filter,

depending on which drawing mode is selected. Mousing over the filter after inverting will no longer
cause errors.

• Fixed bugs preventing the calculation, export, and loading of Affine, Rigid, and Similarity alignments
in the 3D Toolbox. Translation alignment file now properly released after export from the 3D Toolbox.

• Fixed bugs preventing the loading of alignments in the Batch Processor.
• Fixed bug preventing the use of Apply FFT in the 3D Toolbox.
• Fixed bug preventing the toggling of recipe mode in the IP after loading a recipe saved in v4.3.1 into

MIPAR v4.4.0.
• Fixed bug with exporting feature measurements from Local Measure to Color by Measure.

4.4.0.2

• Improved measurement performance of Minimum Diameter and Caliper Diameter.
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• Fixed bug with loading recipes where false color was previously saved as the active grayscale view
mode.

• Fixed bug in the Session Processor which would improperly select a companion Layer as a reference
in feature measurements that use a companion Layer.
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v4.5.0 Release Notes

New Features

Spotlight Extension

• We are excited to introduce MIPAR Spotlight. Integrated into the Image Processor, Spotlight enables
the next generation of feature detection.

• Spotlight behaves like any other detection Recipe step, so MIPAR Clean-up, Morphology and
detection mask handling is still accessible. Recipes that contain a Spotlight step are fully batchable
using the Batch Processor or the Real Time Processor

Snap Tool, powered by MIPAR Spotlight

• We are excited to introduce MIPAR Snap into the Manual Edit and Session Processor workflows.
Snap is powered by Spotlight which enables the tool to detect anything the user points to or draws a
box around.

• Snap offers Fast and Accurate modes; Fast enables lower resource requirements in exchange for
lower detection performance in some applications. Accurate is much more resource intensive but
offers unparalleled edge accuracy.

Session Processor Redesign

• Improved the user experience inside the Session Processor by increasing the size of the image and
improving the organizations of the editing tools.

• Introduced the Snap tool, enabled by the Spotlight Extension.
• Improved the interface layout for both session review workflows as well as model training workflows.
• Improved layer management capabilities.
• Redesigned the editing tool buttons.
• Introduced ‘Separate Selection’ which will automatically keep any annotations discrete.

Manual Edit Redesign

• Improved the user experience inside the Manual Edit recipe step by increasing the size of the image
and improving the organizations of the editing tools.
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• Introduced the Snap tool, enabled by the Spotlight Extension
• Redesigned the editing tool buttons
• Introduced ‘Separate Selection’ which will automatically keep any annotations discrete.

Batch Report Generation

• Reports can now be generated from the Batch Processor, Real-Time Processor and the Session
Processor, enabled by the Report Generation Extension.

• Batch reports can include a user selected representative image, all images or no images.
• Introduced ‘Compress Images’ option to reduce the file size of the output report documents.
• Introduced ‘Aggregate Stats’ option to compile measurement statistics across the entire batch.
• Introduced ‘Save Images’ option which will save images from the batch report as individual image

files.

Improvements
Base Package

• Custom Measurement Manager is hidden while editing or adding a new custom measurement to
reduce interface clutter.

• Improved window maximization for all major apps.
• Eliminated the Cancel button in the status bar when it was not effective.
• Added ‘Edition’ to Help>About.
• Improved the close window experience to reduce question dialogs.
• When immediately stopping a session (or resuming a session after, for example, a power outage) in

the Batch or Real-Time Processor, partial results from the image being processed will get cleaned up
from the session folder.

Report Extension

• Renamed Aggregate Statistics to Summary Statistics in the Report Generator window and output
report file.

Fixes
Base Package
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• Fixed handling of proprietary image formats in the Session Processor when opening a session from
the Batch Processor.

• Fixed bug with loading and editing a recipe that contains a Custom Measurement that uses the Text
feature measurement.

• In the Image Processor, selecting Save Reference Image and Save Current Image will no longer
update the image name in the user interface with the new name.

• Fixed bug with removing a Layer in the image processor after editing a downstream step.
• Fixed bug in the Color by Measure window that sometimes prevents the update of which feature is

highlighted on the overlay image when selecting a new feature.
• Fixed bug that was writing custom measurements mapped to text as a number in the report file.
• Fixed bug where a portable session saved from the Batch or Real-Time Processors where the recipe

has no crop or resize steps or with no batch AOI tracking would rely on the location of the original
image files.

• Fixed bug with the resumption of portable sessions with measurements if the portable session has
been moved, where the resumed measurements would be placed in a new folder alongside the
previous measurements folder.

• Fixed bug in the Real Time Processor that makes a second session folder if first image is processed
alone.

• Fixed bug with editing a recipe with Feature Measurements to add a Companion Area measurement.
• Fixed bug with Preferences GPU dropdown not updating after replacing the video card on the system.
• The Cross-Correlate pre-processing step will no error when the companion image is flat. Instead, a

warning dialog will appear and a blank image will be returned instead.
• Stomata Cell 2 Template recipe loads the appropriate recipe.
• Improved examples of using intercepts measurements in custom measurements.
• Fixed bug where the custom measurement was not being displayed as ‘Mapped’ when selected in the

Custom Measurement Manager.
• Improved the Stats dropdown in the Local Measurement window to eliminate scrollbars.
• Fixed bug preventing the effect of the “Strength” parameter for local thickness measurements using

the “Smooth” skeleton. Recipes built prior to this version will continue to give the same results.
• Fixed bug with skeleton trimming for local thickness measurements using the “Classic” skeleton. This

may cause recipes built prior to this version to give different results if they used trimming on Classic
skeletons.

• Changed default colormap for Grayscale>False Color viewing mode from grayscale to parula.
• Fix bug preventing the clearing of a manual edit mask in the Auto Segmentation step.
• Disabled the Accept button when no annotations are added to the Auto Segmentation step.
• Fixed bug in FFT Filter step that would disable the Annular>Inner Frequency input.
• Prevent the ability to drag-and-drop recipes into the Batch and Real-Time Processors inappropriately

when the session is processing or paused.
• Prevent the ability to drag-and-drop images into the Batch Processor inappropriately when the

session is processing.
• Disable the button to resume a session in the Real-Time Processor when a session is already

running.

Deep Learning Extension
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• Fixed bug that allowed the Batch Processor to launch the Session Processor while a Deep Learning
training was active.

3D Extension

• Fixed the appearance of the Stop button in the 3D Toolbox.
• Enabled middle-click pan control to the 3D Manual Edit window, available even in the middle of a

draw operation.
• Enabled use of scroll wheel to operate image slider control when using zoom and pan in 3D Toolbox,

3D Manual Edit, and 3D Merge Layers.

Hotfixes

4.5.0.1

Base Package

• Fixed bug preventing the display and update of histograms in the Color-by-Measure window on load
and when selecting a cell in both another column and another row from the previously-selected cell.

• Fixed bug that would enable Save Image and Save All Images without any layers in the Session
Processor.

• Fixed bug with scale bar not printing by selecting Save Image or Save All Images in the Session
Processor.

• After opening the Activation window through an app’s Help menu, closing the Activation window will
no longer automatically shut down MIPAR.

• Replacing a color image file in Load Companion Image with another will no longer reset the channel
operation.

• Fixed bug that would cause recipe execution to stop if an error was encountered with the status bar.
• Prevented the status bar from grabbing focus after the progress has started.

• Spotlight Extension*
• Fixed bug where Spotlight after Call Original and Crop Image would incorrectly use the un-cropped

condition on grayscale images.

Report Extension

• Fixed bug when the “sum” statistic could be omitted from some reports.
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4.5.0.2

Base Package

• Fixed bug with closing software which could leave licenses unreleased.

4.5.0.3

Base Package

• Fixed bugs relating to scale factor reversion during undo operations in the Image Processor.
• Fixed bug where portable Sessions saved on Windows would not open on Mac and vice-versa.

4.5.0.4

Base Package

• Fixed bug preventing the viewing of sessions built with Spotlight in the Session Processor on a
system without a Spotlight license

• Fixed bug with creating custom image measurement based on a statistic of a feature measurement
which depends on memory image input.

• Fixed bug preventing the deactivation of hardware acceleration.

Express Package

• Fixed bug allowing the opening of recipes without layers in MIPAR Express

Spotlight Extension

• Fixed bug allowing the use of recipes built with Spotlight to perform dynamic scale factor calculation
on a system without a Spotlight license

API

• Fixed the use of very old recipes through the Python and REST APIs

4.5.0.5

Base Package
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• Fixed bug in Session Processor preventing the use of Save All Images when a layer other than the
first is selected.

• Fixed bugs preventing the loading of recipes with dynamic calibration.
• Fixed bug when generating measurements from the Session Processor.
• Fixed error that occurs with Adjust Contrast, Auto Mode if the adjustment value takes the auto-

determined values outside the image’s dynamic range.

Deep Learning Extension

• Fixed bug that could soft-lock the AI Session Processor after accepting error dialog about trying a DL
training with one layer.

4.5.0.6

Base Package

• Improved error handling on Mac when opening an image from a folder which the system has not been
granted permission to access.

• Improved reading of indexed png files.
• Fixed the generation of measurements when performed from the Color by Measurements window.
• Fixed bug where Manual Edit steps added in “Erase” mode would reopen in “Fill” mode.
• Improved error handling during execution of custom measurements. Specifically, when a missing or

wrong type memory or companion image is passed in.
• Improved error handling when removing companion images with a dependent image or feature path

length measurement added.
• Fixed bug preventing the use of image dimension measurements inside a custom measurement

formula
• Fixed bug where network extension licenses would not properly remain checked out while MIPAR is

open on a workstation.
• Fixed bug where some recipes failed to load when custom measurements are applied to an empty

image.
• Fixed bug that would prevent custom measurements with ‘Var’ in the name from printing in the Color

by Measure window.

Report Extension

• Fixed bug which could result during certain PDF displays.

Checkpoint

• Fixed bug where DOCX file was not removed before results export.
• Fixed a bug when checking for corrupted MIPAR Checkpoint projects.
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4.5.0.7

Base Package

• Fixed bug which caused an incorrect image Y-dimension measurement.
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v5.0.0 Release Notes

New Features

Deep Learning Enhancements

We’ve expanded user control over Deep Learning model training, offering settings to tailor model
performance, improve robustness, optimize resource use, and ensure training efficiency. Read full
documentation on the new Advanced Settings.

Fine-tune Models for Your Features

Adjust model complexity (depth) and context window (filter size) to optimize how your model detects
features of interest, ensuring it works best for your specific data.

Better Variation Tolerance

Increase model robustness with enhanced augmentation options, making your models more tolerant to
variations in image conditions. Add a preprocessing recipe to the training session to help normalize
variation and reduce noise before training begins. This recipe embeds in the saved DLM file and
automatically runs during execution before the model is applied.

Maximize Resource Usage

Adjust batch size and learning rate settings to maximize the efficiency of your hardware, reducing
training time without compromising results.

Accuracy Monitoring with Early Stop

Monitor real-time accuracy validation during training. Enable automatic stop if accuracy fails to improve
after a specified number of epochs, ensuring efficient use of resources and training time.

Spotlight Out of Beta

Spotlight is officially out of beta and is now supported on both Windows and Mac (Apple Silicon)
systems.

Performance has been improved. See the Spotlight page for a full description of its functionality.

MIPAR MIPAR User Manual - v5.0_en

Page 683 of 696



Quick start videos covering several use cases are now available.

Load Companion: Relative Paths and File Filters

Relative Paths

Introduced relative path loading for companion images. Allows the batch processor to load images from a
relative file location instead of a static location.

Example 1:
Images to be processed location: Documents/Working
Companion image location: Documents/Working/Companion
The relative path will look for companion images in the “Companion” subfolder in the images to be
processed folder.

Example 2:
Images to be processed location: Documents/Working
Companion image location: Documents/Companion
The relative path will look for companion images in the “Companion” parent folder of the images to be
processed folder.

File Type Filters

Introduced a file filter setting to Load Companion Image to limit files considered for dynamic loading
during a Batch Process.

Example: If images 1.jpg, 2.png, 3.tiff are in a folder and the file filter is set to jpg, only the ‘1.jpg’ image
will be used to for batch processing.

Engine Upgrade

MIPAR’s underlying processing and analysis engine has been upgraded, which has resulted in:

• General performance improvements
• Native support for NVIDIA’s Ada Lovelace architecture (4000 series RTX and Quadro GPUs)
• Native support for Apple Silicon Mac systems
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Improvements
Base Package

• Improved custom measurement handling of measurements returning NaN or empty results.
• Memory images will carry full bit depth to be used for intensity custom measurements. For example,

image_intensity_stddev(32-bit, mem1) will work as expected, if Memory Image 1 contains a 32-bit
image.

• Improved the view settings saving and loading experience in the Manual Edit step.
• Added preference to link recipe directory to image directory. When enabled, recipe browsing will

default to directory of last opened image.
• Sparsely Sample Image was updated to only operate on segmentation or a blank image. Introduced

‘number’ in the Grid mode, which allows the user to set a static number of points that should be
printed per side. X and Y dimensions are independent so the X can be set to use ‘step’ mode and Y
can be set to use ‘number’ mode.

Spotlight Extension

• Snap settings will now default to their last configuration when a fresh Manual Edit window or Session
Processor is launched.

• Loading message now appears prior to initialization when using “Accurate” model for the first time
since MIPAR launch in Spotlight or Snap.

• Limited area sampling % to 5 percent to prevent accidental overflow errors.

Report Extension

• Improved Report Generator handling of images with special characters in the name.
• Session Processor will now save the report generator reports into the session folder.

Fixes
Base Package

• Fixed memory leak in the Batch Processor and Real Time Processors.
• Fixed bug when resuming a portable session in the Batch Processor when the recipe has no scale or

crop step where the wrong reference image would be copied into the resulting session.
• Fixed bug when resuming a portable session in the Real-Time Processor where the wrong image

would be analyzed.
• Fixed bug that would prevent custom measurements from using ‘itself’ as an input for the companion.
• Fixed custom measurement error that would remove the measurement panel when the last custom

measurement was removed from the recipe.
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• Fixed measurement panel not updating the custom measurement description when a layer is
renamed.

• Fixed custom measurement that’s set to run on all layers incorrectly updating to a new layer.
• Fixed bug that would allow commas in the custom measurement name.
• Removed commas from existing custom measurements.
• Fixed bug that would prevent Mutual Information measurement from running with the GPU

Acceleration preference turned on.
• Fixed error that prevented Fast Marching Method from operating on the GPU.
• Fixed bug that would allow Fast Marching Method’s binary Companion to be replaced with a grayscale

Companion.
• Fixed bug that would prevent viewing of binary image in the Manage Layers window when GPU

Acceleration is turned on.
• Fixed bug with optimizing steps when GPU acceleration is turned on.
• Fixed display issue causing images in the Image Processor to sometimes shift after display.
• Fixed display issue in the Image Processor preventing the use of empty space around an image from

being used if the user zooms in.
• Fixed clipping of image edges when zooming in on an image that has an aspect ratio different than

that of the available space to view that image.
• Fixed memory leak in the Image Processor.
• Fixed bug where interactive measurement panel would not appear in Session Processor.
• Fixed bug preventing the use of the STDDEV_ prefix operator in custom measurements.
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v5.0.1 Release Notes

Read new features and improvements in v5.0.0 ››

Improvements
Base Package

• Added Image Tile Extractor tool to split images into a specified number of tiles. Pre-tiling images
improves Spotlight and Snap resolution and can allow for more Spotlight-based recipes to automate
feature tracing for DL model training. Available from “Tools” menu in any application.

• Modes 2 and 3 in 3-way switch under Fill/Erase in the Session Processor now only operates on visible
layers. Useful for moving a selection from layer class to another with multiple layers present.
(Example: You have 3 layers, and want to move a feature from layer 1 to 2: Select layer 1 > Uncheck
visibility of layer 3 > choose “Select” tool > choose “Erase” mode > set 3-way switch to “Fill Other” >
click on feature to move. Feature will be erased from layer 1 and filled in layer 2.)

• “Add Inverse of All Layers” in the Session Processor now operates only on visible layers.
• Added new option “Add Outline of Visible Layers” in the Session Processor. Useful for adding

boundary layers to improve object separation in models targeting features such as grains and
particles.

Spotlight Extension

• Improved “Spotlight not found” error message to clarify the need to run the latest Spotlight installer.

Bug Fixes
Base Package

• Prevented MIPAR from hanging after certain window closures on Mac.
• Fixed bug on systems with multiple GPUs, bug would populate the GPU list in Preferences with the

last element.
• Fixed bug that would not allow auto-save manual edits to be turned off in the Session Processor.
• Fixed bug where a custom feature measurement which produced identical measurements for all

features could cause an error.
• Fixed UI bug when training a deep learning model with validation which caused the wrong validation

accuracy to be printed to the in-progress info display in the AI Session Processor.
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• Fixed bug in the Local Measurement app that would force the user to select ‘Generate’ twice after
editing the ‘Trim’ value of the Local Thickness measurement.

• Fixed bug in Apply Deep Learning caused by replacing a model which uses a pre-processing recipe,
with one which does not.

• Fixed bug in the Session Processor that prevented image adding after loading an invalid session.
• Fixed bug in the Session Processor that would store an image file dragged and dropped into the

session panel as a session file.

Report Extension

• Fixed bug with printing reports with extremely long file names, layer names and measurement names,
where the extra columns would not be added to the measurement table.

• Fixed bug that would prevent the report generator from opening report with an empty Report Title.
• Fixed bug which caused some batch reports on Mac to fail.

3D Extension

• Fixed bug with 3D Reject Features in the 3D Toolbox.

Hotfixes

5.0.1.1

Base Package

• Fixed bug where addition of inverse or outline layer in Session Processor may not properly apply to all
images.

• Improved error handling when saving tiles from Image Tile Extractor.

Spotlight Extension

• Fixed bug in Manual Edit where Snap would not remember its saved mode (point vs. box) after recipe
was loaded.

• Prevented “Loading model to memory…” status message from overwriting progress bar when using
Snap in interruptible Manual Edit steps.

5.0.1.2

Base Package
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• Fixed non-critical error when a custom measurement was edited or deleted, and window was
accepted without adding or removing a measurement from recipe.

• Fixed bug where Uniform Dilation and Erosion would not update if depth was set to 100 after
previously being set above 100.

Report Extension

• Improved the report generated date to include the time zone and improved the date, time formatting.
Enhanced the method for generating the last modified date of newly saved recipe and session files by
not depending on the operating system to manage file modification dates.

Checkpoint

• Enabled the Export Overlays setting in the Report Generator. This setting can now be turned on to
export final detection overlays into the project folder.
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Latest Release
Update:3.4.4.1
Link:MIPAR_v3.4.4.1_Update
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Latest Release v4.0
Update:4.5.0.7
Link:MIPAR_v4.5.0.7_Update
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Latest Release v5.0
Update:5.0.1.2
Link:MIPAR_v5.0.1.2_Update
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Test Release
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Test Release v4.0
Update:4.5.0.5
Link:MIPAR_v4.5.0.5_Update
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Test Release v5.0
Update:5.0.2.0
Link:MIPAR_v5.0.2.0_Update
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Latest RecipeLib
Update:1.4
Link:RecipeLib_v1.4
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